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About GeneMapper
Software

Chapter Overview

Introduction This chapter describes the ABI PRISM® GeneMapper™ Software
Version 3.0, the relationship of GeneMapper software to the current

ABI PRIsM® genotyping software, and the requirements for installing
and starting GeneMapper software.

In This Chapter This chapter contains the following topics:

Topic See Page
Overview of GeneMapper Software 1-2
Hardware and Software Requirements 1-9
Registering GeneMapper Software 1-11
Obtaining Technical Support 1-12

About GeneMapper Software 1-1
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Overview of GeneMapper Software

About The GeneMapper software v3.0 is a new release of GeneMapper
GeneMapper software. This release of GeneMapper software has additional features
Software and enhancements similar to the functionality of ABI PRISM®
GeneScan® and Genotyper® analysis software. GeneMapper software
provides automated genotyping for linkage analysis, SNP validation,
population genetics, and human identification users.

Supported The GeneMapper software v3.0 supports data generated from the
Instruments following instruments:

4 ABI PrisM® 310 Genetic Analyzer

ABI Prism® 377 DNA Sequencer

ABI PrisM® 3100-Avant Genetic Analyzer
ABI PrRiIsM® 3100 Genetic Analyzer

ABI PrisM® 3700 DNA Analyzer

Applied Biosystems 3730 DNA Analyzer

Applied Biosystems 3730xI DNA Analyzer (for 48 capillary
instruments only)

* & & & oo o

Supported The GeneMapper software v3.0 is specifically designed to work with the
Chemistry Kits following applications and reagents:

¢ ABI Prism® Linkage Mapping Set v.2.5
ABI PrisM® Mouse Mapping Primers v.1.0
ABI PrisM® SNaPshot® Multiplex Kit

ABI PrisM® SNaPshot® Primer Focus™ Kit
AmpF{STR® Kits

StockMarks® Animal Parentage Typing Kits
ABI PRISM® GeneScan™ Size Standards

Custom Microsatellites

* & & & o o o
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Unique Features of Several new features and enhancements of GeneMapper software v3.0
GeneMapper include:

Software v3.0 o

¢
¢
¢

¢

Display of polyploid genotypes
Remote database connection

Microsoft® Windows® 2000 operating system support

A clean installation along with upgrades for the 3100 and
3100-Avant Data Collection computers

Full integration with the Applied Biosystems 3730 DNA Analyzer
including automation capabilities

Expanded technical portfolio (i.e., mutation screening)

Descriptions of Benefits

GeneMapper software using ABI instruments, Linkage Mapping Set
(LMS), AmpF{STR® HID markers, or SNaPshot® Multiplex, provides
capabilities that go beyond the ABI PRIsM® GeneScan® and
Genotyper® software products. It provides a genotyping capability that
sets new standards for high-throughput and automated genotyping,

with the following benefits.

Genotyping benefits of the GeneMapper software

Benefit

Description

High accuracy for size- and
allele-calling

Sophisticated algorithms such as
Multiple Allele Peak Determination
(MAPDA), Automatic Bin Builder
(ABB), and Automatic Bin Assignment
Algorithms (ABAA) assure highly
accurate allele calls .

High-throughput

In a recommended computing
platform, GeneMapper software
processes over 50,000 genotypes in 1
hour. This is sufficient capacity to
analyze all the sample files
accumulated by an Applied
Biosystems® 3730 DNA Analyzer run
overnight at peak capacity in 1 to 2
hours.

About GeneMapper Software 1-3
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Genotyping benefits of the GeneMapper software (continued)

Benefit Description

Fully automated operation Process Component-Based Quality
Values (PQV) monitor major
components of the size- and
allele-calling process, informing a user
of the source of problems anywhere
along the data analysis process.

Ease of use One-button operation is provided with
fully integrated, multi-step size-calling,
allele-calling, and intelligent data
management (using the GeneMapper
database).

Unique features of the GeneMapper software v3.0

Unique Feature Description

Multiple Allele Peak Determination | For non-forensic data, the MAPDA are used.

Algorithms (MAPDA) For forensic data, the Human Identity Caller (HIC) algorithm is

specifically optimized to handle data containing tetranucleotide
repeats and allelic ladders.

Automatic Bin Builder (ABB) After allele peaks are called using MAPDA, the ABB is used to
Automatic Bin Assignment create the bins, optimizing the distances between bins and the
Algorithms (ABAA) precise locations of bin centers. The ABAA then completes the

allele-calling process by assigning allele peaks to their
corresponding bins.

Process Component-Based After bin building and allele assignment, bin quality values are
Quality Values (PQV) assigned to these bins based on the success rate of the bins to

(See Appendix A for more locate allele peaks correctly from the sample file collection.

information.) The PQV system facilitates fully automated operation with only
questionable allele calls, those with minor component related
problems, requiring any intervention by the user. Bad samples,
defined as being below the threshold of acceptability, can be
discarded without any examination.

1-4 About GeneMapper Software
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Unique features of the GeneMapper software v3.0 (continued)

Unique Feature Description

GeneMapper Database The GeneMapper database stores the following data:

¢ Predefined size standard definitions included with installation
and custom size standard definitions

Panel, marker, and allele bin definitions
Analysis methods

Table profiles (for generating tabular reports)

* & o o

Projects containing analyzed data (allele calls, confidence
values, analysis methods, and size standard.)

Automated operation for all but Automated allele calling is made possible by instrument and
problematic data software calibration and setup steps, done once for many
samples (including user-defined criteria). It is also made
possible by the PQV system described above. Bad or
“out-of-bounds” data can be safely discarded, and only data
with minor component problems is deferred for user
intervention.

About GeneMapper Software 1-5
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Important
Features

GeneMapper software v3.0 has a number of features that are built on
the automated genotyping capabilities of the ABI PRISM GeneScan®
and Genotyper applications. The table below lists important features of

the GeneMapper software.

Feature

Description

Ability to read genetic analysis
data produced by earlier
ABI PRisM genotyping applications

You can import sample files directly
into the GeneMapper database from
either the ABI PRISM® Data Collection
software or Sequence Collector
database. It is not necessary to use
separate analysis tools such as
GeneScan software and Genotyper
software for peak quantitation and
allele calling.

Note GeneMapper software has
read-only access to the Sequence
Collector Version 3.0 database.
Therefore, GeneMapper database
results cannot be written back to the
Sequence Collector Version 3.0
database. Instead, they are stored in
individual GeneMapper projects within
the GeneMapper database.

Ability to read and process sample
(.fsa) files containing a fifth dye.
Provides fourth and fifth dye
support.

Data containing a fifth dye can be
analyzed just like the other four dyes.

Ability to export results in a user
defined format

The final results from the GeneMapper
software table can be exported as
user-defined text files.

Ability to import panel, marker, and
Bin definitions

Marker and bin definitions can be
imported into the GeneMapper
database using tab-delimited text files.

Ability to export panel, marker, and
bin definitions

Marker and bin definitions can be
exported from the GeneMapper
database as tab-delimited files.

1-6 About GeneMapper Software
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Feature Description

Ability to create bin sets for Bin definitions, which may vary
different instruments between instrument types, can be
stored as separate bin sets allowing
simultaneous analysis of data from
different instrument types in the same
project.

Ability to correct failed in-lane size | Individual samples that fail size
standards standard matching can be corrected
as soon as they are incurred without
redefining the size standard definition.

About GeneMapper Software 1-7
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How GeneMapper The following figure shows how data flows through the GeneMapper
Software Works software system.

—— »| GeneMapper Database |-———

Raw data from
ABI PRISM Size-Calling Allele-Calling Called-Alleles
instrument or
Sequence
Collector 4
Peak-Detection Size-Matching Y

Automatic Bin Allele-Peak Automatic Bin
Builder Determination using Assignment
(ABB) Multiple Allele Peak Algorithm

Algorithms (ABAA)
(MAPDA)

GR1867b
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Hardware and Software Requirements

Hardware and The following table describes the components your computer system

Software

requires to run GeneMapper software.

Requirements IMPORTANT The Oracle database has an embedded license which only
permits five named users.

Note

In order to perform all functions in GeneMapper software (with its

embedded Oracle database), please ensure there are at least 500 MB of free
space on the partition where the GeneMapper database is installed. It is
possible to export your projects to a different drive or partition, and then delete
those projects from the database to make room for new projects. (See
Chapter 3, “Using the Project Window.”)

System
Component

Minimum Requirement

Recommended

Computer

4 Intel® Pentium®@lll
processor minimum of
540 MHz

4 256 MB of RAM2

4 6 GB hard disk (free
space)

4 Intel Pentium Il
processor faster than
700 MHz

512 MB RAM
10 GB EIDE hard drive
20/48X IDE CD-ROM

10/100 NIC with RWV
(internal)

* & & o

Monitor

800 x 600 pixels size
17-inch monitor

Larger monitor

Operating
System

Microsoft® Windows NT®
version 4.0
(Service Pack 5)

Microsoft Windows NT 4.0

Service Pack 5 or Windows
2000 Professional Service

Pack 2

Ethernet
Capability

Network card for Oracle®
installation. TCP/IP must
be installed prior to Oracle
installation.

a. There are functions within the GeneMapper software that run faster with more than
256 MB RAM. Applied Biosystems recommends using at least 512 MB RAM for the best

results.
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Special The following is a list of special considerations for running the
Considerations GeneMapper software v3.0:

¢

The ABI PrisM® 3100 Genetic Analyzers require the 3100 Data
Collection Software version 1.0 and a minimum of 512 MB RAM.

The Applied Biosystems 3730/3730xI Genetic Analyzers require the
3730 Data Collection Software version 1.0.

When using the GeneMapper software v3.0 with the ABI PRISM®
3700 DNA Analyzer, the software must be installed on a separate
computer.

GeneMapper software v3.0 requires a single-processor computer.

GeneMapper software v3.0 runs on Windows NT® and Windows®
2000 platforms only. Conversion utilities are included for analyzing
data from Maclntosh®-based sample files.

GeneMapper software v3.0 is not compatible with Xeon chips on
upgrades from GeneMapper software v.1.0.2.

The version of Oracle® database in the GeneMapper software v3.0
is an embedded license for use by five (named) users only.

IMPORTANT To accommodate more than five users, additional GeneMapper
software or Oracle database licenses must be purchased.

¢

¢

When installing GeneMapper software v3.0, the user must log into
the local machine and have administrator privileges.

GeneMapper software v3.0 can exist with other Oracle clients but
not other Oracle servers. The only exception to this rule is when the
ABI PrisM® 3100 Data Collection Software version 1.0 and/or the
Applied Biosystems 3730 Data Collection Software version 1.0 is
installed on the system.
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Registering GeneMapper Software

How to Register To register, fill out the registration card included in this package and
return it to Applied Biosystems, and read the information in Chapter 2,
“Installing and Registering the GeneMapper Software” on page 2-3.

For Applied Biosystems technical support telephone and address
information, see “Obtaining Technical Support” on page 1-12.

Note Installation privileges are available only if you have returned your
registration card.
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Obtaining Technical Support

Applied A services and support page is available on the Applied Biosystems
Biosystems Web site. To access this, go to:

Website 0. /iwww.appliedbiosystems.com

and click the link for services and support.

At the services and support page, you can:
4 Search through frequently asked questions (FAQs)
4 Submit a question directly to Technical Support

4 Order Applied Biosystems user documents, MSDSs, certificates of
analysis, and other related documents

¢ Download PDF documents
4 Obtain information about customer training
¢ Download software updates and patches

In addition, the services and support page provides worldwide
telephone and fax numbers to contact Applied Biosystems Technical
Support and Sales facilities.
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Using GeneMapper
Software

Chapter Overview

Introduction This chapter describes techniques for collecting and preparing sample
data that will help you improve the overall quality of the fragment
analysis sample files you import into the ABI PRIsM® GeneMapper™
Software Version 3.0. It also describes how to plan for use of the
GeneMapper software features in your genotyping application.

In This Chapter This chapter contains the following topics:

Topic See Page
Steps Required to Use GeneMapper Software 2-2
Installing and Registering the GeneMapper Software 2-3
Logging on to and Logging out of the GeneMapper Software 2-5
Importing Data from the Analysis Sample Sheet 2-8
GeneMapper Manager 2-11
Overview of the User's Manual 2-12

Using GeneMapper Software 2-1
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Steps Required to Use GeneMapper Software

Using The following steps are required to use the GeneMapper software. You
GeneMapper Will be guided through this process in more detail by reading the
ABI PRismM® GeneMapper™ ID Software v3.0 Human Identification
Analysis Tutorial (P/N 4335523), Microsatellite Analysis with
ABI PRismM® GeneMapper™ Software v3.0 Tutorial (P/N 4335525), and
SNP Genotyping with ABI PRism® GeneMapper™ Software v3.0 Tutorial
(P/N 4335524).

Set up ¢ Set up the GeneMapper software the first time for each analysis
G%”;MZ‘?Z” application:

— Import or create panels and bins in the Panel Manager.

— Create an analysis method suitable for your application with
appropriate bin sets. No bin set is needed if you are performing
a sizing-only application.

— Create the appropriate size standard(s) if your data uses size
standards other than those provided with GeneMapper
software.

— Set up options so that the same setup will apply the next time
you use GeneMapper software, if desired.

— Convert any Macintosh®-generated sample files to the .fsa

v format. (See Appendix E for details.)
W"%e(}v\‘,’?o':;‘:{:f;sis 4 Set up the Project window for analysis of a given set of data:

— Import the fragment analysis sample files.
— Select the appropriate analysis method.
— Choose the appropriate panels.

v — Select the size standard.
Kﬁgf;,gg ¢ Perform analysis and examine the results:

— Initiate analysis.
— Examine analysis results using the Plot window(s).

Export results ¢ EXpOI’t results:

— Set up table format for export (using Table Settings Editor).
— Export (using Export Table command).
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Installing and Registering the GeneMapper Software

No Prior Oracle An important requirement for the GeneMapper software installation is
Installation that no previous Oracle® installation be in place at the time of
installation except for 3100 Data Collection Software (DCS), the
3100-Avant DCS, and the 3730 DCS.

CD-ROM IMPORTANT Do not work off of the CD-ROM. Install the software to the
Contents Selected drive.

GeneMapper software comes on a CD-ROM and includes:

¢ Microsatellite, Human ldentification (HID) marker, bin definitions
and example data, and SNP genotyping tutorial data

AppleScript® sample file conversion utilities
Electronic (PDF)® version of the user's manual
Size standard folder which contains various size standards

* & & o

Panel folder which contains Linkage Mapping and AmpF{STR
panels and bins

Installing To install GeneMapper Software version 3.0, please use the instructions
GeneMapper in the ABI PRISM® GeneMapper™ 3.0 Software Installation Instructions,
Software P/N 4338561, found in the kit contents or use the
GeneMapper 3.0 Installation.txt file on the CD-ROM.
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Registering When you are ready to use the GeneMapper software, follow the
GeneMapper instructions in the table below for registration.

Software To register GeneMapper software:
Step | Action
1 Click Start > Programs > Applied Biosystems > GeneMapper.

The first time you start the GeneMapper software, the Product
Registration dialog box opens.

Product Registration
Your Hame: | |
Organization: | |
Registration Code: | |
Quit
2 Enter your name, organization, and registration code, and click OK.

Note The first time you use the application, you are asked to
enter the registration code found on your registration card.
GeneMapper software then verifies the code. Keep your registration
code in a place where you can easily retrieve it. If you need to
reinstall the software at any time, you will be prompted for the
registration code again.
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Logging on to and Logging out of the GeneMapper Software

Introduction

Logging on to the
GeneMapper
Software

This section provides information on logging on to and logging out of
the GeneMapper software.

You must log on to the GeneMapper software program with a user
name, so that the system can log information to the database and
preserve the options for each user.

To log on to the GeneMapper software:

Step

Action

1

When you start the GeneMapper software application, the following
dialog box opens. Select your user name, if it exists, enter your
password, and click OK.

\-:-,-,I Login to GeneMapper

%Gene!ﬂapper“
T T
7,// /(//;, é‘ |\| 2 User Mame: Igm LI
f/a" e 'II. ' i'ﬂ t
é 7 it W
k - Password: [++4
I Uy
"\- F '|‘ "J Datahase Host: chm?s LI
{'.' SN oA
bt "y
AR el - |
Biosystems 1899-2001 Applera Corp. All Rights Reserved.
Mew Host... | Delete Host | Exit |

IMPORTANT If you do not have a User Name, select the default
gm, enter the password ifa, and click OK to launch the
GeneMapper software. You can go to Options from the Tools menu
and create new users and passwords.

Using GeneMapper Software 2-5
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To log on to the GeneMapper software: (continued)

Step | Action

2 Click the New Host button to open the New Host dialog box.

Enter new GenelMapper host information:
Host Mame: l
Machine Type: IStand-anne LI

]34 | Cancel |

This option allows you to connect to GeneMapper software v3.0
databases on other computers.

3 In the Host Name field, enter the machine name or IP address of the
database host.

The window displays the new database host and its user names list.

Note If the GeneMapper software cannot connect to the
database host you entered, the following error message opens:
“You have entered an invalid host.” Click OK to exit and reenter the
database host information.

Select the appropriate machine type from the drop-down list.
5 Click OK.
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GeneMapper The following rules apply to access the GeneMapper software.

Software Access ¢  The first time the GeneMapper software application is launched
Rules after installation, user registration is required.

4 Once registered, all users can read, write, and edit everything in the
database (except predefined content) because there are no access
privileges.

4 Sequence Collector access information is specified in the Options
dialog box in the Tools menu.

4 Only one user can access a database at a time.

Database connections can only be made across computers using
GeneMapper software v3.0 and not earlier versions of the software.

Logging Out Close the GeneMapper software in one of three ways.
4 Click File > Logout,
4+ Click File > Exit, or
4 Click the Close button .

If you close GeneMapper software with a new or blank Project window
(or no changes in your Project), the Save Project (logout) dialog box
does not open.

When you log out of the GeneMapper software, you have the option of
saving or discarding the changes you made since the last time you
updated the project..

& Do wou want to save changes?

Cves i Mo | Cancell

If you close the GeneMapper software using the Logout command, the
login window reopens after you select either “Yes” or “No”. GeneMapper
software closes completely if you use either the Exit command or the
Close button.
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Importing Data from the Analysis Sample Sheet

Introduction The sample sheet output from the ABI PRISM instrument used to collect
data provides important input to GeneMapper software to identify the
lane number and contents of each sample to undergo analysis. This
section identifies the sample sheet information used by GeneMapper
software so that you can correctly set up the sample sheet.

For detailed information on how to fill out a sample sheet correctly, see
the user's manual for the appropriate ABI PRiSM instrument.

Transfer of Data is transferred from a sample sheet into GeneMapper software as
Information described in the following table.

Sample Sheet GeneMapper Software
Sample file name and Sample file name and
Sample name Sample name

Note These names are the same
between a sample sheet and
GeneMapper software.

Sample Info or Color Info Sample type (Control, Allelic Ladder,
Sample, Negative Control)

Comment Panel name

Comment after Panel name. Use the | User Defined Columns 1-3
pipebar (|) to separate text into user
defined columns.

Note The 3730 has user defined
columns 1-3 in the sample sheet.

Using Sample The sample sheet information is essential for associating the nature of
Sheet Information Ssample fragments with individual dye/lanes and tables in the
GeneMapper software.

For example, the following figures show how the GeneMapper software
incorporates information entered in the Sample Name, Color Info, and
the Color Comment fields of a sample sheet into GeneMapper software
Project tables. It is your responsibility to ensure that the entries on the
sample sheet for your particular ABI PRISM instrument are correctly set
up to provide GeneMapper software with the necessary information.
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Sample Sheet

GeneMapper Software

Project Table

Plate Editor [ x]

File Eciit

Plate Mame: [testaS

Wil Sample Mame Dyes: Colar Infio Color Comment Project Mame Dye Set Run Module
A1 test! bilue 3T00Project! 1] GeneScan _1 D;l

green
X wellow
red standard
0 |orange fifth dye

testl blue 3T00Project1 o GeneScan 10
green
v |yellow
red standard
0 Orange fifth ciye
C1  testl hilue 3T00Project! =] Genescan 10
green
A wellow
red standard
o Orange fifth cye
D1 JtesH blue 37T00Project! o GeneScanl 1D
green
v |yelow
red standard
0 |orange fifth dye
E1  test! hilue 3700Project1 1] Genescant 100
green

A wellow

red standard =
ol | »
Commerts: |tast| r M Ok Cancel

B

‘@ GeneMapper Project: Untitled

File Edit Analysis “iew Tools Help

=0 =B lN [ % b &  Table Seting: |n¢msatemteoeraun AR |

= I

=)

d

= 1 Samples | Genplypes
[CJLinkage | l

|status|Sample File  [Sample Name |Comments |Sample Type [Analysis Method [Panel [Size Standard | Matrix [

1 e e
2 h 02_100405 fga | 100405 MNone Sample MNone MNone  |Maone Porkehop ROX Matrix | Li
3 [ 03_100501.fsa 100501 MNane Sample MNane MNone  |Mane Parkehop ROK Matrii | Li
4 h 04_100302.fga 100302 MNone Sample MNone MNone  |Maone Porkehop ROX Matrix | Li
A | ]

(I

Progress Status I 0% 215

User defined Read from Sample File

Find Command You can increase the utility of the Find (Ctrl+F) command in

GeneMapper software by carefully planning the format of the
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information you put into the Sample Info or Color Info field of the sample
sheet.

Example of How To Use the Find Command

One Method

If... Then...

you have 12 samples, numbered 1, when you search for all dye/lanes

2, 3,..., 12, and you enter these containing a 1 in the Sample Info

numbers into the Sample Info field field, not only will you select sample
1, you will also get samples 10, 11,
and 12.

A Better Plan

If... Then...

you number the samples 01, 02, 03, | a search for the text 01 would select

and so on only the desired dye/lanes.

In Addition

You can place key words in the Sample Comment or Color Comment field
that distinguish samples from each other.
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GeneMapper Manager

Introduction The GeneMapper Manager is a centralized interface within the
GeneMapper software v3.0 for managing and organizing projects. The
GeneMapper Manager window contains six tabs that point to the
following views:

4 Projects - see Chapter 3, “Using the Project Window”

4 Analysis Methods - Chapter 5, “Using Analysis Methods”
4 Table Settings - Chapter 6, “Using Table Settings”
¢

Plot Settings - Chapter 7, “Using Plot Windows - Samples and
Genotypes”

Matrices - Chapter 9, “Creating and Evaluating a Matrix”
4 Size Standards - Chapter 10, “Using the Size Standard Settings”
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Overview of the User’s Manual

Organization of This manual provides technical information to support the GeneMapper
the User Manual software user.

¢ The following chapters explain how to use the major application
components:

— Chapter 3, “Using the Project Window,” describes how to use
the Project window, including the Project Manager to delete and
rename Projects.

— Chapter 4, “Using Panel Manager,” describes how to use the
Panel Manager to manage all of the chemistry kits, panels,
markers, and bin definitions required for automated allele
calling.

— Chapter 5, “Using Analysis Methods,” describes how to use the
Analysis Methods tab to create custom analysis methods for
use in analyzing sample files.

— Chapter 6, “Using Table Settings,” describes how to use the
Table Settings tab to create new profiles, hide and show table
columns, and filter the table entries (rows) in Project windows.

— Chapter 7, “Using Plot Windows - Samples and Genotypes,”
describes how to view data graphically and edit allele calls.

— Chapter 8, “Using the Plot Settings Editor,” describes how to
create a custom plot profile for viewing data.

— Chapter 9, “Creating and Evaluating a Matrix,” describes how to
create a matrix file.

— Chapter 10, “Using the Size Standard Settings,” describes how
to create a size standard and how to use the Size Match Editor.

¢ The following appendices contain reference information:

— Appendix A, “Process Quality Values,” explains how to use the
Process Component-Based Quality Values.

— Appendix B, “Software Genotyping Algorithms,” provides a
description of the genotyping algorithms used in GeneMapper
software.

— Appendix C, “Project Window Software Interface,” describes the
dialog boxes and menu commands associated with the Project
Window.
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— Appendix D, “GeneScan Size Standards,” provides information
on the Size Standards provided with the GeneMapper software.

— Appendix E, “Sample File Conversion,” describes how to use
the Macintosh® AppleScript® program to convert
Macintosh-generated fragment analysis sample files to the
Windows format.

— Appendix F, “Software Warranty Information,” describes the
Applied Biosystems warranty that comes with the software
package.
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Using the Project
Window

Chapter Overview

Introduction This chapter provides a general overview of the Project window, the

central window of the ABI Prism® GeneMapper™ Software Version 3.0
interface.

In This Chapter This chapter contains the following topics:

Topic See Page
Central GeneMapper Software Window 3-2
Details of the GeneMapper Project Window 3-5
Exported Project Tables 3-20
Projects Page 3-23
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Central GeneMapper Software Window

Importance of the As shown by the figure below, the Project window is the most important
Project Window e€lement in the GeneMapper software user interface. The GeneMapper
software is organized around the concept of the project to support its
purpose of automatically calling alleles or performing genotyping.

Splash screen

Registration |
Project Manager sereen
dialog box Login screen
Analysis Methods | Adfi Samples to
Project dialog box
Table Settings
|| Project Open and
Plot Settings Save dialog boxes
Matrices — — Print dialog box
! | | GeneMapper Project window | |
Size Standard  — Manager Samples and Genotypes i Ex.port Table
Editor dialog box
Panel n
Import/Export | _| Manager Plot window — Options dialog box
dialog boxes .
Size Match - | | Sortand Find
Editor dialog boxes

Plot Properties
Control

Print dialog box | —
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Windows and
Utilities
Supporting the
GeneMapper
Software Project

The figure on page 3-2 shows the Project window as the main window
and the manager utilities, editors, and dialog boxes as the subordinate
windows. These windows are opened from and provide support for the
project.

As the focal point of the GeneMapper application, the Project window
makes it easy for you to:

¢
¢

Add samples, initiate analysis, and export results
View sample data and access data plots
You can view the data associated with a particular sample file by:

— Viewing the pre-analysis (raw data) version of the data in the
Samples view of the Project window

— Viewing the tabular results of analysis in the Genotypes view of
the Project window, or

— Viewing plot(s) of selected Project sample data in the Plot
window

Initiate the process of creating analysis methods and defining
panels and bins

The following items support the information in the Project window and
are available in the GeneMapper Manager in the Project window.

¢

Table Setting Editor (GeneMapper Manager) - This page enables
you to change the way information is displayed in the Project
window, including:

— Hide/Show table columns in the Project window
— Filter table entries

— Set profiles to generate reports easily for downstream
processing (i.e. export text files to other applications)

For more details see “Table Settings Editor” on page 6-4.

Analysis Method Editor (GeneMapper Manager) - This page
enables you to create and edit analysis methods, including:

— General properties such as type of analysis (Microsatellite, or
SNP Genotyping)

— Allele-calling properties such as the bin set to be used and
marker repeat information (di-, tri-, or tetranucleotide type,
cut-off value, PlusA distance, PlusA ratio, stutter distance, and
stutter ratio, etc.)
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3-4 Using the Project Window

— Peak Detector parameters and Algorithm type (basic,
advanced, or classic)

— Marker Quality Values to specify various requirements for
analysis

— Peak Quality parameters, such as homozygous and
heterozygous peak heights, maximum expected alleles, etc.

— Quality flags settings and PQV threshold values (pass and fail
ranges for sizing and genotype quality values)

For more details see “Analysis Method Editor” on page 5-5.

Panel Manager - This window enables you to create and edit
panels or “reference data” and has the following components:

A tool for creating product or chemistry kit folders

A table for specifying panels

A table for defining markers within a panel

A graphical editor for defining bins

For more details see Appendix C, “Project Window Software
Interface.”

Size Standard Editor (GeneMapper Manager) - This window
enables you to create new size standard definitions to be used with
new groups of samples and delete existing size standards.

For more details see “Creating/Editing a Size Standard” on

page 10-5.

Size Match Editor - This window enables you to adjust an in-lane
size standard to compensate for peak shift or a missing peak.

For more details see “Size Match Editor” on page 10-12.

Display Plots - This window enables you to display graphically the
data associated with samples and markers, and visually assess the
quality of the data.

For more details see “Displaying Plot Windows” on page 7-2.
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Details of the GeneMapper Project Window

Introduction The following information is provided for the GeneMapper Project

Project Window
Interface
Conventions

Reformatting the
Window

window.
Topic See Page
Project Window Interface Conventions 3-5
Reformatting the Window 3-5
Parts of the Main Window 3-6
Navigating in the Project Window 3-7
Samples and Genotypes Views 3-11
Project Window Toolbar 3-12
Viewing the Project Window Contents 3-14
Access to Subordinate Application Windows 3-15
Column Menus and Rules for Columns 3-18

The Project window enables you to:

¢

Minimize the window to an icon on the Microsoft Windows taskbar
or to the title bar

Maximize the window to fill the entire screen

Resize the window by dragging any window edge or corner

The following reformatting can be done in the Project window to change
the presentation of information.

4 The View menu provides a Show Navigator toggle command to

show/hide the navigation pane for both the Samples and
Genotypes views. When the navigation pane is hidden, the table
occupies the entire width of the Project window.

Shift-clicking a column header sorts the data by that column. The
Sort dialog box under the Edit menu allows cumulative sorting over
three columns; see “Sort Dialog Box” on page C-47.

The first column of the table, displaying row numbers, is fixed during
horizontal scrolling of the Samples and Genotypes tables.
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4 You can create Hide/Show columns as needed with different table
settings created using the Table Settings in the GeneMapper
Manager window.

¢ Resize columns by dragging the separating lines. When resizing is
enabled, the cursor changes to a resize cursor (a double-headed
arrow that looks like this <—>).

Parts of the Main Once you have loaded Sampile files into a Project window, the main
Window Wwindow looks like the example below. For more information see
Appendix C, “Project Window Software Interface.”

\-;pl GeneMapper Project: Microsatellite Project

1 File  Edit Analysis “iew Tools Help
2 EF = By By b L H 1] ] Table Setting: | |applied Biosysterns:Appli... VI ]
E-=IProject Samples | Genowpesl
3 - eMaPsho
S-f Linkane] Status|Sample File Sample Mame |Comments | Sample Tvpe |Analysis Method Fanel =]
01 100306 W |01_100301.fsa 100301 Maone Sample Microsatellite Default|None G
4 ——— 0z_10040 7 [ 3 02_100405.f5a |100405 Mone Sample Micrasatellite Default| Mone G
5 | gi—}ggg 8 W |03_100501.fsa 100501 Maone Sample Microsatellite Default|None G
..... 05_10040 (|9 W |04_100302.fsa 100302 Maone Sample Microsatellite Default|None G
----- 06_10050 {10 05_100406.fsa |100406 Mone Sample Microsatellite Default|None G
o7_10030 1y 06_100502 fsa |100502 None Sample Microsatellite Default| None G
12 W |07_100305.fsa 100305 Maone Sample Microsatellite Default|None G
| |
<] |
Frogress Status .. [ | ]

The following table describes the parts of the main window in the above
figure.

Parts of the main window

Item | Name Description

1 Drop-down These menus are described in “Project Window
menus Menus” on page C-9.

2 Toolbar Toolbar icons are described in “Project Window

File Menu Dialog Boxes” on page C-27.

3 Samples and The use of these tabs is described in “Samples
Genotypes View” on page C-2 and “Genotypes View” on
tabs page C-6.

4 Navigation The use of this pane is described in “Navigating
pane in the Project Window” on page 3-7.
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Parts of the main window (continued)

Item | Name Description
5 Samples view | These columns are described in “Samples View
columns Columns” on page C-3.
6 Progress The progress of analysis and import/export of
indicator projects is shown in this indicator.

Navigating in the This section provides information on how to navigate as well as how to
Project Window access different views for samples files.

4 Navigation in Samples and Genotypes View - (See page 3-7)

4 Info Tab - (See page 3-8)
4 Raw Data Tab - (See page 3-9)
4 EPT Tab - (See page 3-10)

Navigation in Samples and Genotypes Views

The left panel of the Project window has a tree view navigation device.
In the Samples view, the tree viewer has three levels. Each sublevel of
the tree-view is indented to the right.

In the Genotypes view, the tree viewer has three levels and each
sublevel of the tree view is again indented to the right.

Samples View

e Project
e Run folder

e Sample

Genotypes View

@ Panels (root level)
e Panels
o Markers

As soon as you click the tree view controller (indicated in the figure
below), the tree view expands with the subordinate level indented.
Clicking the controller a second time will collapse the level back to its

original form.
E-=IProject Prolect
- Linkage——— Run folder
S 01_100301 fsa
02_100405fsa
03_100501 fsa Samp|e files

L 07_100305.f5a

Artisan Technology Group - Quality Instrumentation ...

04_100302 fsa |
05_100406 fsa
06_100502 fsa
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Once you have added files to the Project window, the following rules

apply.

If you...

Then...

select the Project item in the
Navigation pane

all samples in the project are displayed
in the table.

select a Run folder in the
Navigation pane

samples in the selected Run folder are
displayed in the table.

select a Sample file in the
Navigation pane

sample information associated with the
selected sample is displayed in the right
pane (See figure on page 3-8).

click the Raw Data tab (with the
Info view displayed)

raw data associated with the selected
sample is displayed in the right pane
(See figure on page 3-9), replacing the
Info view display.

click the EPT Data tab

sample information associated with
voltage, power, current and run
temperature is displayed (See
page 3-10).

Info Tab

When a Sample file is selected from the navigation pane in the Samples
view, a special information window like that shown below is presented

and “Info” is the active tab.

ww* GeneMapper Project: Microzatellite Project

File Edit Analysis

Wiew Tools Help

e o B BB Wl LU £l @ | TableSetting: | [Applied Biosysterns:Appli... LI B B @l
=-S3Praject Info | Raw Data | EPT Data
-] SNaPshot
E-ES Linkage Sample Information =
i Sample File : 01_100301.f=sa
02_10040| | sample Origin Path : D:\GeneMapper\Exauples)SampleFiles)Linkage)0l_l00301.fsa
03_1005 Status : Need to be analyzed —
04_1003 File Source : Local driwve
05_1004
06_1005
...... 07_1003
Errar Message
Message : None
4 T —’lﬂ

Frogress Status ...

| St
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The Info tab displays sample file information such as:
sample information
run information
data collection settings

capillary information

¢
¢
¢
¢ gelinformation
¢
4 error messages
4 current settings

Sample information comes directly from the Instrument Data Collection
and/or Sample sheet.

Raw Data Tab

Clicking the Raw Data tab in the Samples view, when the Sample file is
selected, displays the Raw Data view for the selected Sample file.

‘@ GeneMapper Project: Miciosatellite Project

File Edit Analysis “iew Tools Help
= B B W 100 [ 4 TableZetting:  |rpplec B\osystems:Appl\..LI &) B %l

= SProject Info RawData | EPT Data]
T eMaPsho L
L Blikage || [1t0020153

400 1838 276 2704 3152 380 4020 4deE 4904 5342 57D 6218 BG5S 7094
02_1004 2412

- 2320

2428

e 0B_1005 1938
L D7_1003 1441

[T 21

| | » scan: 4583 rfu: 2760

Progress Status [ 5%

There are several plot-scaling features in the Raw Data view:

4 Zoom in on one area by placing the cursor in either the X or Y axis
label areas, and click and drag. The software zooms in on the area
of selection.

4 Return to a full scale plot by double-clicking in the label area again.
The plot window is restored to full scale.

4 You can scale the Y axis to maximum Y or a user defined value by
selecting Y-Axis Scale from the View menu.
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Use the Raw Data view to evaluate the following:

4 problems or noise in the baseline that could result in poor size
calling

4 start and stop points for analysis

EPT Tab

Clicking the EPT (electrophoresis, power, and temperature) tab in the
Samples view, when the Sample file is selected, displays a window that
shows the voltage, power, current, and run temperature associated with
that sample.

(@ GeneMapper Praject: Microsatellite Project

File Edit Analysis Wiew Tools Help

e H @ EE WL i @  Tabieseting:  [spplied BiosystemsAppli. v | @ B &l

B E'F"GDIEE‘ info | Raw Data EPTData |
SMaPsho
B Linkege 01_100301 fsa
s 1400 1838 2278 2714 52 3530 an2g A4EE 4304 5342 57800 B218 BBIE 7034
—-02_1004 #3
- 03_1005 -
~-04_1003
—05_1004 =
- DB_1005l 181
~-07_1003 135
23
a3
EP Vaoltage m— EF Current s
| | EP Power  n— RunTemp. —
4 »
Progress Status [ e
Line Description
Blue EP Voltage
Black EP Power
Green EP Current
Red Run Temperature
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Samples and
Genotypes Views

There are several plot-sealing features in the EPT view:

¢

Zoom in on one area by placing the cursor in either the X or Y axis
label areas, and click and drag. The software zooms in on the area
of selection.

Return to a full scale plot by double-clicking in the label area again.
The plot window is restored to full scale.

You can scale the Y-axis to maximum Y or a user defined value by
selecting the Y-Axis Scale from the View menu or specify upper and
lower limits in the Scale to dialog box.

The Samples and Genotypes tabs provide access to two separate
tables, each of which is considered a different view of the same project
data. Only one of these views is displayed in the Project window at any
time.

¢

Samples View - (See page 3-12 and in detail on page C-2)
This view is used to enter samples and its tab is always enabled.
Genotypes View - (See page C-6)

The tab for this view is enabled when results are present. Samples
that do not have a Panel attribute do not display in the Genotypes
table.

Note Samples with no results do not display in the Genotypes tab.
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Samples View

4@ GeneMapper Pioject: Database Project

File Edit Analysis “iew Tools Help
rf s @ BB L [ B & | Table Sefiing:  [microsatellite Defauit LI m 8&

= &Project Samples |Genmvpes|

] Datahasing

Sample Type |Analysis Method Panel Size Standard |Matrix |Run Mame |Instrument Type |Instrument ID|Run Date & Time |REF |S0QI |SFNF |MNF SMF |OS £
1 Contral HID_Advanced | ldentiiler_w3 | GS500LIZ Datahasing | ABIH 00 1 00_1202_t| 200103 1611:41 O
2 Allelic Ladder |HID_Advanced | Identifiler_v3 | GS&00LIZ Databasing ABI3100 3100_1202_02001-03-16 11:41 |. |. [ ] |. ‘
3 Sample HID_Advanced | ldentiiler_w3 | GS500LIZ Datahasing | ABIH 00 1 00_1202_t| 200103 1611:41 TR
4 ple HID_ d e LIz 3100 BN E W

Progress Status ... [ =

Genotypes View

b;«l GeneMapper Project: SUSAN
File Edit Analysis Wiew Tools Help

f = B By B Wi 1L HIll| & Table Setting IMicmaatellite Default ;I [ B s

Samples Gemwesl

Sarmple Name |Panel |marker  |Dye |allele 1 |alisle 2 [Size 1 [Size 2 |Height1|Height 2|Peak &n|Peak &n aD0J2EH |05 [SHF |oBa |sPa [sF [BIN [PH
1 MA L MNANANANANA
T 100301 Green_|vd  [THO1  [o |2 2 173.74 [175.66 (3430 [872.0 [2865.0 [a387.0 []
3 100301 Green_|vd  [TPOX |6 []
4 100301 Green_|va  |cEF1PO [o |7 2 27746 [279.32 10520 [633.0 [133400014257.0[ X []

[ I
Analysis Completed |

Note Shown with navigator pane closed.

Project Window The table below is provided as a reference for the Project window
Toolbar toolbar commands.

e @ Bw il RNWE > é

Tahle Sefting: Microsatellite Default LI m ,@ =

Icon Description

; Creates a New Project
E{ Tooltip: New Project
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Icon

Description

Opens the Open Project dialog box
Tooltip: Open Project

Saves the Project
Tooltip: Save Project

Opens the Add Samples To Project dialog box
Tooltip: Add Samples To Project (Ctrl+C)

E LT

Opens the Export dialog box; exports the contents of
the Samples or Genotypes tables in tab or comma
delimited format (Ctrl+E)

Tooltip: Export Table

Opens the Plots Table window
Tooltip: Display Plots

Opens the Size Match Editor window
Tooltip: Size Match Editor

Opens Analysis Method Editor
Tooltip: Analysis Method Editor

Opens the Panel Manager window
Tooltip: Panel Manager

Opens GeneMapper Manager
Tooltip: GeneMapper Manager

Starts the analysis; displays progress bar and Stop
button on the Status bar during analysis
Tooltip: Analyze (Ctrl+R)

| ¥ = g5 EE

Brings samples with errors to the top of the table; sorts
by overall confidence value in the Samples or
Genotypes table

Tooltip: Low Quality to Top (Ctrl+B)

Opens the Table Setting Editor for the currently selected
table
Tooltip: Table Setting Editor (Ctrl+T)

Opens the Find dialog box
Tooltip: Find (Ctrl+F)

oo B

Opens the Print dialog box
Tooltip: Print (Ctrl+P)
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Viewing the The following table lists how to display information in a Project window.
Project Window
Contents

To display information in a Project window:

To hide the...

Open the...

Clear the... | And GeneMapper software displays the...

Navigation pane

View menu
from the Project
window

Alternative =
Ctrl+Shift+N

Show Project window without the navigation pane.

P
NaVlgatOr File Edit Analysis View Help
check mark g @ BEm L Al | Tanieprome | [ovs wCecmimn tane

Samples | Genatpes |

Narne |Sample Type |Analysis Method |Panel | Size Standard |Run Name |Run Date &
1 100301 Sample  |demo_LMS |PanelDi-)|ManGS400HD |Linkage  |1988-02-27
2 |0 |1ood0s Sample  |demo_LM3 |Panei0i-)|ManGS400HD |Linkage  |1998-02-27
3 [ml 100501 Sample demo_LMS Panel01-h|ManGS400HD |Linkage 1898-02-27
4+ [0 [rooae2 Sample  |demo_LMS |PanelDi-)|ManGS400HD |Linkage  |1998-02-27
5 [0 [rooan6 Sample  |demo_LMS |PansiDi-)|ManGS400HD |Linkage  |1988-02-27
6 |0 [roosoz Sample  |demo_LMS |PanelDi-)|ManGS400HD |Linkage  |1988-02-27
70 |roo3os Sample  |demo_LM3 |Pansi0i-)|ManGS400HD |Linkage  |1998-02-27

To see the...

Click the...

And GeneMapper software displays the...

Genotypes view

Genotypes tab

Project in the Genotypes view.

& GeneMapper Proiect. LMSdemo

Alternatives =
Select View >
Samples, or
Ctrl+Shift+1

A|te|’natlves = File Edit Analysis Wiew Help
EE R e e [ B
Se|eCt E] Fl'éng\:ng‘mr Samples Genotypes |
Genotypes i o e
command from 2 nkage PaneiDi-}|D152600 (B |21 [215 (21105 (21496 10720 7640 | [ | | (W | (W
3 nkage PaneiDi-}|D15234 (B |276  [282  |27502 (26088 [12020 (5450 |0 | (W | | | (W
the View menu 4 inkage Paneldt-)|D15248 (B (179 |2 17937 (18331 (7300|5470 O [ (W (W (W W (W
Ct | Shft 2’ 5 lnkage Paneii1|D15450 |8 |33 33616 15770 =M ’E’E’E’E’E
5 lnkage Pancl0fD1S186 |6 [322 (332 [32228 33207 4100 2780 |0 |
or r+ I+ | | 7 lnkage Panel0r-|D15255_|G_|e5 9448 2136.0 ([l ]%]%’%’%’%
Note Sam ples Progress Status T
must be
analyzed to see
genotypes.
To see the... Click the... And GeneMapper software displays the...
Samples view Samples tab Project in the Samples view.
again 4 BeneMapper Project - Untitled MEE|

File Edit Analysis Yiew Help

e @ B W B [ e | Taneproie | [aolied SiosystemsDer:
E-SIProject Samples | Genompesl
[CILinkage
‘Statua‘sample File ‘Sample MName ‘Sample D ‘Cnmmems ‘Sample Type
i 100301 None sample B
2 ol 02_100405 fga | 100405 MNone Sample
3 [ 03_100501.fsa 100501 MNane Sample
4 ol 04_100302.fga 100302 MNone Sample
g [ 05_100406.fsa 100406 MNane Sample
B ol 06_100502 fga | 100502 MNone Sample
- = " L =
< [ ]
Progress Status .. e =z
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Access to
Subordinate
Application

Windows

The following table lists how to access subordinate GeneMapper

software windows.

Access GeneMapper Application Windows

To see the... Select... And GeneMapper software displays the...
Analysis Tools > Analysis Methods page.
Methods GeneMapper
Manager (@ GeneMapper Manager 5
Projects (Analysis Methods | Tanle Settings F‘\mSenmgal Mamnesl Size Standards
Then SeleCt MNarne Last Saved Ot Instrument Analysis Type Description
the Analysis 1 3100Avant-D533 2002-08-2013:5:|GM Microsatellite
2 3100Avant-SHP 2002-08-2013:5:|GM ShHaPshat
MethOds tab 3 3730 D5-33 Install 2002-08-2013:00 gm 3730 Microsatellite Factory Provided
4 Default 2002-08-2013:0:| G Microsatellite
5 Microsatellite Default 2002-08-2013:00 gm Microsatellite Factory Provided
B SMaPshat Default 2002-08-2013:00 gm SMaPshot Factory Provided
Mew... | Qper. | Save As. | Impart.. Export. [Je/ete
Done
Panel Manager Tools > Panel Panel Manager window.
Manager, _
& Panel Manager | %]
or click the File Edit Bins View
icon: HIl B X W Imlm | Bin Set |AmpFIETR_Bins... 'I |||[ B M|
=1~ &I Panel Manager el (Geae
8 W A pF IS 1 [Blue w3 | none
2 |Green_|_v3 none
3 |Profiler_v3 none
4 |Profiler_Plus_v3 none
5 |COfiler_v3 none
& |SGM_Plus_v3 none
7 |ldentifiler_¥3 none
g |Profiler_Plus_CODIS_ | none
9 |CcOfiler_GODIS_v3  |none
10|Identifler_CODIS_¥3  |none
4 | »
oK Cancel | Apply |
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Access GeneMapper Application Windows (continued)

To see the... Select... And GeneMapper software displays the...
Size Standards Tools > Currently Defined Size Standards.
GeneMapper @ cercrzppermn E.
Manager Projects | Analysis Methods | Table Settings | Plot Sstiings | Matices | Size Standards?
Name Last Saved COwner Type Description
Then SeleCt GS400HD 2002-08-20 13:0:|gm Basic/dvanced |Factory Provided

GSA00
G55006250)
GEA00LIZ
GEA00-250)LIZ

1
2 2002-08-20 13:0:|gm
3

4

5

6 |os120Lz

7

8

[l

1

1

2002-08-20 13:0:|gm
2002-08-20 13:0:|{gm
2002-08-20 13:0:|gm
2002-08-20 13:0:|gm
2002-08-20 13:0:|{gm
2002-08-20 13:0:|gm
2002-08-20 13:0:|gm
2002-08-20 13:0:|{gm
2002-08-14 14:3:{gm

Basicitdvanced | Factory Provided
Basicidvanced |Factory Provided
Basicitdvanced | Factory Provided

the Size
Standards tab.

Basicitdvanced | Factory Provided
Basicidvanced |Factory Provided
Basicitdvanced | Factory Provided

377_65_HID_GS500
377_F_HID_68500
CE_G5_HID_GS500
0 |CE_F_HID_GS500

1 |GS500LIZ_3730

Basicitdvanced | Factory Provided
Basicidvanced |Factory Provided

Factory Provided
Basicidvanced | 35bp, 250bp and

Mew, | Gnen SaveAs! Impaot.. Exnort:

Delete
Dane

Size Match
Editor

Analysis > Size Match Editor.
Size Match

Editor,

(g Size Match Editor
Edit View Tools

X HE |

\208ample1 fsa
Owerride 8Q1

or click the

Icon: Sizing Quality= 1.0

Size Matches | Size Calling Curvel

N i
47 23 3027 AT 3407

20
110420

T L. T
3897 T 97T

[

| 3

oK Cancel ApEly.
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Access GeneMapper Application Windows (continued)

To see the... Select...

And GeneMapper software displays the...

Table Setting Tools > Table Table Setting Editor.
Editor Setting Editor, @ Tl SeTRGERT =
or press General Samples | Genmypesl
Cirl+T. - Samples Table Settings:
Show |Column Filtering Content
If samples 1 Slatus Show All Records |NA =
have been 2 W Sample File Show All Records
imported, you 3 W Sample Marne Show All Records
can click the 410 Sample ID Show All Records
. i 5 W Comments Show All Recards
icon: TT. 6 | |3ample Type Shiow All Recards | MIA
I-IH T~ Analysis Method Show All Recards
i W Panel Show All Recards
Note To 9 |7 |size Standard Show All Records
create a new |10l |hatrix howe All Racnrd B
table, select Show | Hide |
Tools >
GeneMapper ok | camal |
Manager.
Then select
the Table
Settings tab
and click New.
Plot window a sample or Plot Window
results row,
and then

either select
Analysis >
Display Plots,

press Ctrl+L,

or click the
icon:

il

ig# Samples Plot

File Edit ¥iew Tools Alleles Help

Microsatellit.. = m Panes: IE ..l_.l_ Iﬁl: Mﬁ”ﬁ'_l

Wi wfive| WilE @

Sample File ‘Suupls“:mz TPuul ‘ns |sq

D533 LIS fra ‘nssnimsmu ‘nsrns ‘. [] =

-1 - B I P E

191 2z 255 287 #9351 383 M5 A4 478 &M 543

2458 ‘

.|

Hu“

” | |

lele
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Column Menus Columns are used to set up analyses after you have added samples to
and Rules for a project.

Columns
Column Menus

Five columns in the Samples view of the Project window have
drop-down menus to apply settings to selected cells in the column:

4 Sample Type
4 Analysis Method

4 Panel
¢ Size Standard
¢ Matrix

Note The Panel column displays a pop-up window which contains a
hierarchical list of kits and panels. A panel is required for any allele-calling
analysis.

Each of these columns is used to apply needed analysis parameters to
selected samples. Different list selections can be made to the individual
column rows representing samples.

Rules for Columns

The following rules apply to column selections:

4 Clicking the header for a column selects the entire column.

4 Shift+clicking selects a continuous selection range.

4 Ctrl+clicking on individual cells makes discontinuous selections.
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Applying a List Selection to an Entire Column

To apply a Menu selection:

Step

Action

1

Apply the selection to the top cell in a column:

a. Select the top cell in a column. This will display a drop-down list
of items.

b. Select and click an item to apply the selection to the cell.

Select all other cells in the column, either as a continuous or
discontinuous selection, to which the list selection is to be applied.

Click Edit > Fill Down to apply the choice made for the first cell to all
selected cells. (Ctrl+D)

Fill Down the Panel Column

To fill down the panel column:

Step

Action

1

Select the top cell in the Panel column to open the Select a Panel
window.

Expand the appropriate folder.

Double-click the appropriate panel.

Click Edit > Fill Down.
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Exported Project Tables

Opening Exported Project tables are exported as text (.txt) files. When they are opened in
Project Tables in Microsoft® Excel software, use the Text Import Wizard as described in

Microsoft Excel the following procedure so that all columns of the table are interpreted
correctly.

To open and save an exported text file in an Excel spreadsheet:

Step | Action

1 Start Excel software, and either:
¢ select File > Open > Files of Type, or

¢ select Data > Get External Data > Import Text file.

Then select the .ixt file and click Import.

2 Navigate to the folder containing your exported table files and
double-click the table file you wish to open. The Text Import Wizard
window opens.

Text Import Wizard - Step 1 of 3 EHE

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Mext, or choose the data bype that best describes your data.
riginal data type
Choose the file bype that best describes yvour data:
- Characters such as commas or tabs separate each field,
dth - Fields are aligned in columns with spaces between each field,

Skart impart at pow: I 1 5‘ File: origin: IWindows {ANST) - l

Preview of file K:\GM 3.0 picturesiProject Folderiexported table,

pratusdSample FileOSample NameOCommentsOSample Typelinalysis Heﬂ
false0d01 100301. £5a01003010NonedSanplelle faultOGreen I w3OGS400

Erued0Z 100405 £5a01004050NonedSanpledle faultONonedNonedPorkcho
Erued03 100501. £5a01005010NonedSanpledle faultONonedGS400HDOPork
Erued04 100302. £5a01003020NonedSanpledle faultONonedGS400HDOPork vI

| [
Cancel < Back | Mext = I Einish |

2 [[n]e o]
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To open and save an exported text file in an Excel

Step

Action

3

Move through the steps to import text.

a. Click the Next button to proceed to Step 2 of 3 in the Text Import
Wizard window.

b. Select either Tab or Comma Delimiters according to how you
exported the table (if necessary).

Text Import Wizard - Step 2 of 3 [ 7] <]
This screen lets ywou set the delimiters your data contains. Vou can see
hawe your text is affected in the preview below,
rDelimiter
¥ Tab ™ Semicolon ™ Comma

[~ Space [ Gther: I_ Text Qualfier: | j'

I™ Treat consecutive delimiters as one

aka presi

Status Sample File Banple WHame Comments Sample Type An=
fal=e 01 100301 . f== 100301 one Sanple De|
fal=e 02_100405 . f=a 100405 one Sample De|
fal=ze 03_100501 f=a (100501 one Sanple De|
fal=e 04_100302 . f== 100302 one Sanple De|
alse |05 100406 f=a 100406 one annle |
4 ] l

Cancel « Back. i

" Finish |

Click the Next button to continue to Step 3 of 3 in the Text Import
Wizard window.

Text Import Wizard - Step 3 of 3 EHE

This screen lets you select each column and set olurnn data Format
the Data Format, % General

‘General corwerts numeric values to numbers, date © Text
values to dates, and all remaining values to text, O pate; MDY -

Advanced. .. |

€ Do not import; column (skip)

neral Ceneral Ceneral Feperal Ceneral

Eanple File Faople Name Comments Fample Type fhalysis Me fj

D1_100201. fsa L00F0L Hone Fanple efault

DZ_l00405. fsa 100405 Hone Fanple efault

02_lO0S01. fsa LO0E0L Hone Fanple efault

D4_l0020Z. fsa LO0I0Z Hone Fanple efault -
=

Cancel I < Back | Mext = I

As you can see, the first column of the table is already selected.
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To open and save an exported text file in an Excel

Step | Action
5 Open the table file by performing the following actions:
a. Hold down the Shift key.
Scroll to the last column of the table.
Click the last column of the table and release the Shift key.
. Click the Text option button.

. Click the Finish button to open the table file with all columns in
text format.

® 20O

6 Save the text file as a Microsoft Excel Workbook file. The next time
you open the file in Excel, the table columns will display correctly in
text format.
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Projects Page

Using the Projects

The GeneMapper Manager Projects page, shown below, is a utility
Page

which is used to rename, save as, import, export, or delete projects.

To display the Projects page, select the GeneMapper Manager from the
Tools menu and select the Projects tab.

(a GeneMapper Manager [<]

Projects | Analysis Melhudsl Table Semngsl FIDISeﬂmgsl Malrmeal Size Staﬂnamal
Last Saved Owner

Froject

#of Samples

s k Project 2 14:5¢
Casework Project 068050|2002-08-05 15:27
HID Casework 062602 |2002-08-01 1531 GM
Datahase Project 2002-07-01 09:17|GM

Renarme.. Save As.. Impart...

Done

Select the project you would like to change and click the appropriate
button. If you click the Delete button, the Project Deletion dialog box

displays. Click No if you do not want to delete the project. Click Yes only
if you want to delete the project permanently.

w* GeneMapper Deletion Alert [ ]

@ Delete <Casework Project=7?

This will permanently remove the ohject from the database and cannot be undane.

o |
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Projects Tab The Projects Tab allows you to view information about the projects
stored within the GeneMapper database and perform certain functions
such as renaming and exporting of projects.

Note The only method of backing up your projects is to export them.

Description of items on the Projects tab:

Item Description

Project column Project name

Last Saved column Date/Time stamp showing when the
project was last saved

Owner column User name of the person who
created the project

Samples column Number of samples contained in the
project

Rename button Opens a Rename dialog box for

renaming the project

Enabled when a project is selected

Save As button Displays the Save Project As dialog
box

Enabled when a project is selected

Import button Displays a dialog box for Importing
projects
Export button Displays a dialog box for Exporting

selected projects
Enabled when projects are selected

Note Projects can be exported as
a group by holding down the shift
key and selecting multiple projects.
This feature works with one or more
selected projects.

Delete button Deletes the selected projects
Enabled when a project is selected

Note This feature works with one
or more selected projects.

Done button Closes the GeneMapper Manager.
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Export Project The Export Project window enables you to export a project out of the
Window GeneMapper database into a specified location. See an explanation of
each area on this window in “Using the Export Project Window” on

page 3-26.
1
2
E‘%Expml Project
Look in: | GenemMapper ;l | a(l :
T
1| Database
_1docs
3 i Examples
_1JRE
4
5 File narme: | ESL
Files of type: IJava sarialized file (*.ser) ;l Cancel |
6 ]
7

Note Reference data and Size Standards used by exported Projects are not
exported with the Projects.
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Using the Export Project Window

The elements called out in the figure in “Export Project Window” on
page 3-25 are described in the table below.

Export Project Callouts

Item

Name

Description

1

Toolbar

These icons are used as follows:

| - Clicking moves display up one level in
main pane.

| - Clicking moves display to Home level in
main pane. This level is usually

Profiles\<user>.

Eﬁl - Clicking creates a new folder at the
present directory level.

s=z| - Clicking presents a list of the contents of

the selected folder.

- Clicking presents details of the selected
folder.

Drop-down
directory menu

Select drive letter and/or folder.

Folder/file
display pane

The contents of the disk or directory are selected
in the toolbar and the directory menu is displayed
here.

Save button

This button saves the exported project.

File name field

Enter a file name to use for saving your data.

Files of type
field

This field is a display filter for files (folders are
always shown). Use this drop-down menu to
select the file extensions for display:

4 All Files (*.*) shows all files

4 Java Serialized file (*.ser) shows only files
with the extension .ser, which is how
GeneMapper projects are exported.

Note There is only one preset file extension
(.ser) that can be used.

Cancel button

Closes the Export Project window without
exporting a project.
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Import Project The Import Project window enables you to import project data
Window previously saved. See an explanation of each area in “Using the Import
Project Window” on page 3-28.

1
2
Eg’ilmpml Project
Loak in: ] GeneMapper
Clapp
| Database
_1docs
3 ) Examples
[ 1JRE
) | |
5 File narme: | Impaort
Files of type: IJa\ra serialized ﬂle|(*.ser) LI Cancel |
6 ]
7
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Using the Import Project Window

The elements called out in the figure in “Import Project Window” on
page 3-27 are described in the table below.

Import Project Callouts

Item

Name

Description

1

Toolbar

These icons are used as follows:

- Clicking moves display up one level in
main pane.

| - Clicking moves display to “Home” level in
main pane. This is usually
“Profiles\<user>".

Eﬁl - Clicking creates a new folder at the
present directory level.

s=z| - Clicking presents a list of the contents of

the selected folder.

- Clicking presents details of the selected
folder.

Drop-down
directory menu

Select drive letter and/or folder.

Folder/file
display pane

The contents of the disk or directory are selected
in the toolbar and the directory menu is displayed
here.

Import button

This button imports the selected project.

File name field

Enters name of selected project being imported.

Files of type
field

This is a display filter for files (folders are always
shown). Selects the file extensions for display:

¢ All Files (*.*) shows all files

¢ Java Serialized file (*.ser) shows only
files with the extension .ser, which is
how GeneMapper database projects
are exported.

Note There is only one preset file extension
(.ser) that can be used.

Cancel button

Closes the Import Project window without
importing a project.

3-28 Using the Project Window

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com




Using Panel Manager

Chapter Overview

Introduction This chapter describes the Panel Manager feature in the ABI Prism®
GeneMapper™ Software Version 3.0, and provides instructions on how
to use it for microsatellite data. Some information is provided regarding
SNaPshot® specific features; however, additional information can be
found in the tutorial guide (SNP Genotyping with ABI PRism®
GeneMapper™ Software Version 3.0, PN 4335524). Portions of this
chapter are organized around the Panel Manager menu items to explain
various features and actions that can be performed.

In This Chapter This chapter contains the following topics:

Topic See Page
Panel Manager Overview 4-2
Panel Manager Window Commands 4-6
Formats of Panel and Bin Text Files 4-23
Panel Table View 4-33
Marker Table View 4-35
Bin View - (for Microsatellites Only) 4-37
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Panel Manager Overview

Introduction The Panel Manager utility allows you to manage all of the chemistry
kits, panels, markers, and bin definitions required for automated allele

calling.
Topic See Page
Purpose of the Panel Manager Window 4-2
Displaying the Panel Manager Window 4-3
Hierarchy of Panel Data 4-3
Panel Manager Toolbar 4-4
Panel Manager Navigation Pane 4-5

There are two ways to get data for the Panel Manager:
4 Creating kits, panels, markers, and bins manually.

¢ Importing preformatted text files that contain panels, markers, and
bin definitions. (See “Formats of Panel and Bin Text Files” on
page 4-23 for two examples.)

Purpose of the The Panel Manager window enables you to create, edit, and import
Panel Manager panels. It features a:

Window ¢  Tool for creating kit folders
4 Table for specifying panels
4 Table for defining markers within a panel
¢ Graphical editor for creating and editing bins

Data for the panels is stored in the database.

4 Clicking the Apply button after making changes to a panel sends all
changes to the database but keeps the window open for further
edits.

4 Clicking OK sends all changes to the database and closes the
Panel Manager window.

The changes in panel data are then reflected in the Project and Plot
windows.
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When to Click the
Apply Button

Displaying the
Panel Manager
Window

Hierarchy of Panel
Data

4 After deleting a kit, panel, marker, or bin set

4 After making a number of edits

4 After creating a bin set

To display the Panel Manager window, either:

4 Click i (Panel Manager) from the Project window toolbar,

or

4 Select Tools > Panel Manager in the Project window.

File Edit Bins Wiew

gei
LI5NPdema
LLMS-MD10
LIAmpFISTR_Panels_v3
LILMS-HD5
LILMSHD5-v2.5
LLMS-LD20
LILMSMD10-v2 5

=IReference Samples

g Panel Manager [x]
[T Bin Set:l LI R I_I—
ke Hhame ke Type | Coonee
1 |SHPdemo SMP none
2 |LMS-MD10 Microsatellite  |none
3 |AmpFISTR_Panels_v3 | Microsatellite  |none
4 |LMS-HD5 Microsatellite  |none
5 |[LMSHD&-V25 Microsatellite  |none
B |LMS-LD20 Microsatellite  |none
7 |LMSMD10-¥2.5 Microsatellite  |none
oK Cancel Anply

Conceptually, the hierarchy of panel data is as follows:

¢

¢ Panel
¢ Marker
4 Bin

Kit (chemistry kit or product)

A kit is a collection of panels. A panel is a collection of markers. Bin sets
are collections of the expected allele locations for markers contained
within a kit. A different bin set should be used for each instrument type,
as variations in run conditions and polymers affect allele positions.

The GeneMapper software requires kit, panel, and bin set names to be
unique throughout the database and requires marker names to be
unique within a panel. The Panel Manager enforces these requirements
during user entry and editing of names as well as during data import.
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Since the Panel Manager allows users to add comments as needed, no
history or audit trail of panel data changes is kept. Such comments
provide a way for users to track changes and the reasons for the
changes. Each kit, panel, and marker has a comment field.

Panel Manager The toolbar icons enable specific Panel Manager actions similar to their
Toolbar associated menu items as described throughout this chapter. Position
your mouse over an icon to view its tooltip description.

12 3 45 6 7 8
@i (2 e [IE] M ein et [snP Demobins =] L IO Ee
Item Description

1 New Kit/Panel/Marker icon automatically updates to
= reflect the current action depending on the item
selected in the navigation pane (File menu).

IE 2 Clear icon performs kit/panel/marker deletion (Edit

menu).
s 3 Icons select bin options: Add Bin, Delete Bin, Edit Bin
(B = [ :
(Bins menu).
[ 4 Icons allow viewing of Project alleles (Bins menu).
i 5 Icon switches view to full X-Axis and Y-Axis scales

(View menu).

[ranosssmste. =] 6 Pull-down menu allows selection of a bin set for a
selected kit.

7 Icons select specific kit/panel/marker actions (Bins
menu):

B[] £ 4 | Newsinset, I

Add Reference Data, =4
Auto Bin, ’E
Panel Reference Data,
Auto Panel

IiI—IiI—IMT 8 Dye color toggle icons (View menu).

CHy
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Panel Manager The Panel Manager navigation pane is the primary navigation interface
Navigation Pane in the Panel Manager window. Since it is found in all Panel Manager

views, as shown in the table below, it enables moving back and forth
between the views to view, edit, and create kit folders, panels, markers,
and bins. The elements of this field are described below.

Element

Description

E-ElFPanel Manager

The Panel Manager root node is the container
for all panels. It is the top level of the
hierarchy.

E-=&Panel Manager
---|_"|LMS-HD5—V2.5
F-CLME-MD10-¥2.5

Kits help users organize their panels in
product- or project-specific folders. Clicking a
kit folder displays the Panel table.

E-=IFanel Manager
Eﬂ LMS-HDA-Y2.5
‘ ---|jF'aneI01—HD5-v2.5
---ﬂPanelﬂz—HDS-vz.S

The Panel folder icon represents a set of
markers. Clicking a panel folder displays the
Marker table. For SNP kits, clicking a panel
folder also displays a plot view.

E-E&Panel Manager
E I LMS-HDE-W2 5
- E-EDPanelll-HD5-V2.5
o o D182TaT
D15249

The Marker icon represents an individual
marker. Clicking a microsatellite marker
displays the Bin view. Clicking an SNP marker
displays the Bin table.
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Panel Manager Window Commands

Introduction The tables in this section describe the following Panel Manager views

and menus.
Topic See Page
File Menu 4-6
Edit Menu 4-11
Bins Menu 4-12
View Menu 4-20

File Menu The File menu offers options to the user to create or export kits,
duplicate, import and export panels, and import and export bin sets.

[Rl=l Edit BHins Miew
Mew Panel... Ctrl+M
glicate Earel

] e e = e e
Import Bin Set... Cirl+5hif+B
Export Panels... Cirl+E
Export Bin Set.. Cirl+5hif+E
Export All Kits... Clrl+k
Print... Ctrl+P

New Kit/Panel/Marker

The New Kit/Panel/Marker command changes its name and function
depending on the item selected in the Panel Manager navigation pane
as follows:

4 New Kit — This menu item is enabled when the Panel Manager root
node is selected in the navigation pane and allows creation of a
new kit folder. When creating a new kit:

— Enter in a unique kit name

— Select the appropriate kit type (microsatellite or SNP) from the
drop-down menu

— Click OK to add kit to navigation pane
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4 New Panel — This menu item is enabled when a kit folder is
selected in the navigation pane and allows creation of a new panel
folder. When creating a new panel:

— Select the “New Panel” name in the right hand window table
and enter in the desired name. Names must be unique within
the database.

— Repeat to add multiple panels to a kit

— Press [Enter], then click Apply after entering a Panel name to
update the navigator pane

¢ New Marker — This menu item is enabled when a panel folder is
selected in the navigation pane and allows creation of a new
marker. When creating new markers:

— Select the “New Marker” row in the right hand window table and
enter in the appropriate information for each column. Refer to
“Marker Table View” for more information.

— Repeat to add multiple markers to a panel
— Press [Enter], then click Apply to update the navigator pane

Duplicate Panel

The Duplicate Panel command creates a copy of a selected panel and
places it in the same kit as the original with the name “[Selected
Panel]-dup”. The panel and all associated bins with all bin sets are
duplicated as well. This menu item is enabled when a panel folder is
selected in the navigation pane.
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4-8 Using Panel Manager

Import/Export Panels

Lookin: | Panels | | Ic_bﬁl =

Install Standards Panels.td
LMS-HD5-v2.5 Panels b
LW3S-MD10-W2.5 Panels bt
Microsatellite Tutorial Panel td

File name: |F'ane|s Import |
Files oftype: |l Files (=) ~|  cancel |

The Import Panels command and the Export Panels command open the
corresponding dialog box to allow importing/exporting of kits and
panels. This is enabled when the Panel Manager root node is selected
in the navigation pane. See “Formats of Panel and Bin Text Files” for
more information.

Export Panels is not available when the Panel Manager root node is
selected; it is only active when a kit is selected.

Import/Export Bin Set

The Import Bin Set command and the Export Bin Set command open
the corresponding dialog box to allow importing/exporting of bin sets.
This is enabled when a kit name is selected in the navigation pane. See
“Formats of Panel and Bin Text Files” for more information.

When bins are imported into a kit, GeneMapper software checks for
bins that fall outside of their marker allele size ranges. If bins overlap or
fall out of the marker range the Import Bins Options dialog box will
open.
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Import Bins Options ﬂ

—Select Option

& ndjust marker ranoe & delete out of bounds hing

" Increase marker range to accomaodate all hing

[ Delete all overlapping and out of bounds bins

[5]:8 Zancel

The Import Bins Options dialog box allows you to choose how
GeneMapper software handles the bins being imported. The numbered

lines in the graphic above refer to the individual numbered descriptions
in the figures on .

1.The option shown below adjusts the marker range to
accommodate any bins that overlap the marker boundaries and will
delete all bins that fall completely outside the marker size range.

1 - Adjust marker range and delete out-of-bounds bins

Marker Range 100 - 110 Marker Range 98 - 114
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— The option shown below increases the marker allele size range
to accommodate all overlapping and out of bounds bins.

2 - Increase marker range to accommodate all bins

Marker Range 100 - 110 Marker Range 88 - 116

— The option shown below does not affect the marker allele size
range, all overlapping and out of bounds bins are deleted.

3 - Delete all overlapping bins and out-of-bounds bins

A B € D E F G D E

‘

Marker Range 100 - 110 Marker Range 100 - 110

If all the bins in an import are inside their marker ranges, the dialog box
does not open.

Backing up Panels and Bin Sets

The only way to back up panels and bin sets is to export them. You will
be prompted for a location and name for the exported item. See “Export
All Kits” on page 4-11.
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Export All Kits

The Export All Kits command opens the Export All Kits dialog to allow
exporting all kits and their associated panels, markers, and bin sets to a
selected location. When you use this option, panels retain their current
panel name as listed in the Panel Manger. Bins are named as follows:
[Kit name]_[Bin set name]_bins.txt.

Print

The Print command opens the Print dialog box to enable printing.

Edit Menu The Edit menu contains the Undo command and the Clear command.

[=LlW Bins  Miew

Undo

The undo command allows for the Clear command to be undone.

Clear

The Clear command deletes items selected in the navigation pane from
the GeneMapper database, such as:

¢ Kits

Deletes the kit and all bin sets associated with that kit.
¢ Panels
¢ Markers

Use the Bins Menu items to delete bins and bin sets.
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Bins Menu The Bins menu contains commands to edit markers and bins.

m Wiy

Edit 5P Marker.. il +H
[Delete SHE Marker CArwE i+
Add Bin Crl+B

Edit Bin Crl+H
Delete Bin Ctrl+0
[ewy Bif =et..

elete Bin Set

Showe Project Alleles
Add Eeference Data.. Clil+R
Fanel Eeference [Data... Ciil+R

Ao Bir 05 (e
Auto Farel 05 (e
Edit SNP Marker

The Edit SNP Marker command opens the Edit SNP Marker dialog box
allowing the user to edit the marker name and bin information for the
selected marker. To enable this feature:

4 Select the menu item when a SNP marker is selected in the Panel
Manager Plot tab

OR
4 Right-click on a SNP marker or bin in the Panel Manager Plot tab

Additionally, SNP markers and bins can quickly be edited by changing
the data in the Panel Manager Table tab for a selected SNP Panel.
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Delete SNP Marker

The Delete SNP Marker command deletes the SNP marker, and
associated bins, selected in the Panel Manager Plot tab. To enable this
feature:

4 Select the menu item when a SNP marker or bin is selected in the
Panel Manager Plot tab

OR
4 Right-click on a SNP marker in the Panel Manager Plot tab

Add Bin

The Add Bin command creates a new bin associated with a panel as
follows:

¢ For microsatellite data:

Step | Action

1 Select a marker in the Panel Manager navigation pane.

2 Select the Add Bin menu item OR right-click within the allele size
range of the marker shown in the Panel Manager right-hand
window to select the New Bin option.

3 Drag the length of the desired bin range with the mouse.

Edit the bin information in the Add Bin dialog box that opens.

¢ For SNaPshot data:

Step | Action
1 Select a SNaPshot panel in the Panel Manager navigation pane.
2 Select a marker in the Plot tab.
3 Select the Add Bin menu item OR right-click on a marker or bin in
the Plot tab.

4 Edit the SNP Marker using the dialog box that opens.
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Delete Bin

The Delete Bin command deletes a marker bin as follows:
4 For microsatellite data:

Step | Action
1 Select a marker in the Panel Manager navigation pane.
2 Select a bin to be deleted.
3 Select the Delete Bin menu item OR right-click on the bin and

select the Delete Bin option.

¢ For SNaPshot data:

Step | Action
1 Select a SNaPshot panel in the Panel Manager navigation pane.
2 Select a bin to be deleted in the Plot tab.
3 Select the Delete Bin menu item OR right-click on the bin and

select the Delete Bin option.

Edit Bin
The Edit Bin command edits a marker bin as follows:
¢ For microsatellite data:

Step | Action
1 Select a marker in the Panel Manager navigation pane.
2 Select a bin to be edited.
3 Select the Edit Bin menu item, or right-click the bin and select the
Edit Bin option.
4 Edit the bin information in the dialog box that opens.

¢ For SNaPshot data:

Step | Action
1 Select a SNaPshot panel in the Panel Manager navigation pane.
2 Select a bin to be edited in the Plot tab.
3 Select the Edit Bin menu item, or right-click on the bin and select

the Edit Bin option.

4 Edit the bin information in the Edit SNP Marker dialog box that
opens.

4-14 Using Panel Manager

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com




To quickly resize a bin, select a bin and adjust the right and left handles
to the desired size range.

To move a bin, select a bin and holding down the mouse button, move
the bin to the desired location.

Edit Bin Dialog Box

Ix

Mame: (213

|

Locajion:mz-?D

Left offzet: IU.4U [ Mew offset default
Right UffSEtIF [ Mew offset default
[ Mutant Bin
ak | Cancel
Element Description
Name Editable; name of the bin can be alphanumeric.
Location Editable; location of the bin center in base pairs.
Left Offset Editable; the left boundary of the bin, expressed as the

base pair distance to be subtracted from the location
(default = 0.4).

Right Offset Editable; the right boundary of the bin, expressed as
the base pair distance to be added to the location
(default = 0.4).

OK Accepts the pending changes and closes the dialog
box.

Validation: the following criteria apply:

4 The edited bin must have a name unique in its
marker.

4 The edited bin must have a location and offsets that
do not overlap any other bins in the marker.

If validation fails, an alert message will be displayed.

Cancel Closes the dialog box without accepting the pending
changes
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Element Description

New Offset Checking this box sets a left and right offset default, to
Default (checkbox) | be used for subsequent creation of bins.
Mutant Bin Designates a bin as a mutant. Bin color is red.

New Bin Set

The New Bin Set command opens the New Bin Set dialog box, allowing
the user to create a new bin set for the selected kit. Clicking OK checks
the name for uniqueness; if the name is not unique, an alert is shown
and the dialog box closes. The new bin set name then displays at the
top of the Panel Manager window in the Bin Set pull-down menu.

Note Bin sets are always created at the kit level.

Note SNP kits can only contain one bin set.

tg* New Bin Set x|
@ Flease enter narme of new Bin Set.
(0] 4 Cancel
Delete Bin Set

The Delete Bin Set command deletes the bin set currently listed for a kit
in the Bin Set drop-down menu at the top of the Panel Manager window.
If there are multiple bin sets associated with a kit, use the drop-down
menu to select the appropriate bin set to be deleted.

Note This action cannot be undone.

& Delete Bin Set x|

@ This action cannot be undone. Do you want to continue?
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Show Project Alleles

The Show Project Alleles command displays all of the marker’s allele
calls that are present in the Genotypes table of the open project. Allele
calls are displayed as blue asterisks. This option is enabled when a
marker is selected in the Panel Manager navigation pane and
genotypes exist for that marker. The option is for microsatellite data
only.

Add Reference Data

The Add Reference Data command opens the Add Reference Data
dialog box, allowing the user to associate data with a microsatellite
panel or SNaPshot kit for creating markers and bins.

&andd Microsatellite Reference Data x|
Edit

Samples To Add:

earch Criteria

All -

Froject

Sample

Analysis ;l

Search Results Search

[#-__] Microzatellite Tutarial

Lo | 1 ] e

For microsatellite panel reference data, samples must have been
analyzed using the panel for which the data serves as a reference and
the appropriate size standard.

For SNaPshot kit reference data, samples must have been analyzed
using the appropriate size standard and an Analysis Method with
SNaPshot as the Analysis Type.
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Panel Reference Data

This feature now works for both microsatellite and SNP data.
¢ SNP data

The Panel SNP Reference Data command opens the SNP
Reference Data dialog box, allowing the user to organize the
reference data imported at the kit level into panels. This feature is
only used when creating panels manually, not when using the Auto
Panel feature. The panel is enabled when a SNaPshot panel is
selected and reference data has already been added at the kit level.

4 SNP Reference Data o x|
SMP kit reference data: SMP Panel reference data:

_4 SNaPshat Tutorial _4 Bplex Sample

s A111347-15053 ~—# AlBnapshot Controlfsa

#® 451347-01 fsa
@ AT1347-02fsa | =
Lew A1347-10053

Rermove | Eermove |

Ok | Cancel |

4 Microsatellite data

The Panel Reference Data command allows you to remove
reference samples from the selected microsatellite panel.

% Microsatellite Reference Data x|
Microsatellite Panel reference data:

Remove |

oK | cancel |
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Auto Bin

The Auto Bin command opens the Auto Bin dialog box to automatically
create bins for a microsatellite panel. This feature is enabled when a
microsatellite panel is selected and reference data has been selected.
Refer to the Microsatellite Tutorial for more information.

Minimum guality value |0 1‘

Allele Maming Scheme

@ Number (1,2, 3,4, .
 Lefler(A,B,C,D, )

™ Rounded hasepair (100, 200, 300)

Auto Bin Options:

& Auto Bin (clear existing bins)

© Incremental Auto Bin (keep existing bins)

ok | _cancal |

Auto Panel

The Auto Panel command opens the Auto Panel dialog box to
automatically create panels, markers and bins for a SNaPshot Kit. This
feature can only be used with reference data generated from the

ABI PrisM® SNaPshot Primer Focus Kit. Refer to the SNaPshot Tutorial
for more information.

Eganuto Panel x|

"~ Save Existing Panels

Allele Mames

Woewe o Yallow  [o]
W Green IA_ | IT_

rMarker multiple

Minimurm multiplex |5
Maximum multiplex |20
rPanel Name

Base Panel name |

rMarker Overlap

& Maximum overlap
Mo averlap

Mumber of basepairs between markers |5

Ok | Cancel |
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View Menu

Full Wiewy Ctrl+]

H Axis Scale ]

' Axis Scale ]

Cwes ]
Full View

Depending on the X- and Y-axes mode, the Full View command resets
the X- or Y-axis to the:

4 maximum range
¢ panel size range
4 most recent Scale To range

X Axis Scale for SNP data

cale Scale to maximum

Y Axis Scale P & Scale to panel size range

Diyes ] Scalefo..

The X Axis Scale menu command controls the horizontal scale of the
reference data electropherogram being viewed in the Panel Manager as
follows:

4 Scale to maximum — The electropherogram being viewed is scaled
to its maximum base pair length as collected from the instrument.

4 Scale to panel size range — The electropherogram being viewed is
scaled to the size range available for the selected panel.

4 Scale to - The user can define the horizontal range being viewed.

To zoom in to a specific region on the X-axis of the electropherogram:
4 Click and drag with the left mouse button the desired region on the

X-axis.

OR

4 Right-click on the X-axis to open the X-Axis Scale menu command
options.
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X Axis for Microsatellite data

cale e | B

' Axis Scale * @ Scaleto marker size range

Diyes ] Scalefo..

The X Axis Scale menu command controls the horizontal scale of the
reference data electropherogram being viewed in the Panel Manager as
follows:

4 Scale to maximum — The electropherogram being viewed is scaled
to its maximum base pair length as collected from the instrument.

4 Scale to marker size range - The electropherogram being viewed
is scaled to the size range available for the selected marker.

4 Scale to - This setting allows the user to define the horizontal range
being viewed.

To zoom in to a specific region on the X-axis of the electropherogram:

4 Click and drag with the left mouse button the desired region on the
X-axis.

OR

Right-click on the X-axis to open the X-Axis Scale menu command
options.

Y Axis Scale

#® Scale to maximum
Diyes ] Scalefo..

The Y-Axis Scale menu command controls the vertical scale of the
reference data electropherogram being viewed as follows:

4 Scale to maximum — The electropherogram being viewed is scaled
to its maximum height as.

¢ Scale to- The user can set the Y-Axis scale value.
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Artisan Technology

To zoom in to a specific region on the Y-axis of the electropherogram:

4 Click and drag with the left mouse button the desired region on the
Y-axis

OR

4 Right-click on the Y-axis to open the Y-Axis Scale menu command
options.

Dyes

il v Blue Dye  Cirl+1
¥ Showe SMP Bins v Green Dye  Cirl+2
v lellow Cye  Cirl+3
v Red Dye Ctrl+4
¥ Orange Dye Cirl+5
¥ All Dyes Clrl+6

The Dyes menu item controls the dye colors shown when viewing
SNaPshot reference data and microsatellite reference data
electropherograms in the Panel Manager Plot view. Checked when
active. Multiple dye colors may be selected.
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Formats of Panel and Bin Text Files

This section provides an example of a file used to import panel
definitions and a file used to import bin definitions. Files like these are
created using Microsoft® Excel or other spreadsheet programs. Files
must be saved as a tab-delimited text file.

Topic See page
Panel Definition Example 4-24
Bins Definition Example 4-26
Panel Definitions for SNaPshot 4-28
Bins Definitions for SNaPshot 4-30
Import and Export Files 4-32
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Panel Definition The examples below show panels defined in the format used by
Example GeneMapper software v3.0 for a panel definition in a tab-delimited text
file (.txt) using notepad or wordpad, or a Microsoft® Excel spreadsheet
saved as a .txt file.

i Microsatellite Tutorial Panel.txt - Notepad - 1Ol x|
File Edit Format Help
version GM v 3.0 =]
KAt type: MICROSATELLITE
Chemistry Kit Microsatellite Tutorial none
Panel Tutorial Panel 9 nong
D6a5264  EBlue 108.0 130.0 - 2 0.0 nonea
DEs1574 Blue 14a.0 172.0 - 2 A ] nane
DES27E  EBlue 201.0 233.0 - 2 o] nane
055408 Elue 249,0 285.0 - 2 [A] nane
DES308  Blue 326.0 354, 0 - 2 0.0 nane
DESZEY  Green 104.0 138.0 - 2 0.0 nonea
DBs292 Green 134.0 178.0 - 2 A ] nane
02434 Green 201.0 245.0 - 2 o] nane
055426 Green 274.0 208.0 - 2 [e] nane
0551981 vellow 115.0 125.0 - 2 0.0 nong
065257 vellow 167.0 1%5.0 - 2 0.0 nong
065446  vellow 212.0 234.0 - 2 0.0 nong
p5sedl  vellow 299.0 339.0 - 2 0.0 none
055433 Red g9, 0 GG, 0 - 2 o] nane
p5s422  Red 118.0 140.0 - 2 [A] nane
DSs406  Red 168.0 156.0 - 2 0.0 nane
DSs400 Red 221.0 243.0 - 2 0.0 noneg
DES30%  Red 3207.0 333.0 - 2 (A ] nane
1 2 3 4 5 6 7 8
Columns:
1: marker name
2: dye color
3: min ASR (ASR = allele size range; actually the marker size range)
4: max ASR
5: control allele names as comma-separated bin names (1, 2)

(if none, there must be a dash “-”)
6: type of repeat (2 = dinucleotide, 3 = trinucleotide, 4 = tetranucleotide,
5 = non-repeat)
7: marker-specific stutter ratio (if none, use a zero “0”)
8: comments (if none, write “none”)
Notice that there are no extra rows between markers and panels.
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A Microsoft Excel - Book1 : -0l x|
J File Edit Wiew [nsert Format Tools Data window Help -|ﬁ'| il
D2EHSk(Be = 4 4 o - 2[A-2
J23 - =
A B | ¢ [DIEFG[ H | T
| 1 |Version GMv 3.0 =
| 2 |Kit type: MICROSATELLITE
| 3 |Chemistry kit |Microsatellite Tutarial none
| 4 |Panel Tutorial Panel 9 nane
| 5 |DESZ264 Blue 108 130 - 2 0 none
| B |DBE1574 Blue 146 172 - 2 0 nane
| 7 |DBEE27E Blue 201 233 - 2 0 none
| § |Das408 Blua 249285 - 2 0 none
| 9 |De5308 Blue 326 354 - 2 0 none
| 10 | DES257 Green 104 138 - 2 0 none
| 11 |DEE232 Green 154 176 - 2 0 none
| 12 |DES434 Green 201 245 - 20 none
| 13 |Da5426 Green 2741295 - 2 0/none
| 14 | D&51381 Y ellow 15125 - 2 0 none
| 15 |DES257 fellow 167 195 - 2 0 none
| 16 |DES446 fellow 2121234 - 2 0 nane
| 17 |DaSE41 Y ellow 299 339 - 2 0 none
| 18 |Da5433 Fed 69| 99 - 2 0 none
| 19 |Da5422 Red 118 140 - 2 0 none
| 20 | D55406 Red 168 196 - 2 0 none
| 21 |DaE400 Red 21 243- 2
| 22 | DEE309 Fed 307 333- 2
73
|4 ] 4w [¥i]}5heet1 & sheetz #fheets /| 4]
Red [ | | (UK |
1 2 3 4567 8
Columns:
1: marker name
2: dye color
3: min ASR (ASR = allele size range; actually the marker size range)
4: max ASR
5: control allele names as comma-separated bin names (1, 2)
(if none, there must be a dash “-”)
6: type of repeat (2 = dinucleotide, 3 = trinucleotide, 4 = tetranucleotide,
5 = non-repeat)
7: marker-specific stutter ratio (if none, use a zero “0”)
8: comments (if none, write “none”)

Notice that there are no extra rows

between markers and panels.
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Bins Definition The examples below show bins defined in the format used by
Example GeneMapper software v3.0 in a tab-delimited text file (.txt) or an Excel
spreadsheet saved as a .txt file.

Note The ASR in the bin definitions file should match the ASR in the Panels
definition file. Also, kit, panel, and marker names must be the same between the

two files.
=10
File Edit Wiew Insert Format Help
D|E?|E| @@d M| r}$||ﬁ|'ﬂ| @9|
Version GM v 3.0 = 1
Chemistry Kit Genelcan Installation Standards 2
BinZet MName 3730 D3-33 Install Eins 3
Panel MName D3-33 4
Marker MName D203119 5
113 112.92 0.4 0.5
119 118.75 0.4 o.5
Marker MName D9316290
239 239.3 0.4 0.5
241 241.3 0.5 0.5
Marker HName D53644
85 54.94 0.4 0.4
o7 S95.95 0.4 0.5 e
Marker MName DE53424
218 218.24 0.4 0.5
Zz0 220.15 0.5 0.5
Marker MName DI3IZE5
137 137.45 0.4 0.4
146 146.2 0.4 0.4
Marker MName D183462
303 303.05 0.4 0.4 |
For?—‘elp, pressFl‘ ‘ ‘ MUM
1 2 3 4
Columns: Rows:
1: bin name 1: GM version number
2: bin center 2: Kit name
3: bin left offset 3: bin set name
4: bin right offset 4: panel name
5: marker name
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A Microsoft Excel - Book1 o ]
J File Edit Wiew [nsert Format Tools Data indow Help -|5’|5|
DR &R 2 = A& 28 @we - 2]A-2
EZ3 - =|
A : |
| 1 |Version GMv 3.0 i
| 2 |Chemistry Kit GeneZcan Installation Standards 2
| 3 |BinZet Mame |3730 D5-33 Install Bing 3
| 4 |Panel Name |DS-33 4
| 5 |Marker Name 0205113 5
| B | 113 11292 0.4 05
| 7 119 11875 0.4 05
| G |Marker Name D351690
9 239 2393 04 05
|10 | 241 2413 05 05
| 11 |Marker Name |DGE6E44
| 12| a5 8494 0.4 04
[13] a7
|14 | Marker Name |D85424
| 15 | 218
|16 | 20
|17 |Marker Name |DI5255
|15 137
19 146
| 20 |Marker Name | D185462
21| 303
|4 (4 [»]"Sheet1 sheetz f Sheets
A I
—
1 2 3 4
Columns: Rows
1: bin name 1: GM version number
2: bin center 2: Kit name
3: bin left offset 3: bin set name
4: bin right offset 4: panel name
5: marker name
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Panel Definitions The examples below show SNP panels defined in the format used by
for SNaPshot GeneMapper software v3.0 in a tab-delimited text file (.txt) or an Excel
spreadsheet saved as a .txt file.

4§ sNPdemo.tut - Notepad - 1Ol x|
File Edit Format Help
version GM v 3.0 =]
Kit Type: SHP
Chemistry Kit SHPdema none
pane’l Gplexdemo none
20mer - nong
28mer - nonea
3amer - none
44mar - none
SZmer - nane
a0mer - nong
1 2 3
Columns:

1: marker name

2: control allele names as comma-separated bin names
(A, G) (if none, there must be a “”)

3: comments (if none, write “none”)
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FA Microsoft Excel - Book2

J File Edit Wiew [nsert Format Tools Data indow Help

=10l x|
=81x|

DR &ER 2= A8 @ - 2|A-2
F12 | =
A | B | c| Do | E | FE‘
| 1 |Version GMv 3.0
| 2 |t type: NP
| 3 |Chemistry kit SNPdemo nane
| 4 |Panel Bplexdema |none
| 5 |20mer nane
| B |2Bmer nane
| 7 |3Bmer nane
| G |ddmer nane
| 9 |5dmer nane
| 10 |EOmer nane
11 hd
|4 ] 4[p[p]Sheet1 [ Sheetz f sheatz 7 |« ﬂJJ
R 0 hom) my’
1 2 3
Columns:

1: marker name

2: control allele names as comma-separated bin names
(A, G) example (if none, there must be a “-”)

3: comments (if none, write “none”)
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Bins Definitions The examples below show SNP bin definitions in the format used by
for SNaPshot GeneMapper software v3.0 in a tab-delimited text file (.txt) or an Excel
spreadsheet saved as a .txt file.

Note ASR = Total allele size range. The allele size data automatically exports
and then the range is printed.

_I5x]
File Edit Format Help
version GM v 3.0 =]
Chamistry Kit SHPdamo
Binset Mame SHPdemn
Panel Mame 6plexdemo
Marker Mame 20mer
ASR 24.6 26.1
A 24.6 26.1 Graean
mMarker MName 28mer
ASR 27.3 29,98
5 27.3 29.0 Elue
A 28,15 28,0 Green
marker name 36mer
ASR 358.4 40,2
G 38.4 40,1 Blue
mMarker Mame 44mer
ASR 46,8 48.8
T 46,8 48,8 Red
marker name 52mer
ASR 55.1 55.2
I 53.1 54.6 vellow
T 54.0 55.2 red
mMarker kame almer
ASR G6l.4 G63.0
I 61.4 63.0 vellow _J
I — M
1 2 3 4
Columns:
1: bin name

2: bin size range min
3: bin size range max
4: bin color
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Book3

Ed Microsoft Excel -
File Edit Wiew [nsert Format Tools Data ‘Window Help

=10l x|

=18 %]
DEE &R 2 = 8w - 2[A-?
F26 - =|
A | B Jc[Do] E |3
| 1 |%ersion GhWw 3.0 =
| 2 |Chemistry Kit ZNPdemo
| 3 |BinZet Mame ShPdemo
| 4 |Panel Name Bplexdemo
| 5 |Marker Name 20mer
| B |ASR 246 26.1
7 A 246 Z6.1 Green
| G |Marker Name 28mer
| 9 |ASR 273 299
101G 273 29.1 Blue
11 A 285 299 Green
| 12 |Marker Name 38mer
| 13 [ASR J6.4 40.2
14 |G 368.4 40.2 Blue
| 158 |Marker Mame ddmer
|16 [ASR 468 43.8
17T 46.8 43.8 Red
| 18 |Marker Name 52mer
| 18 [ASR 531 85.2
|20 [C 531 54.6 Vellow
21T 54 552 Red
| 22 |Marker Name B0mer
| 23 |ASR B1.4 B3
4 |C B1.4 B3 Vellow
4 b [bi\\Sheet1 { Shestz f Shest | ¢
I [
1 2 3 4
Columns:
1: bin name

2: bin size range min
3: bin size range max

4: bin color
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Import and Export The Panel Manager imports and exports two text file data formats,
Files panel data and bin set data. These files are tab-delimited and the
following rules apply:

4-32

¢

Files to be imported must have the correct number of columns in
the correct order.

On import, panel and bin set names are checked for uniqueness in
the GeneMapper™ database and markers are checked for
uniqueness within the panel that will contain them. An alert is
presented if a name is not unique and such a file cannot be
imported.

If any errors are found during import, no data from the file is
accepted by the Panel Manager.

Lines beginning with “#” are comments and are ignored on import.

Both Panel and Bin set file formats have a header line with a
GeneMapper software version string:

Version GM v 3.0

If the first line of a file to be imported does not begin with “Version
GM,” then GeneMapper software handles the import as a
GeneMapper software 1.x panel import. If the file is in GeneMapper
software 1.x format, then it is imported without errors. If the file is in
GeneMapper software 2.x or 3.x format, the file will not be imported
and the following error alert will be presented: “The format of this
file is wrong. Correct the file and try again.”

If the data type label does not match the type specified in the import
command, the file is not imported and an alert is presented.

A PanellmportLog.txt file is generated during import of a panel or bin
set and will list any errors encountered. This file is found in the
GMdistribution\app folder on your hard drive. Panels and bin sets
created in GeneMapper software v1.0.2 or GeneMapper software v2.0
are automatically updated when imported into GeneMapper software
v3.0
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Panel Table View

Introduction Selecting the Panel Manager icon or text in the navigation pane (left
pane shown below) shows a table of the current Panel Manager folders
or kits in the right portion of the window. Selecting a particular kit
produces a list of panels in the right portion of the window. This list is
called the Panel Table view.

Tasks you can perform in the Panel Table view include:
¢ Editing panel names and entering comments in the panel table
4 Creating new panels using the New Panel command

¢ Deleting an existing kit by selecting it in the Navigation pane and
then choosing the Clear command

¢ Exporting panels and bin sets used for project analysis to backup

Note Editing or deleting kits, panels, and bin sets will prevent your from
displaying analyzed projects. Export any panels and bin sets that you might use
at a later date, or for reanalysis of old projects.

(i Panel Manager [ =]
File Edit Bins Wiew
cr B [ W N[ einset[erree. <] I E # Cx B iil_i|
——

] Eit Hone Eit Type Commart.

[snPderna 1 [NFdemo BN none

E-CILME-MD1D 3 [LMs-MD1D Microsatellite  |none

- CJAmpFISTR_Panels_v3

- C]LMS-HDS 3 |AMpFISTR_Panels_v3 |Microsatellite  |none

- LMSHDA-Y25 4 |LME-HD5 Microsatellite  |none

CILmMS-LD20 5 |LMSHDS-v2.5 Microsatellite  |none

- CILMSMD10-V25 E |LhS-LD20 Microsatellite  |none

7 |[LMaMDn-vz 5 Microsatelite  |none
=IReference Samples |
oK | Cancel | Apnly |

Note A Warning alert is shown whenever kits or panels are deleted to remind
you that this reference data may have been used previously in Sample analysis.
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Panel Table The table below lists the columns in the Panel table:

Columns Note All columns are resizable.
Column
Name Description
Panel Editable. Contains the name of the panel. Cell accepts
Name alphanumeric characters (restricted for any invalid symbol
characters — includes all Microsoft Windows invalid
characters).

Note When the cell is closed, the software must check that
the name is unique. An alert message will display if the name
is not unique.

Comments | Editable. Contains comments regarding the panel. Cell
accepts alphanumeric characters.

Name Rule for Panel names must be unique (within a kit and across kits).
Panels
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Marker Table View

Introduction Selecting a panel in the navigation pane displays the Marker table for
that panel. The Marker table, shown below, enables you to view, create,

and edit marker names and associated data.

iz Panel Manager [<]
File Edit Bins Wiew
w0 OE W Bin get | = [ [ e |
5 EDLMSMD0-V2.5 Bfiker Hume | Dye Color | Bifn Sise |Max Sine | Conerol Allales | Muker Rapes | ukr Specific S | Commers [Ladter A1l
Pangl01-MD10-Y: 1 Blue 0 1 g 2 0.0 none
LJPanelZ-MDT0VZ: |15 015045 |Biwe  |160.0 1800 166,176 |2 nn none
[IPansIna-MD1 042 :
paneinsnpinvz. | |3 (D152800 lBe  |a0s0 (2210 |207.207 (3 nn none
CIPansins-mDiovz: |4 (D15234  |Blue (2620 (2840 (270,274 2 nn none
[IPansif-mD10-v2: |15 (015450  |Bue (3150 (3410 (331,338 2 nn none
JPanel07-MD10V2: | |5 [hy5a6s | Green (640 1060 8898 2 nn none
[IPansIng-MD1 42 ;
[TPancioswpioyas | |7 (D182887 [Green [121.0 [1810 [1371a1 |3 nn none
[CPansll0-MD10-v2 . | |B |D152785 |Green |170.0 1840 (178,182 2 nn none
[Pansi1-MD10-¥2: g (0152880 |Gresn (2100 (2340 210214 2 nn none
[DPane ZMDT0V2: | |10 (0y5ans  |Green (2720 2880 274,276 |2 nn none
[IPansll 2-MD10-v2 1 L
JPanehanpinvz, | |11/D18198  |Green [3200 (3380 (328,328 |3 nn none
[IPansll &-MD10v2 ¢] 12018213 [vellow 1030 1280 108115 2 nn none
4 I~ |13 0150878 [velow 1480 1780 154068 2 nn none
SReference Sample |14 pya2ne_lveine Lonsn TR 0o T _»|J
OK Cancel Apply
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Marker Table The figure on page 4-35 shows the columns in the microsatellite marker
Columns table. They are further described in the following table.

Marker table column descriptions:

Column Description
Marker Editable. Contains the name of the Marker. Cell accepts
Name alphanumeric characters from the keyboard. The field is

validated if the marker name is unique in the panel.

Note Marker names are case insensitive (i.e., D1S83 is the
same as d1s83).

Dye Color Editable. Contains the color names blue, green, yellow, red,
orange. The field is validated if it is one of these text strings,
which are not case-sensitive.

Min Size Editable. Contains the starting base pair number for the
allele size range. Cell accepts numeric characters from the
keyboard.

The range defined by the Minimum Size parameter should
include the stutter peaks for the smallest allele.

Max Size Editable. Contains the ending base pair number for the allele
size range. The cell accepts numeric characters from the
keyboard.

Control Editable. Contains a comma separated list of control allele

Alleles names in the marker. No validation.

Marker Editable. Indicates a di-, tri-, or tetra-nucleotide repeat.

Repeat

Contains a number for the number of repeats: 2, 3, 4.

The field also accepts 9 for nonrepeat containing markers.
The field is valid if it contains 2, 3, 4, or 9; any other number

is invalid.
Marker Editable. Contains the ratio of stutter peak to main peak.
Specific Sets the maximum value of stutter for a specific marker, as

Stutter Ratio | opposed to using a global value for all markers.

Comments Editable. Contains comments regarding the marker. Cell
accepts alphanumeric characters from the keyboard.

Ladder Editable. Comma-separated list of allele names in the allelic
Alleles ladder. No validation. Applicable only to Human Identification
(HID) genotyping or applications that use allelic ladders.
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Bin View - (for Microsatellites Only)

Introduction The Bin view enables you to view, create, and edit bins. The data

Description of the
Bin View

displayed in the Bin view, imported into the Panel Manager using the
Import BinSet command, is used to create the bins associated with the
marker.

Bins allow the user to average the minor variations in size that occur
from run to run and capillary to capillary.

(@ Panel Manager
File Edit Bins Yiew
B < TN DT =E e et [~] R lilil_lil_llﬂT |
=I5 Panel01-MD10 -
0152787 Bins
""" 0152797 J 102 104 106 108 MO M2 114 18 1B 120 122 124 125 129 130132 134 135 139 140
. (2 104 16 108 10 1iE 1} 1) 16 10 122 13 126 12 jn 13z 134 198 9

02
ot

[
950 882 1014 104E 1078 1110 142 174 1206 1288 1270 1302 1334 1386 1393 1430 1482

4

=IReference Samples | Location =121.98 bp

OK Cancel Apply

Reference Data, Bins, and Allele Calls

Reference data includes descriptions of bins (name, location, and
boundaries) and the sample allele calls used to construct the bins. In
the Bin view, the vertical bars are bins that are originally associated with
the Markers imported as reference data. The “+” symbols shown in the
figure above (marked in red on the monitor) are from the reference
alleles used to build the bin set indicated in the drop-down menu at the
top of the window. The red + s shown when those alleles are used in the
autobinning process or in the manual process of bin creation.
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ig# Panel Manager x|
File Edit Bins View

x5 % s (B Binset [3100avantDs33 - jEmEE [mE m |M||

E-&Panel Manager
B[S GeneScan Insta 112 118
. Dos

9
-D881630
D35644
-D95424
-D85288
- D185462

-DEB3289
- 188117
(R =1
S SNPdemo
- Jhplexdemn

| | 3

El-&IRefarence Samples
- DE33 LMS fsa

+ +

0.0
98 100 102 104 106 108 110 112 114 116 118 120 122 124 136 128
D20s119

K1 [ _>i

| |

=

Marker D205118 ¢103.00-123.00)

oK | Cancel | Anply |

If you analyze data using a bin set like that shown above, you will see
the + s as shown above. Then, when you click the Show Project Alleles
icon,

W the + s will be overlaid by a set of “*” symbols (marked in blue

on the monitor), which represent the data associated with a particular
bin for the current project in the Project window and called according to
the allele associated with the bin.

Bins may be used for calling alleles with or without allele calls in the
reference data, but project alleles (* s) are required for automatic bin
generation (the Auto Bin function). Reference alleles (+ s) are identified
as a result of the Auto Bin command.

Selecting a reference data sample in the navigation pane displays that
particular sample’s electropherogram with bins overlaid to provide easy
viewing while editing markers.

X- and Y-axes, Genotype Quality Symbols, and Cursor Location
Information

The Bin view X-axis is the fragment size in base pairs; the Y-axis is
quality, or signal height if a reference sample is selected. Vertical
shaded bars are the bins that will be used to call alleles for the selected
marker. The symbols (blue stars), described above as Allele Call
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indicators, represent Genotype quality values on the Y-axis for the
alleles of samples that have been analyzed and are currently displayed
in the open project. The equivalent positions in the reference data are
marked with red + s.

The Genotype quality values, representing analysis results, are not
editable. Bin location, boundaries, and names are editable. Cursor
location in base pairs for any selected bin are shown under the X-axis to
the left. The Bin Sets drop-down menu, located just above the Bin view
pane, selects the bin set that is applied to the marker.

Marker Allele Size Range (ASR)

Reference data for bins includes the marker ASR. This is the size range
of bins in a marker and is set by the user to allow multiplexing of
markers in a sample; an ASR should be changed only when a marker is
under development.

ASR boundaries can be edited in the marker table or in the Bin view by
adjusting the ASR handles on the right and left hand sides of the
screen. The bins in a marker must not extend beyond the marker ASR.
When bins are created and viewed in the Bin view, they are restricted
so that their range does not extend beyond the marker ASR. The Show
Alleles command may show new allele calls for a marker outside that
marker’s ASR, but bins cannot be created or extended to include alleles
outside the ASR. To create bins for alleles that fall outside the ASR, edit
that marker’'s ASR first and then click Apply. Then you can add a new
bin.

Bins must not overlap in a microsatellite marker. When bins are created
and edited, their locations and offsets are restricted to avoid overlap.

Import and export commands for panels and bin sets are enabled in the
table views of the Panel Manager. Imported bin set reference data
includes the bin boundaries but not sample reference data (the “+ s”).
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Automatic Bin This section discusses the features of the Automatic Bin Builder (ABB)
Builder and and Automatic Bin Assignment Algorithm (ABAA).

Automatic Bin
Assignment

Algorithm The ABB process is used, along with the outcomes of the Multiple Allele
Peak Determination Algorithms (MAPDA) and in conjunction with the
ABAA to ensure that the called alleles are of the highest accuracy. The
key benefit of combining these algorithms with the ABB is that, since
only a small number of questionable alleles result from the integrated
process, manual reexamination of the allele information is significantly
minimized.

Combining Unique Features

Automatic Bin Builder

The ABB is the first step in accurate allele assignment. The process of
creating bins starts with a collection of Sample files. Bins are created by
the ABB based on the chosen panel information and successive allele
calls from the Sample file collection. As each Sample file in the
collection is processed, the bin definitions are refined to reflect the
actual data. The bin centers and widths continue to be refined until all
Sample files in the collection are processed and GeneMapper software
is ready for its final step of allele calling, Automatic Bin Assignment.

Automatic Bin Assignment Algorithms

Once bins are completely defined by the ABB, allele peaks are
accurately and automatically assigned to their corresponding bins to
complete the allele calls using the ABAA. The allele assignment
algorithms calculate the certainty of each allele peak assignment, and
determine if an allele should be called. Bin assignment quality values
are assigned to the allele and become part of the overall PQVs.

Questionable alleles are appropriately marked with either a

“Check /\” or“Low Quality @” status marker. See the table under
“Genotype View Columns” on page C-7 for more information on how
this information is displayed in the Genotypes view.
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Using Analysis
Methods

Chapter Overview

Introduction This chapter provides information on how to use the Analysis Methods
feature in the GeneMapper Manager window of the ABI Prism®
GeneMapper™ Software Version 3.0, and describes how to use the
features of the Analysis Method Editor.

In This Chapter This chapter contains the following topics:

Topic See Page
Analysis Methods Tab 5-2
Analysis Method Editor 5-5
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Analysis Methods Tab

Introducton

Default Analysis
Methods

The Analysis Methods Tab is used to create custom analysis methods
for analyzing sample files. An analysis method is a set of algorithm

parameters that are applied to data during analysis.

GeneMapper software v3.0 contains the following standard Applied
Biosystems profiles:

Detection
Default Analysis Type Bin Set Algorithm
Microsatellite Microsatellite None Basic
SNP Genotyping | SNP Genotyping | None Basic
3730 DS-33 Microsatellite 3730 DS-33 Basic (For use
Install Install Bins with the Applied

Biosystems
3730 DNA
Analyzer only)

Note These profiles can be altered but should not be deleted. They are
intended to be used as models for customizing new analysis methods.
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About the Analysis The Analysis Methods tab contains a list of analysis methods in the
Methods Tab database. This tab is used to manage the contents of the project

window.

To display the Analysis Methods tab, select Tools > GeneMapper

Manager > Analysis Methods.

\-:-,-,I GeneMapper Manager [ %]

Projects Analysis Methods | Table Setings | Plot Settings | Matrices | Size Standards |

MName Last Saved Owwner

Instrurment Analysis Type ]

|1 Default I2002-D4-D1 18:10:10.0 |G

Microsatellite

Il

I i |

Mew... Qpen... Save As... Impart...

Export...

Parts of the Analysis Methods tab:

Done |

Item

Description

Name column

Analysis method name

Last Saved column

Date/Time stamp showing when the
analysis method was last saved

Owner column

User name of the person who
created the analysis method

Instrument column

The type of instrument used

Analysis Type column

Identifies the analysis mode of the
analysis method (i.e., HID,
Microsatellite, SNaPshot)
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Parts of the Analysis Methods tab: (continued)

Item Description

New button Opens the New Analysis Method
dialog box. Always enabled.

This dialog box asks you to select
the analysis type before opening the
Analysis Method Editor.

The analysis type you select:
4 Sets the analysis algorithm

4 Displays the appropriate fields for
that type of analysis in the
Analysis Method Editor dialog
box.

Open button Opens the editor for a selected
analysis method. Enabled when a
analysis method is selected.

Save As button Displays the Save As dialog box.
Enabled when an analysis method is
selected.

Import button (.xml file type) Displays a dialog box for Importing

analysis methods. Always enabled.

Export button (.xml file type) Displays a dialog box for Exporting
selected analysis methods. Enabled
when one or more analysis methods
are selected.

Delete button Deletes the selected analysis
method(s)
Done button Closes the GeneMapper Manager
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Analysis Method Editor

Introduction The Analysis Method Editor allows you to create or edit analysis
methods to be used for analyzing your sample files. The analysis
method determines the type of application being analyzed and allows
for customization of the peak detection algorithm and quality value
settings.

Flowchart

Select Tools > GeneMapper Manager
Select the Analysis Methods tab

-

Click New

Select analysis type
In the General tab, type a name for the new setting

-

In the Alleles tab, select the bin set to use

-

In the Peak Detector tab, choose a peak detection
algorithm for your application

-

In the Peak Quality tab, set minimum requirements

-

In the Quality Flags tab, adjust PQV and threshold settings

-

Click OK to save

Project
window

GeneMapper
Manager window

Analysis Method Editor window
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Accessing the Access the Analysis Method Editor in the following ways:

Analysis Meﬂ_“’d ¢ Click Tools > GeneMapper Manager > Analysis Methods Tab >
Editor New or Open

4 In the Project Window, click the Samples tab. Click New Analysis
Method to create a new method, or double click an existing method
to edit it.

4 Select a sample in the project window and click the Analysis
Method Editor icon on the toolbar. Edit the currently selected
samples’ analysis method, if necessary.

Note The Analysis Method Editor icon is not active unless a sample with an
analysis method is selected.

New Analysis When you create a new analysis method, the following dialog box
Method Dialog opens prior to opening the analysis method editor. This dialog box
Box allows you to select the analysis type for your samples, and controls the
items available for customization within the Analysis Method Editor tab.

Hew Analysis Method E

Select analysis type:

© HID = ShaPshot

& Microsatellite

Ol Cancel
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General Tab In the General tab, enter a name and description for the analysis
method.

Analysiz Method Editor - Microsatellite

.
-
E
3

I

Note The Analysis Type reflects the choice selected in the New Analysis
Method dialog box.

Allele Tab In the Allele tab, set a number of parameters controlling allele calling,
including:
4 Bin Set
4 Marker Repeat Type (for Microsatellites)
4SNP Cut-Off value (for SNaPshot)

Using Analysis Methods
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Analysiz Method Editor - Microzatellite

General ||E|E Feak Detector | Peak Gualityl Quality Flagsl
Bin Set: |Mane =
Marker Repeat Type
[~ Use marker-specific stutter ratio it available
Walues for dinucleotide repeats are calculated automatically.
Trinucleotide Tetranucleotide
Cut-offvalue ID.2 IEI.25
PlusA ratio IU.QS ID.QS
PlusA distance |1.E |1_E
Stutter ratio ID.QS IEI.1 5
Stutter distance From IU-U Fram |0.0
To |3.5 To 4.6
Range Filter... | Factory Defaults |

Ok | Cancel |

Bin Set

Bins are a way of matching your data to the allele definitions contained
in the panel assigned to the data. Bins are the locations in which you
expect an allele to display. Alleles are defined in Markers as a size
range (bin) centered around the average size in base pairs, for example
101.5 +~ 0.4 bp. If your sample has a peak that falls within a bin, the
allele in your sample file is called with the identifier assigned to that
allele bin.

A bin set must be chosen for your analysis in order to guide the
algorithms in assigning allele calls. This drop-down list enables you to
choose the bin set to be used for analysis. The bin set chosen for
analysis must match the kit/panel chosen for analysis.
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Marker Repeat Type (for Microsatellites)

As stated on the Allele tab view, no entries are required for dinucleotide
repeats because the application calculates them automatically.

Check the “Use marker-specific stutter ratio if available” check box to
insert stutter ratio information into the Panel Manager marker’s table. If
you know the stutter ratio for an individual marker, you can set this
number under the “Marker Specific Stutter%” column in the Panel
Manager. Checking this box in the Alleles page causes the algorithm to
use your defined stutter ratio and not the ones defined in the Stutter
ratio box. Different values can be used for different markers.

The “Cutoff value” ignores all peaks less than the cut-off ratio of the
largest peak in the allele size range.

The “PlusA ratio” and “Stutter ratio” refer to the ratios you are expecting.
For example, if you expect a stutter percentage of 20% for your
markers, enter in 0.2.

The two columns labeled Trinucleotide and Tetranucleotide allow entry
of all related parameters directly into fields, so that everything can be
seen at once. The following table provides information about the ranges
of possible values.

Trinucleotide  Tetranucleotide

Parameter Min Max Default Default
Cut-off value 0.0 1.0 0.2 0.25
PlusA ratio 0.0 1.0 0.95 0.95
PlusA distance 0.0 ? (Infinite) 1.6 bp 1.6 bp
Stutter ratio 0.0 1.0 0.95 0.15

Stutter distance 0.0 ? (Infinite) from0to 3.5bp from 0 to 4.5 bp

Using Analysis Methods 5-9

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



The parameters in the table (except Cutoff value) are defined
graphically in the following figure.

Allele PlusA

oy

PlusA ratio =

B
Stutter A

Stutter *

1
B
Y

y
l
|

\
Stutter Distance

PlusA Distance

SNP Cutoff Value (for SNaPshot)

For heterozygous SNP genotyping alleles, if the highest peak height is
X and a second, lower peak height is Y, then the ratio Y/X must be
larger than the cutoff value in order for the second peak to be called.
The default value is set at 0.3 and may need to be further optimized for
your data.

Range Filter

The Range Filter allows you to remove labels from peaks within a
specific size range for each color.
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Peak Detector Tab Use the Peak Detector tab to select the algorithm to use for detecting

peaks:

¢ Basic

¢ Advanced
4 Classic

See Appendix B, “Software Genotyping Algorithms,” for additional
information on Basic, Advanced, and Classic peak detection algorithms.
Basic Peak Detection Algorithm

The default, Basic peak detection algorithm, is used for most
applications.

Analysis Method Editor - Microsatellite

| Peak quaity| auaiiy Flags

IBQSiC 'I

General | Allele ;|

Peak Detection Algorithm:
Minimurm Peak Height

 Automatic
& User specified (rfu)

Blue Green ellow Red Orange

||sn 50 50 50 50 ‘

Factory Defaults |
oK | Cancel |

The application sets the level automatically for these five dye colors
when “Automatic” is selected: blue, green, yellow, red, and orange. This
level represents the minimum signal strength that will be identified as a
peak for each dye (equivalent to 10 times the noise).

Selecting the User Specified option button enables the number entry
fields for five dye colors. These numbers are the minimum signal
strength that will be identified as a peak (in relative fluorescent units).
For all dyes, the default is 50, minimum is 1, and the maximum is any
number of 10 digits.

Using Analysis Methods 5-11

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Advanced Peak Detection Algorithm

This algorithm is similar to the ABI PRISM® GeneScan® software on
Windows NT operating system method of analyzing size standards and
performing peak detection. Information on the individual parameters
can be found in Appendix B, “Software Genotyping Algorithms.”

Analysis Method Editor - Microzatellite E

General| Alleles Peak Detector | Peak qualiy| Quality Flags |

Feak Detection Algorithm: X

Range

Analysis Sizing
FulRange || [alSizes =]
leiree| Btarieize0 |
St P W St Size:lm

Smoathing and Baselining

Smoothing & None
 Light
' Heawy

Baseline Window: |51 pts

Size Calling Method

" 2nd Order Least Squares
" 3rd Order Least Sguares
" Cuhic Spline Interpolation
& Local Southern Method
¢ Global Southern Method

~Peak Detection

Feak Amplitude Thresholds:

B: ISD R ISD
G: ISD o ISD
Y: ISD

Min. Peak Half\width: |2 pts
Folynomial Degree: |3
PeakWindow Size: |19 pts

Slope Threshold
Feak Start:

Feak End:

Factory Defaults |
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Classic Peak Detection Algorithm

This algorithm is similar to the GeneScan software on the Macintosh
operating system method of analyzing size standards and performing
peak detection. Refer to Appendix B, “Software Genotyping Algorithms,”
for additional information.

Analysis Method Editor - Microzatellite E

General| Allele Peak Detector | Peak quality| Quality Flags |

Feak Detection Algorithm:
~Range Feak Detection
Analysis Sizing FPeak Amplitude Threshaolds:

FulRange || [alSizes =] B: [50 R: [50

S0 =iz i Size:ID G: ISD o: ISD
St Bt 0000 St S|ze:|1 oo ¥ ISD—

rData Processing

i idth: ts
[lEaseling Min. Peak Half Width: |3 (4
¥ MultiCompaonent Split Peak Carrection
Smadthing: & Mone Mo Peak Correction LI

 Light
 Heawy Caorrection Limit 30 pts.

Size Calling Method

" 2nd Order Least Squares
" 3rd Order Least Sguares
" Cuhic Spline Interpolation
& Local Southern Method

" Glohal Southern Method Factory Defaults |
ak | Cancel |
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Peak Quality Tab The Peak Quality page sets the thresholds for warning flags in the
Genotypes view in the Project window. The PQV system uses these
values to determine what types of warning flags should be set for each
parameter. When you click the Peak Quality tab, the following page

opens.
Analysis Method Editor - Microzatellite E

General| Allele| Peak Detector Peak Quality | quality Flags |

—Signal level

Homozygous min peak height ISDD.D

Heterozygous min peak height |1 n0.0
~Heterozygote halance

Min peak height ratio ID.S
~Peak morphology

Max peak width (hasepairs) |1.5

Full-up peak

Full-up ratio |D1—
~Allele number

Max expected alleles |2

Factory Defaults |
ak | Cancel |

The settings include the following:

4 Signal Level (in fluorescent units)
— Homozygous min peak height (default = 200)
— Heterozygous min peak height (default = 100)

Peaks between the minimum peak height and the signal peak
height setting (set in the Peak Detector page) will still be scored, but
the peak height flag will be triggered.

¢ Heterozygote Balance
— Min peak height ratio (default = 0.5)

In a heterozygous allele, the higher peak height is X and the lower
peak height is Y. If the ratio Y/X is less than the Heterozygote
Balance, then the process quality value flag for Peak Height Ratio
will be triggered and the GQ value will be lower.
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¢ Peak Morphology

— Max peak width (basepairs) (default = 1.5)
¢ Pull-up peak

—  Pull-up percentage (default = 0.1)

Considers the ratio of any color peak directly under a major peak.
Flags Spectral Pull-Up quality value as in the Genotypes table.

¢ Allele Number
— Max expected allele number (default = 2)

If analyzing polyploid alleles, enter in the maximum number of
alleles you expect. You must also set the table profile to display the
correct number of alleles.

4SNP (for SNaPshot application only)
— Double peak (default = 0.5)
(See “PQV Flags on the Genotypes Page” in Appendix A.)
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Quality Flags Tab Use the Quality Flags tab to set the importance level of the PQVs
available for microsatellite and SNP analysis. The PQVs are weighted
on a scale of 0 to 1, with 0 being of no importance and 1 being of the
highest importance. Most defaults are set at 0.5, except for Out of Bin
Allele, which is set at 0.8. These defaults emphasize the point that if a
peak falls outside a bin, it should have a lower genotype call. The
Default button will reset these calls to the default numbers discussed in
the Peak Quality Tab section on page 5-14.

Analysis Method Editor - Microzatellite E

General| Allele | Peak Detector | Peak Qualty Qualy Flags |

Guality weights are between 0 and 1.
Guality Flag Settings

Spectral Pull-up ID_S Contral Concordance ID.S
Broad Peak ID.S Lowe Peak Height ID_S
Single Peak Artifact |u.5 Off-scale | 5
Sharp Peak IU-5 Feak Height Ratio ID.S

One Basepair Allele ID.S
Qut of Bin Allele ID.S
Split Peak ID.S

=

P Thresholds

Pass Range: Fail Range:

Sizing Quality: From ID.?S to 1.0 From 0.0 to ID.25
Genotype Quality, ~ Fram IU-75 to1.0 Fram 0.0 to IU.25

Factory Defaults |
ak | Cancel |

PQYV Thresholds

Use the options under PQV Thresholds to set Pass/Check/Low Quality
thresholds for the Sizing Quality (SQ) parameter for the Samples view
and the Genotype Quality (GQ) parameter for the Genotypes view. (See
the figure on page 5-16.) Anything that is not labeled Pass or Low
Quality will be labeled as check.
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Options

The Quality metric columns are set to display color symbols by default.
However, the SQ column in the Samples view and the GQ column in the
Genotypes view can be set to display the numerical equivalent on which
the color symbols are based for these columns. This setting is made in
the Analysis tab in the Options window by clicking the Numbers option
button for the Quality Metrics Display setting.

Data entry restrictions for the PQV thresholds ensure that the lower limit
of the Pass range is always greater than the upper limit of the Low
Quality range. The Check range is the interval between Pass and Low
Quality, if any. For example, if you use the default threshold settings
shown in the figure above, any result over 0.75 passes, any result at
0.25 or below fails, and any result from 0.26 to 0.74 will be marked for
you to check. (See “Process Component-Based Quality Values,” in
Appendix A.)

When the default setting for the Quality Metrics Display (Analysis tab in
Preferences window) is “Symbols,” a Pass for the SQ and GQ
parameters is indicated by a green square [ll: a Check is indicated by
a yellow triangle A and a Low Quality is indicated by a

red octagon @ -

Some quality metrics are either Pass or Low Quality (for example,
Background Peak), and some are warning flags with either Pass or
Check values (for example, File Not Found). Such values are not
adjustable by the Threshold parameter.
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Using Table Settings

Chapter Overview

Introduction This chapter provides information about the Table Settings tab in the
GeneMapper Manager window of the ABI Prism® GeneMapper™
Software Version 3.0, and describes how to use the features of the
Table Settings Editor.

In This Chapter This chapter contains the following topics:

Topic See Page
Table Settings Tab 6-2
Table Settings Editor 6-4
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Table Settings Tab

Introduction Use the Table Settings tab to perform the following tasks:
¢ Create new profiles
¢ Hide and show table columns

¢ Filter the table entries (rows) in Project windows

Default Table GeneMapper software v3.0 contains the following standard Applied
Settings Biosystems profiles:

— Default
— SNP Default
— Microsatellite Default
Default is a general profile, SNP Default is intended for SNaPshot

samples,and Microsatellite Default is intended for Microsatellite

samples. These profiles can be used as models for customizing new
profiles.

Table Settings Tab To display the Table Settings tab, select Tools > GeneMapper
Manager > Table Settings.

‘g GeneMapper Manager x|

Projects | Analysis Methods Table Settings | piot Setings | Matrices | Size Standards

[Mame LastSaved | Owner |Deseription

1 Default 200 02 gm

2 HID Default 2002-08-2013:00 gm

3 8P Default 2002-08-2013:00 gm Factory Provided

4 Microsatellite Default 2002-08-2013:00 am Factory Provided

Iew open Save As Import Export

Dahe |
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Table Settings allow you to determine what columns are viewed in the
Samples and Genotypes tab, and to set filtering properties.

The Table Settings tab contains a list of Table Settings in the database.
This tab is used to manage the contents of the Project window by
providing the following menus and interface elements.

Parts of the Table Settings tab:

Item

Description

Name column

Table Setting name

Last Saved column

Date/Time stamp displaying when
the object was last saved

Owner column

User name

Description column

Description of the object

New button

Opens the Table Setting Editor
window

Always enabled

Open button

Opens the editor for selected table
settings

Enabled when a single object is
selected

Save As button

Displays the Save As dialog box
Enabled when a single object is
selected

Import button (.xml file)

Displays a dialog box for Importing
objects

Always enabled

Export button (.xml file)

Displays a dialog box for Exporting
selected objects

Enabled when one or more objects
are selected

Delete button

Deletes the selected object(s)

Done button

Closes the GeneMapper Manager
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Table Settings Editor

Introduction Use the Table Settings Editor to show or hide information specific to
your sample, add filtering capabilities, and give content information for
each column in the project window. The Table Settings Editor window
contains the following three tabs:

4 General
4 Samples
4 Genotypes

The General Tab The General tab provides the capability to give a name and description
to a new profile.

Note You cannot change the name of an existing profile, only the description.

ig Table Setting Editor

General | Samp\esl Genutypesl

Mame: [Mewr Proiile

Description

Cancel |
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The Samples Tab The Samples tab provides the capability to filter columns in the
Samples table of the project window.

(g Table Setting E ditor ]

General Samples | Genotypes'

Filtering

Content

Show &l Records | M

Show All Records

Show All Records

Show All Records

Show All Records

Show &l Records | M

Show All Records

Show All Records

Show All Records

~Samples Table Settings:
Show |Column

1 [@  |status
2 ¢ Sample File
3w Sample Mame
410 Sample ID
5 W Comments
6 | Sample Type
| Analysis Method
g8 W Panel
9 W Size Standard
10 I atriz

Shova All Records
Show | Hide |

Cancel |
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The Genotypes The Genotypes tab provides the capability to filter columns in the
Tab Genotypes table of the project window and the capability to control the
allele settings.

@ Table Setting Editor

Column Filtering Content
Sample File Show All Records

Sample Marme Show &l Records

Sample ID Show All Recards

Run Name Show All Recards

HEIEIRRE
0
=S

Panel Show All Recards
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The Sample and The Samples and Genotypes tabs display the Table Setting properties
Genotypes Tab that will be applied to the corresponding tabs in the Project window. The
Elements Properties or elements are described in the table below.

Samples and Genotypes Settings

Element

Description

Column settings

These settings contain the valid columns for either
Samples or Genotypes data.

4 Show column - List with an editable check box
for each Project column, controlling whether the
column is shown or hidden

¢ Column column - List of column headings for
the Project window

4 Filtering column - List of filtering properties for
each Project window column

4 Content column - Sets what information is
displayed in each Project window column as
selected by the appropriate filtering method.
“N/A” indicates that no comments can be made
for these rows.

Filtering Properties
(Summary)

(For more specific
information, see
“Filtering Controls”
on page 6-10.)

The filtering properties for a Project table column
are controlled in the Filtering and Content columns.
Modifying these settings updates the property in the
Column/Filter table. For more information, see
“Filtering Controls” on page 6-10.

OK

Closes the Table Setting Editor window and applies
any pending changes to the Project window.
Contents of the Table Setting Editor are saved to
the GeneMapper database.

Cancel

Closes the Table Setting Editor window without
making any pending changes.

Show

Selects all highlighted rows as visible.

Hide

Selects all highlighted rows as hidden.

Using Table Settings 6-7

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Allele Settings

The Allele Settings box on the Genotypes page of the Table Setting
Editor window controls how the Allele, Size, Height, Area, Mutation and
Comment columns are displayed in the Genotypes view.

Allele Setting
Mumber of Alleles |2 [ Keep Allele, Size, Height, Area, Mutation and Camment together
Cancel |

Allele Settings Description

Number of Alleles The number of alleles for which genotypes are
displayed.
The default value is 2. This value is correct in most
cases. However, when you are analyzing polyploid
data you should change this value to the
maximum expected allele number to view all calls.

Keep Allele, Size, If the box is unchecked:

Height, Area, Mutation

— then the columns display as:
and Comment together

Allele 1, Allele 2, Size 1, Size 2,
Height 1, Height 2, Area 1, Area 2,
Mutation 1, Mutation 2, Comment 1, Comment 2

or
If the box is checked:
— then the columns display as:

Allele 1, Size 1, Height 1, Area 1,
Mutation 1, Comment 1,
Allele 2, Size 2, Height 2, Area 2,
Mutation 2, Comment 2
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Creating a New To create a New Table Setting:
Table Setting

Step | Action

1 Select GeneMapper Manager > Table Settings and click New to
open the Table Setting Editor window.

2 In the General tab, enter a name for the new setting and a
description if necessary.

3 Open the Samples and/or Genotypes tabs and select the
desired contents for the Samples and Genotypes tables in the
corresponding tabs.

4 Click OK to save the new setting.

Editing a Table To edit a Table Profile:
Setting

Step | Action

1 Select Tools > GeneMapper Manager to open the GeneMapper
Manager window.

Note If the table is selected in the project window drop down
menu, then you can click the Table Settings icon or Tools >
Table Setting Editor.

Select the Table Settings tab.

Select a table setting name and click Open. The selected
setting opens.

4 Perform edits in the table setting.

Note See The Sample and Genotypes Tab Elements on
page 6-7.

5 Click OK when you have completed editing. The changes you
have made are saved to the Table Setting.

Deleting a Table To delete a Table Setting :

Setting -
Step | Action
1 Select the Table Settings tab in the GeneMapper Manager
window.
2 Select a table setting name and click Delete.

A warning alert is shown. Click OK to remove the setting.
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Filtering Controls The Table Settings column labeled “Filtering”, shown in the figure
below, is used to filter or set the type of record or display presented for a

Project window column.

\-:-,-,I Table Setting Editor

General Samples | Genotypes'

Samples Table Settings:

Show |Column Filtering Content

1 |~ |Status Show &l Records | M =
2 ¥ Sample File Show All Records

3 | |Sample Name Show All Records

410 Sample ID Show All Recards

5 | |Comments Show All Records

6 |  |Sample Type Show All Records | MA

7 | |Analysis Method Show All Records

g | Panel Show All Recards

9 | |Size Standard Show All Records

10/ M atriz Shie Al Becord h

Show | Hide |

Cancel |

Samples View Column Filtering Settings

Note When you apply these settings to filter parameters, be aware that when
no instance of the type specified exists, the Sample Table displays blank. If this
occurs, return to the Table Manager and reset the filter.

The following information describes how to use the filter settings for the
Samples Column Settings. The default “Show All Records” can be
changed to one of the following:

Samples view filter settings:

Column Name

Filter Settings

Status

Sample File

Analyzed or Not Analyzed

Show All Rec... | ™

Show All Records
Anahzed
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Samples view filter settings: (continued)

Column Name

Filter Settings

Sample Name
Sample ID
Comments
Analysis Method
Panel

Size Standard
Matrix

Run Name
Instrument Type
Instrument ID
Run Date & Time
User Defined Columns

Show Records Containing

Show All Records g
Show All Records

Note This setting allows specification by a
string. Input this information into the Content
column.

Sample Type

Sample, Control, Allelic Ladder, Primer
Focus, or Negative Control

Sample Type
Sample LI
Sample
Contral
Allelic Ladder

Megative Contral

Reference Data
Off-scale
Sizing Quality Invalidated

Yes or No
Show Al Records v
v Al Records
NE
i [

Sample File Not Found
Matrix Not Found
Size Standard Not Found

Show Pass (green squares) or Show Low
Quality (red octagons)

Show All Rec... | ™

Show All Recards
Show Pass
Show Lowe Quality
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6-12  Using Table Settings

Samples view filter settings: (continued)

Column Name

Filter Settings

Sizing Quality (SQ)

Show Pass, Show Check, or Show Fail

Show Pass
Show Check
Show Lowe Quality

Note These settings restrict the display to
those records meeting these criteria.

Genotypes View Filter Settings

Note

In applying these settings to filter parameters, be aware that when no

instance of the type specified exists, the Genotypes table will be displayed
blank. If this occurs, return to the Table Manager and reset the filter.

The following information describes how to use the filter settings for the
Genotypes Column Settings. The default “Show All Records” can be
changed to one of the following:

Genotypes view filter settings:

Column Name

Filter Settings

Sample File

Sample Name
Sample ID

Run Name

Panel

Marker

Allele

Size

Height

Peak Area

Mutation

AE Comment
Integration Comments
User Defined Columns

Show Records Containing

Show All Records b

Show All Records

Show Records Containing:

Note This setting allows specification by a
string. Input this information into the Content
column.
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Genotypes view filter settings: (continued)

Column Name Filter Settings

Dye Blue, Green, Orange, Red, or Yellow

Show All Records 4

Show All Records
Blue

JGreen

Qrange

Fed

el

Note This setting can be changed to display
either all colors “Show All Records” or the choice
of display of an individual color. SNaPshot data
cannot be filtered by this selection.

Off-scale Show Pass (green squares) or Show Check
Sharp Peak (M) (yellow triangles)

One Basepair Allele (M)
Single Peak Artifact (M)
Split Peak (M) Show All Records b
Out of Bin Allele
Peak Height Ratio

Show All Records

Low Peak Height Show Pass
Spectral Pull-up Show Check
Allele Number

Broad Peak

Double Peak (SNP)
Narrow Bin (SNP)
Control Concordance
Overlap (HID)

Allele Edit Yes or No
Allele Display Overflow

Show All Records b
Show All Records

Tves

ro
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Genotypes view filter settings: (continued)

Column Name Filter Settings

Genotype Quality (GQ) Show Pass, Show Check, or Show Low Quality

airec...

Show All Records
Show Pass
Show Check

Showy Lowy Q0 ality
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Using Plot Windows -
Samples and Genotypes

Chapter Overview

Introduction This chapter describes how to examine and interpret
electropherograms within the ABI Prism® GeneMapper™ Software
Version 3.0 Samples and Genotypes plot windows, and explains the
various electropherogram settings and interactions in the plot window

menu items.

In This Chapter This chapter contains the following topics:

Topic See Page
About the Plot Window 7-2
Plot Window Toolbars 7-4
Plot Window Menus 7-5
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About the Plot Window

Introduction The Samples and Genotypes plot windows allow you to visually assess
your data. If genotype calls were made, you can also view and edit
allele calls assigned by the GeneMapper software algorithms.

Purpose of the Plot Samples Plot Window
Window 1o samples plot window allows you to:

View electropherograms on a per sample basis

View a sizing or genotypes table for sample(s) shown

Overlay all samples to determine size standard quality

Edit markers and bins

View the relationship between controls and samples

* & & & oo o

Edit allele calls

Genotypes Plot Window

The Genotypes plot window allows you to:

View electropherograms on a per genotype basis
View all genotype calls for a given marker

Edit markers and bins

View the relationship between controls and samples

* & & o

Edit allele calls

Displaying Plot Display the plot window from the GeneMapper Project window.
Windows To open the plot window:

Step | Action

1 Highlight any number of samples or genotypes from the project
window, by selecting the row number or sample file name.

2 Click M (Display Plots) on the toolbar, or
Analysis > Display Plots.

When you select a sample, all of the corresponding genotypes are
automatically selected in the Project Window Genotypes Tab. If a plot
window is open, the view refreshes as you switch between tabs.
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Customizing Plot
Windows

When you select a genotype, the corresponding sample(s) are
automatically selected in the Project Window Samples Tab. If a plot
window is open, the view refreshes as you switch between tabs. The
genotype selection is maintained until additional samples or genotypes
are selected or deselected.

Note Samples with a failed sizing quality (SQ) value cannot be displayed in
the Plot window. Only raw data can be viewed for failed samples.

Note The Plot Window cannot contain electropherograms from both the
Samples and Genotypes tabs at the same time.

Certain features within the Plot Windows can be customized using the
pull-down menu items or toolbar icons. Frequently used plot views can
be saved as Plot Setting profiles using the Plot Settings Editor
accessible from the GeneMapper Manager. See Chapter 8, “Using the
Plot Settings Editor.”

¢ The last profile used in the Samples Plot is used to open the
Genotype plot.

¢ The last profile used in the Genotypes Plot is used to open the
Sample Plot.
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Plot Window Toolbars

Toolbar The toolbar icons enable and disable plot features similar to their
Descriptions associated menu items as described throughout this chapter. Position
your mouse over an icon to view its tooltip description.

1| |2 3 4 5 6

| | |
e B e W WA B Wl e
Wd] il Whlsfe o
| | | |
7 8 9 10

Item Description

1 Pull-down menu that allows selection of a plot profile

Note Click the Plot Settings Editor icon to edit the selected profile.
(Tools menu)

2 Pull-down menu that controls the number of electropherogram panes
shown

3 Dye color toggle icons (View menu)
Header, Marker Range and Marker Indicator toggle icons (View
menu)

5 Icons that select the plot display: Combine Dyes, Separate Dyes,
Overlay All (View menu)

6 Icons that select the Sample Plot window to be displayed: No Table,
Sizing Table, Genotypes Table (View menu)

7 Icons that select either Peak Selection Mode or Binning Mode
(Alleles menu)

8 Icons that select the Label display: No Labels, Horizontal Labels,
Vertical Labels (View menu)

9 Icons toggle additional view features: Overlay Bins, Show/Hide Peak
Position, Controls To Top, Show/Hide Allele History (View menu)

10 Icon switches view to full X-axis and Y-axis scales: Full View from the
View menu.
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Plot Window Menus

File Menu The File menu commands are used to perform the basic commands.
[Rl=l Edit “iew Tools Alleles H

Save Panel Ctrl+Shift+S
Print Ctrl+P
Export Table Ctrl+E
Close PlotWindow Escape

Command Description

Save Panel Opens the Save Panel(s) dialog box informing the user of
(Ctrl+Shift+S) | what panel(s) have been modified and how many projects
currently in the GeneMapper database will be effected.
The options are:

4 Save Panel |

Fanel: Tutorial Panel 9as Modified.
Changes Will Effect 1 Project

& Save Panal

 Save Panel As
" Discard Changes

Ok |

4 Save Panel - This option allows you to save any marker
and bin changes made to the current panel name,
affecting all projects analyzed using this panel.

4 Save Panel As - This option allows you to save any
marker and bin changes made to a new panel name,
affecting only the current project being analyzed.

Note When using Save Panel As feature, the application
creates a duplicate panel with bins from the current bin set
and all bins from associated bin sets.

4 Discard Changes - This option allows you to discard any
changes made to markers and bins.
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Command Description

Print Automatically prints the contents of the plot window in the
(Ctrl+P) following order:
4 controls

4 samples/genotypes
4 table (if any)

Note Customize the view prior to printing.

Export Table Opens the Export Table dialog box allowing the user to
(Ctrl+E) export either the sizing or genotypes table shown in the
Samples Plot window.

i Export Table

&) GeneMapper_Log td
E Genehapper_Preferences _vI

File name : I Expnriiatle
Show files of type IAII Files {*7) =l Cancel |

Exportfile as: [Tab-delimited text {bd) =

Note This command is functional only when a table is
currently being viewed. The exported table contains the
same configuration as the currently viewed table.

Close Plot Prompts to save any pending changes and closes the plot
Window window.
(Escape)
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Edit Menu The Edit menu command provides basic editing for the Plot window
menus described in this section.

Edit

Iltem Description

Undo The Undo command is enabled after a user action that adds,
(Ctrl+2) modifies, clears, or reorganizes. It allows you to undo certain

actions, such as:

4 Editing an Allele
4 Editing a Bin

¢ Resizing Markers
¢

Zooming
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View Menu The View menu contains features you can use to control:
4 zooming of electropherograms
4 electropherogram lines/dye displays on the view
¢ anumber of display activities

WUl Tools  Alleles Help

v Toolbar
Sample Info Ctrl+F1
Raw Data Cirl+F2
EPT Data Ctrl+F3
Full Wiew Cirl+]
H-Axis Scale 4
-Axis Scale 4
Lahels 4
v BHins Ctrl+Shift+B

Feak Positions

v Allele Chanoes
Contrals To Top

v Off-scale Peak Indicatar

Dyes »
Plots »
Tables »
Tahle Filter 4
v Header
v Marker Range Cirl+R
v Marker Indicator Crl+k
Item Description
Toolbar Controls whether or not the Plot toolbar is displayed at the
top of the Plot window. This item is checked when active.
Sample Info Provides quick access to the Sample Info data tab for the
(Ctrl+F1) selected electropherogram. (See Chapter 3, “Using the
Project Window.”)
Raw Data Provides quick access to the Raw Data tab for the selected
(Ctrl+F2) electropherogram. (See Chapter 3, “Using the Project
Window.”)
EPT Data Provides quick access to the EPT Data tab for the selected
(Ctrl+F3) electropherogram. (See Chapter 3, “Using the Project
Window.”)
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Item

Description

Eull View
(Ctrl+])

Automatically resets the X- and Y-axes of the

electropherogram(s) currently viewed to their full scale size.

=1

Flle Edit View Tools Alleles Help

Microsatelite... =] [ panes: [1 =] 0L ([ N = vl

ML afiel WL @

Sample File  |Sample Name |[Panel  [08 |50

nnns,xm,n....,n‘xm ‘Wm ] B

130 182 184 185 183 130 132 194 19 198 200 202 204 206 208 210 212 214 216 218 220 222 224

Zoomed In View J AA/\ n
e . A AY

L [ il

Note Double-clicking with the left mouse button on an
axis automatically resets that axis to full view.

ioix)

File Edil View Tools Alleles Help

Wi S [@  peres [ EEEEE BT e

A ofirel MileE @ |

Sample File  |Sample Name [Panel |05 [5G

e o 17 | il
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Item Description

X-Axis Scale Selects the horizontal scale units for the X-axis to be
displayed in either base pairs (default) or data points.

® Basepairs Cirl+y
Data Point Ctri+M

Zooms in on a specific region on the X-axis of the
electropherogram as follows:

4 Click and drag, with the left mouse button, the desired
region on the X-axis.

In the Samples Plot, this affects all electropherograms.
In the Genotypes Plot, this affects only the selected
electropherogram.

or,

4 Right-click the X-axis to open the Zoom To dialog box,
which enables specific zoom coordinates and tick
spacing units to be set.

Double-click the X-Axis Sample Plot and all the
electropherograms return to Full View.

Double-click the X-Axis Genotype Plot and only the
selected electropherograms return to Full View.

G X-Axis Zooming x|
]

Zoom Fraom | jul |

Tick Spacing I unitsiick

Cancel |
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Item

Description

Y-Axis Scale

Controls the vertical scale of the electropherograms
currently viewed as follows:

¢ Scale Individually - Each electropherogram being
viewed is scaled to its maximum height.

4 Scale To Maximum Y - All plots currently viewed are
scaled to a global maximum value.

4 Scale To - This setting allows a user to set the Y-Axis
scale value. If multiple plots are currently viewed, all
plots are scaled to this value.

#® Scale [ndividually
Lahels r Scale To Maximum Y
¥ Bins Ctrl+B Scale To..

Zooms in on a specific region on the Y-axis of the
electropherogram as follows:

4 Click and drag with the left mouse button the desired
region on the Y-axis. This only affects the selected
electropherogram.

or

4 Right-click the Y-axis to open the Zoom To dialog box,
which enables specific zoom coordinates and tick
spacing units to be set. Use the Apply To checkbox to
apply the settings to all electropherograms (panes).

i ¥-Axis Zooming
Y-Ais

Zoom To: |
Tick Spacing : | unitstick

[~ Apply to all electrapherogram

Cancel |

4 Double click on the Y-Axis to return selected
electropherograms to Full View.

4 Shift+double click on the Y-Axis to return all
electropherograms to Full View.
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Item Description

Labels Controls how labels are viewed beneath an
electropherogram.

L Mo Labels
¥ Bins Cir+Shift+B @ Horizontal Labels
Peak Positians Wertical Labels
4 No Labels - Labels are off.
[Fsamsiespiot =lof
File Edit View Tools Alleles Help
Micrasatelite .. = [ Panes: [1 ¥| (0 ([ =] PO T @l
e T e |
[Sogeme [sugenae [rn [os [sa
‘mm [set1 Bnd o1 W 1o =

262 286 270 g74 27% 080 296 090 294 P98 02 306 M0 ¥4 18 22 3% 33 334 9] a4 45 950

et}
120
1470
1520
LR

2ot el

L —

=le

4 Horizontal Labels - Labels are positioned horizontally
across the screen. Labels in close proximity overlap with
the left most label displayed on top. Click any label to
bring it to the top for viewing.

¥ Samples Plot

File Edit View Tools Alleles Help
[aNF Defaut =] [ Fanes: [2 = W WERE ERE N
M fiel WL @

sample File  |Sample Name [Panel  [08 |5
5_E13_00 fra ‘5 ‘Ephthpl. [] |
REEEEEEE R R R R R RN
a6 [heer e b [heer
2500
e
1288
e
103 |
15 1
wr \
L 5
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Item

Description

Labels
(continued)

4 Vertical Labels - Labels are positioned vertically across

the screen to prevent overlap. This option is
recommended for printing.

i Samples Plot E
File Edit View Tools Alleles Help

Microsatelite .. ] [0 Panes: [1 ¥| (0 (. (7 = i P e |

MO Ll WLfs @

Sample File Fa@hnau [pana [os Tsa

01000 E 10630 [set1 Bnd o1 [ =
[oiszeT ] DS ] [bis2800 1

83 W 99 07 M5 123 130 139 147 155 183 71 AT9 187 195 203 211 219 227 235

201 N
100
b

] A

L

B
3

Note Labels are enabled in Separate Dyes mode only for
Microsatellite samples, and are enabled in Combine Dyes

mode only for SNaPshot® samples.
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Item Description

Bins Controls whether or not transparent bins are shown or
(Ctrl+shift+B) hidden on an electropherogram. In the Binning mode, bins
are automatically displayed and the Bins menu item is
checked.

Separate Dyes mode

EETTTI— ST

File Edii View Tools Alleles Help

Microsatellite . ~] ] Panes: [1 =] Wl WE EREL WD @@l

M4 S| Mol @ |

| surpte Fme |supleBame  [Pand Jos [so

| o T T W o =
[brs27sT ] [Diszas ] [Diswen ]

92 400 W8 116 124 132 M0 143 456 184 A7z 180 488 195 204 212 220 208

Note Bins are enabled in Separate Dyes mode only for
Microsatellite samples, and are enabled in Combine Dyes
mode only for SNaPshot samples. When you turn off a
specific dye color for SNaPshot samples, the bins for that
color turn off also.
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Item Description

Bins Combine Dyes Mode
(continued) G Samples Plot
File Edit View Tools Alleles Help
[ave perr =] (5 panes: [ =] EECEEE EE W

A S| MLE @

Sample File  |Sample Name [Panel |05 [5G
5_E13_00 f5a ‘5 ‘e.m swol [ | -]
A7 1% 21 2% 2% 2T 2 31 3 8% ¥ 8 M 43 45 4T 4 M 3 O3 T 5 B k3 BT 7
82 36 [z Ey
2504-
s
1288
1a31
103 |
15 1
Ld ZI

Note Bins are enabled in Separate Dyes mode only for
Microsatellite samples, and are enabled in Combine Dyes
mode only for SNaPshot samples. When you turn off a
specific dye color for SNaPshot samples, the bins for that
color turn off also.

Peak Shows/hides the peak position indicators on the
Positions electropherogram currently viewed. Checked when active.
Disabled for overlaid samples.

i Samples Plot

File Edit View Tools Alleles Help
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Item Description

Allele Shows/hides label editing effects.
Changes ¢ Turned Off

— Deleted label disappears

— Edited/Added label looks normal

4 Turned On, labels manually edited are shown with
descriptors and the allele call.

Label deleted - Allele label is shown with a diagonal slash
through it.

52

Label changed - Allele label is shown with a double upper
bar.

Charzed
4] 152

Label added - Allele label is shown with a double upper bar.

Adfed

al 52
Controls To Controls whether or not control samples are displayed at
Top the top of the Plot window. Checked when active.

When active, a new pane is displayed at the top of the Plot
window. Only samples and their corresponding genotypes
designated as Control or Allelic Ladder in the Sample Type
column of the Project window display in this pane. If multiple
controls are shown, use the scroll bar to scroll through the
different controls.
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Item

Description

Off-scale
Peak Indicator

Controls whether or not offscale peaks are highlighted in an
electropherogram. Checked when active.

When enabled, a magenta bar overlays any offscale peak in
an electropherogram as shown in the figure below. An
offscale peak is a peak whose height exceeds the dynamic
range of the collection instrument.

{ Samples Plot

File Edit View Tools Alleles Help
avP Deraut | panes: [I =
A ooy ] WkLwE W

R B

Sample File|Sample Name |Pansl |08 |5Q
3_C03_05 fsa H Gplex Sanpl [ | |
RN
571 o [er ke Ezmdr e
L
5578
a2
a8
2538
1852
ELS [
L4 3

Dyes

Controls the dye colors shown in the Plot window. Checked
when active. Multiple dye colors may be selected.

Note This feature is not available when viewing
microsatellite genotypes in the Genotype Plot window.

Cr il v BlueDye  Ctrl+1
Flots P v GreenDye Cirl+2
Tahles b v Yellow Dye  Ctrl+3
Tablg Filter } v RedDye Ctrl+4
v Header v Orange Dye Cirl+5
v tlarker Range Cirl+R v Al Dyes Ctrl+6
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Item Description

Plots Controls the way electropherograms of samples are shown
in the Sample Plot window.

Plots ® Combine Dyes  Cirl+7
Tables 4 Separate Dyes  Cirl+8
Table Filter b Overlay Al Cirl+49

4 Combine Dyes - All dye colors from a sample are
combined into a single source electropherogram.

o ozt =] [ Panes: [1 =] ECEEE BT Wl EeE
Wi LEel HLRE w I
Sample File |Sa@hl¢w |m
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Item Description

Plots 4 Separate Dyes - Each dye color from a sample is
(continued) separated into an individual electropherogram.
st | panes: [ 5] Ll I = e W
i umel MusE @ |
e e [os_[ra
6300080510650 [set1 Bnd o1 W 1o Al

I —
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j PI - jul . .
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| s
[as) fa 133 o) szl

B
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4 Overlay All - Multiple samples are combined into a single
electropherogram.

s <@ eanest [ =] WECENE BT |
Wi ufvel MalfE @ fowraran ]|

sample File  |Sample Name |[Panel |08 s

A we e e s s s s o an s s s s s e )

4565

w3z

2799

1865

. UM u‘m.,ﬂm,lh H widd il

L 3
Plots The Overlay All option can be used to verify size standards
(continued) as follows:

1. Select any number of Samples in the Project window.
2. Click M (Display Plots).

3. Turn off all dye color icons except the dye color used for
the size standard.

4. Click ||E (Overlay All). All size standard
electropherograms are displayed; this allows the user to
check for outliers.
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Item Description

Tables Controls which table, if any, is viewed at the bottom of the
Sample Plot window.

Tables # Mo Table Ctrl+a)
Tahle Filter »  Sizing Table Cirl+A
v Header Genotypes Tahle Crl+iy

4 No Table [Ctrl+Q] - Table is turned off.

4 Sizing Table [Ctrl+A] - A sizing table is shown which
displays information for all detected peaks in the
selected samples. Use the Plot Settings Editor to
configure the columns shown in the table. Use the Table
Filter menu item command to control which rows of data
are shown.

4 Genotypes Table [Ctrl+W] - The genotypes table, as
displayed in the Project window Genotypes tab, is shown
for the selected samples. Use the Table Setting Editor to
configure the columns shown in the table.

Table Filter Controls which data rows are displayed in the Sizing or
Genotypes Table viewed at the bottom of the Sample Plot
window.

Table Filter [l ® Show All Rows Ctrl+F
v Header Show Selected Rows  Cirl+G
v Marker Range Cirl+R Hide Selected Rows  Ctrl+H
v darker Indicator Crl+k Show Allele Call Rows  Cirl+Y

4 Show All Rows - All available data rows are shown.

4 Show Selected Rows - Only peaks that are selected in
the electropherogram(s) are shown.

4 Hide Selected Rows - All peaks that are selected in the
electropherogram(s) are hidden.

4 Show Allele Call Rows - Only peaks that have allele calls
assigned are shown. This is applicable for the Sizing
Table only.
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Item

Description

Header

Controls whether the individual Sample or Genotype
Header is shown above an electropherogram. Checked
when active.

Note The information shown in the Header can be
configured through the Plot Setting Editor.

¢ Headers Turned On

kg Samples Plot

File Edit View Tools Alleles Help
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Marker Range
(Ctrl+R)

Controls whether or not the colored marker bar is displayed
at the top of an electropherogram.

Marker
Indicator
(Ctrl+K)

Controls whether or not the red triangles at the bottom of
the electropherogram, which indicate the marker allele size
range, are displayed.
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Item Description

Marker Margin | Opens the Marker Margin dialog box to allow the user to
determine how many base pairs beyond the allele size
range are displayed in the electropherogram.

Note This option is only enabled when viewing the
Genotype plots. The value can be pre-configured through
the Plot Setting Editor.

& Marker Margin x|

Enter marker margin (in hasepairs)

|
Ok I Cancell
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Tools Menu The Tools menu provides access to the GeneMapper Manager and the
Plot Settings Editor.

Tools

GeneMapper Manager ... Ctrl+h

Flot Settings ... Cirl+T

Item

Description

GeneMapper
Manager
(Ctrl+M)

Opens the GeneMapper Manager to allow creation or editing
of various project settings. Used to create a new Plot Setting
profile. See Chapter 2, “Using GeneMapper Software,” for
more information.

(@ GeneMapper Manager
Pmiectsl Analysis Methodsl Table Seflings PImSemngsl Mamcesl Size Standardsl
|Name Last Saved Owner Description
1 Sizing 2002-08-13 11:1:{am Factary Provided
2 Def|2002-06-13 11:1: am Factary Provided
3 SMP Default 2002-08-13 11:1:{am Factary Provided
MNew... BT, Save As Impart... \EiaegE B[z

Done

Note New profiles can only be created through the
GeneMapper Manager.
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Item Description

Plot Settings | Opens the Plot Settings Editor to allow the currently selected
(Ctrl+T) Plot Setting profile to be edited. See Chapter 8, “Using the
Plot Settings Editor,” for more information.

Plot Settings Editor

General Sample Headerl Genotype Headerl Sizing Tab\el Labelsl Display Seningsl
Sampls Header Settings:

Show | Column
1 v Sample File
2 ¥ Sample Name
3™ Fanel
4 |7 Off-zcale
5 ™ Sizing Quality

Show Hide
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Alleles Menu The Alleles menu is used to edit allele call labels on selected peaks and
is only enabled when labels are displayed in the Plot window and one or
more peaks are selected.

Help

Editing Mode [

Aol el (Eipfr S

Delete Allele Delete

History

Rename Allele ]
v Allele Edit Comment Cirl+O

Add Bin Ctrl+B

Edit Bin Ctrl+L)

Delete Bin Delete
Item Description

Editing Mode | Controls whether the action of the mouse within the
electropherogram is in Peak Selection or Binning mode.

Editing Mode Peak Selection  Ctrl+;
A flelE Cirl+L & Binning Ctrl+

In Peak Selection mode (Ctrl+;):
4 Peaks can be selected
¢ Allele calls can be edited

Clicking on a peak automatically highlights that peak’s
data row within the Sizing Table or (Genotype Table, if an
allele call has been made).

4 Continuous peak selection is available

Use the Shift key or Click+Drag inside the plot area.
4 Discontinuous peak selection is available

Use the CTRL key.

The selected peak is maintained when switching
between the Samples and Genotypes tabs in the Project
window with the Plot view still visible.
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Item Description

Editing Mode | In Binning mode (Ctrl+\):
(continued)

¢ Marker size ranges can be edited

4 Bins can be edited

When the Binning mode is selected, the Plot window
automatically switches the display configuration to an
appropriate view for editing bins.

— Plots shown in Separate Dyes mode for microsatellite
samples

— Plots shown in Combine Dyes mode for SNaPshot
samples

— X-Axis displayed in base pairs
— Marker Indicator and Marker Range displayed
— Bins displayed
To edit marker size ranges (for microsatellites only):
a. Select Binning mode.

b. Click the marker indicator of the marker to be edited. A
red indicator displays.

c. Drag the red indicator line to the desired size range.
Note To edit allele calls, refer to Add Allele, Delete Allele,

and Rename Allele rows in this table. To edit Bins, refer to
Add Bin, Edit Bin, and Delete Bin rows in this table.

To edit marker size ranges for SNPs, the bins need to be
edited.

Binning Mode is disabled when:

a. There is no binset for the panel.

b. The binset was deleted.
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Item Description

Add Allele Allows the user to add a new allele call to an unlabeled
(Ctrl+L) peak as follows:

a. Select Peak Selection mode.
b. Select an unlabeled peak using the left mouse button.

c. Select the Add Allele menu item or right-click mouse
button to open the Add Allele dialog box.

If Allele Edit Comment is selected, the Add Allele Comment
dialog box opens allowing the user to enter an allele
comment for the selected peak. Labels must be turned on.

A bin name is assigned to the label if the selected peak falls
within a bin defined for the marker. Otherwise, the allele is
designated with a question mark (“?”) until the user
renames the allele. If the Show type of edit checkbox is
selected in the plot profile, the word “Added” displays inside
the box.

Note For quick access to “Add Allele Call,” double-click an
unlabeled peak.

Delete Allele Allows the user to delete an allele call from a labeled peak
(Delete) as follows:

a. Select Peak Selection mode.
b. Select a labeled peak using the left mouse button.

c. Select the Delete Allele menu item or right-click mouse
button to open the allele edit options and click Delete.

If Show Allele Edit Comment is selected, the Delete Allele
Comment dialog box opens allowing the user to enter an
allele comment for the selected peak. The label is then
deleted.

If the Show type of edit checkbox is selected in the plot
profile, the word “Removed” displays inside the label box (if
Allele Changes is selected from the View menu).

Note Multiple alleles may be deleted at the same time by
selecting multiple peaks. This is constrained to the peaks in
the plots currently shown.

History Allows the user to view the allele history in columns labeled
Basepair, Allele Name, User Name, Modification Date,
Action, and Comments.
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Item Description
Rename Rename Allele 5
Allele v Allele Edit Ccomment Ciri+0 g
Add Bin Cirl+B T
Edit Bin Crl+LJ g
Delete Bin Delete 9
10
11
12
13
14
15
?
Custam
Allows the user to change the allele call on a labeled peak.
a. Select Peak Selection mode.
b. Select a labeled peak using the left mouse button.
c. Select the Rename Allele menu item or click with the right
mouse button to open the allele edit options and click
Rename Allele.
d. Select an allele call from the menu to rename the allele.
If you select Allele Edit Comment, the Edit Allele Comment
dialog box opens allowing the user to enter an allele
comment for the selected peak. The allele is then renamed
to the selected allele call.
If Show type of edit prefix is turned on in the plot profile, the
word “Changed” displays inside the label box.
Allele Edit Controls whether or not the Allele Comment dialog box
Comment opens when making label changes. Checked when active.
(Cri+O) To view the comments entered:
4 Show the AE Comment column in the Project Window
Genotypes Table, or
4 Select the History option when right-clicking a selected
labeled peak, or
4 Double click a label.
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Item Description

Add Bin Allows the user to add a marker bin as follows:
(Ctri+B) a. Select the Binning mode.

b. Click the Marker Range for the bin. A line and a cross hair
opens on the electropherogram.

. Select the Add Bin menu item or right-click to open the
Add Bin option.

. Add a bin by either dropping the cross hair at the center
of the desired bin location or by dragging across the
desired bin range. The Edit Bin dialog box opens
allowing the user to add bin information.

[¢]

o

Add Bin to "D651574" x|

Mame IBin
LUEEIiUH.I1 56.38

Leftoffset: IU 40 [ Mew offset default
Right DﬁSEt'ID 40 [ Mew offset default

[ Mutant Bin

oK | Cancel |
Edit Bin Allows the user to edit a marker bin as follows:
(Ctri+U) a. Select Binning mode.

b. Select the bin to be edited.
c. Select the Edit Bin menu item, or right-click the selected
bin to open the bin edit options, and select Edit Bin.

The Edit Bin dialog box opens allowing the user to edit bin
information. To quickly resize a bin, select a bin and adjust
the right and left handles to the desired size range.

To relocate or move the bin (mouse action only):

a. Select Binning mode.

b. Select the bin to be moved.

c. Click and drag the center of the bin to a new location.
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Item Description

Delete Bin Allows the user to delete a marker bin as follows:
(Delete) a. Select Binning mode.
b. Select the bin to be deleted.

c. Select the Delete Bin menu item, or right-click the
selected peak to open the bin edit options and then
select Delete Bin.

The bin will then be deleted.

Move Allele Using the mouse, you can move an allele label to a new peak.
To move an allele:

Step Action

1 Left click a label to select it.

2 Hold down the Ctrl key and drag the label to the new peak.

The old label will be marked “removed.” The new label will be
marked “added.”

Help Menu The Help menu provides access to online help and to the About
GeneMapper software window.

GenemMapper Help  F1

Ahout GeneMapper
ltem Description
GeneMapper Help Opens the GeneMapper User Manual PDF file using
(F1) Adobe Acrobat Reader.
About Opens the About GeneMapper window to indicate
GeneMapper registration information and software version number.
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Special Feature Invalidate Genotype Quality

This feature allows the user to quickly reset the Genotype Quality to 1.0
and all PQV icons will be greyed out. Since the allele call has not
changed, the AE box will not be checked.

To use the Invalidate Genotype Quality feature in the sample plot:

Step Action

1 Show the Genotype table.

2 Select the Genotype Quality cell of a genotype.

3 Right-click the selected cell to open the Override Genotype Quality
dialog box.

4 Click Yes.
The Genotype Quality now passes with a value set to 1.0, and the
PQYV icons are greyed out in the Genotypes table.

To use the Invalidate Genotype Quality feature in the genotype plot:

Step | Action

1 Select the sample header of a plot to select it.

2 Right-click on the header to open the Override Genotype Quality
dialog box.

3 Click Yes.
The Genotype Quality now passes with a value set to 1.0, and the
PQV icons are greyed out in the Genotypes table.
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Using the Plot Settings
Editor

Chapter Overview

Introduction This chapter describes how to use the Plot Settings tab in the
GeneMapper Manager window of the ABI Prism® GeneMapper™

Software Version 3.0, and describes how to use the features of the Plot
Settings Editor.

In This Chapter This chapter contains the following topics:

Topic

See Page
Plot Settings Tab 8-2
Plot Settings Editor 8-4

Using the Plot Settings Editor 8-1
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Plot Settings Tab

Introduction The Plot Settings tab enables you to create and edit plot setting profiles
for viewing your data in the Samples and Genotypes plot views.

Default Profiles GeneMapper software v3.0 contains the following standard Applied
Biosystems profiles:

4 Microsatellite Default
¢ SNP Default

4 Sizing (view is similar to the view in the ABI PRISM® GeneScan®
software)

Plot Settings Tab The Plot Settings tab contains a list of Plot Setting profiles in the
database and is used to manage the contents of the Samples and
Genotypes Plot views by providing the following menus and interface
elements. To display the Plot Settings tab, select Tools > GeneMapper
Manager > Plot Settings.

\-;«l GeneMapper Manager

Projects | Analysis Methods | Table Settings PIotSemngsl Matriceal Size Standards

Narme Last Saved Owner Description
1 Sizing 2002-06-1017:00 gm Factary Provided
2 Microsatellite Default |2002-06-10 17:0t gm Factory Provided
3 8P Default 2002-06-1017:0¢ gm Factory Provided

IEw. OHEN... Save e Import Export. [Deleie
Dahe |
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The Plot Settings tab contains the following items:

Item

Description

Name column

Plot setting name

Last Saved column

Date/Time stamp showing when the
plot setting was last saved

Owner column

User name of the person who
created the plot setting

Description column

A description of the plot setting

New button

Opens the Plot Settings editor

Always enabled

Open button

Opens the editor for a selected
project

Enabled when a single plot setting is
selected

Save As button

Displays the Save As dialog box

Enabled when one or more settings
are selected

Import button (.xml file extension)

Displays a dialog box for Importing
plot settings

Always enabled.

Export button (.xml file extension)

Displays a dialog box for Exporting
selected plot setting

Enabled when one or more plot
settings are selected

Delete button

Deletes the selected plot setting(s)

Done button

Closes the GeneMapper Manager

Using the Plot Settings Editor 8-3

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Plot Settings Editor

Introduction The Plot Settings Editor allows you to customize your plot views by
adjusting the following:

4 The items displayed in the Sample headers
The items displayed in the Genotype headers
The columns displayed in the Sizing table
How labels are shown

* & & o

Display settings

How to Access the The Plot Settings Editor can be accessed in the following ways:

Plot Settings 4  gelect Tools > GeneMapper Manager > Plot Settings Tab > New
Editor or Open_

4 Inthe Sample or Genotype Plot views, select a profile to edit and
select Tools > Plot Settings or click the Plot Setting Editor icon
on the toolbar.

General Tab The General tab allows you to enter in the name and description of the

plot setting.

General | Sample Header' Genotype Header' Sizing Table' Labels' Display Settings'
When Opening The Plot YWindow

Mame: Mew Plot Setting

Description:

Cancel |
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Sample Header The Sample Header tab controls what is viewed in the header above
Tab each sample electropherogram in the Samples Plot view.

Genotype Header
Tab

Plot Settings Editor

General Sample Headerl Genntype Headerl Sizing Tamel Lahe\sl Display Seningsl

Sample Header Settings

X ===

Show

Column

Sample File

Sample Mame
Panel
Oft-scale
Sizing Quality

o |

Ok Cancel

The Show button displays all selected rows as visible (checked), and
the Hide button displays all selected rows as hidden (unchecked).

The Genotype Header tab controls what is viewed in the header above
each Genotype electropherogram in the Genotypes Plot view.

Plot Settings Editor

Generall Sample Header Genotype Header | Sizing Tablel Labelsl Display Bet‘tmgsl

Genotype Header Settings:

=zl lolvola/a|lw[m]=

=l

n

Shiowy

Calumn

sample File

SIS SIS SIS S

Sample Mame
Panel

Marker
Off-scale
Sharp Peak ()

One Basepair Allele () ||

Single Peak Arifact (M)
Split Peak (M)

Out of Bin Allele (M)
Peak Height Ratio

|t Paal: Hairht

Showy Hide

QK Cancel |

The Show button displays all selected rows as visible (checked), and
the Hide button displays all selected rows as hidden (unchecked).
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Sizing Table Tab The Sizing Table tab controls which columns are displayed in the sizing
table as shown in the Samples Plot view.

Column

<

DyelSample Peak

Sample File Mame

Marker
Allele

Size
Height
Area

Drata Point

BRI
X R K| K| =& &

The Show button displays all selected rows as visible (checked), and
the Hide button displays all selected rows as hidden (unchecked).

8-6 Using the Plot Settings Editor

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Labels Tab The Labels tab controls how labels are viewed for each allele. You can
display up to four labels per peak.

Plot Settings Editor

prea <]
Mone =] Dye Color-Border ]

Times Mew Roman ]
10 ]

Plot Settings Editor

Allele Call <]
Size =]
prea <]
one ] Dye Color-Border ]

Mone
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Description of items displayed on the Labels tab:

Name

Type

Description

Allele Call, Area,
Height, Data point, and
Size labels

Drop-down menu items
in the label box

Labels are determined
by the GeneMapper
software v3.0.

AE Comment

Drop-down menu item
in the label box

Shows the last allele
edit comment

Show data type Check box Label prefixes such as

prefixes “al” for allele call will be
displayed.

Show type of edit Check box If an allele is manually
edited, the label will
display “changed” or
“deleted.”

Invert mutant labels Check box If a bin is labeled as a

mutant bin in the Panel
Manager, then the
label color will be
inverted to distinguish
it from normal bins.

Label Color

Drop-down menu

Controls the color of
the labels. From the
drop-down menu
select one of the
following:

Black & White

Dye Color - All (text &
border in color)

Dye Color - Border
(text in black, border in
color)
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Display Settings The Display Settings tab controls how each plot setting will
Tab automatically open when a customer chooses that setting.

Plot Settings Editor

Generall Sample Headerl Genotype Headerl Bizing Tahlel Lahels Display Sangsl
¥When Opening The Plot YWindow

© Use the display settings lastused for this plot
& Use these display settings:

For both Sample and Genotype plots:

Panes: 1 |

MET L vl w] LJ%[s
Wiz [Basepaits =] vavis:[Seale individually =]
v Toolbar ¥ Show Off-scale

Far Sample plot only:
(T T T
2 == = R T

For Genotype plot only:
Marker Margin: |5 bp

ol Cancel |

You can select Use the display settings last used for this plot button
to have the Samples and Genotypes plot views display with your
previous settings, or select Use these display settings to adjust the
way these views display with the current settings on this page. These
icons are the same as the ones in the Plot window. Move the mouse
over each icon to view the tooltip description. The tooltip describes what
action occurs if the button is pressed. For example, by default, all colors
are shown. If you move your mouse over the All icon [l , the tooltip
says “Hide All Dyes.” If you click the icon, all colors will be hidden.
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Creating and
Evaluating a Matrix

Chapter Overview

Introduction This chapter describes the process of creating and evaluating a matrix.
With the ABI Prism® GeneMapper™ Software Version 3.0, matrices are
stored in the GeneMapper database. They become .mix files on your
hard drive only when you export them. You must export a file in order to
run the 310/377 data collection. You have the option of selecting four or
five dyes depending on the application when creating a new matrix for
data collection.

Note This chapter applies only to the ABI PRISM® 310 Genetic Analyzer
and the ABI PrismM® 377 DNA Sequencer instruments.

In This Chapter Topics in this chapter include the following:

Topics See page
About the Matrices Tab 9-2
About Matrices 9-3
Process of Creating a New Matrix 9-8
Choosing a Data Point Range for the Matrix Calculation 9-10
Generating a New Matrix 9-12
Assigning the Matrix to Samples 9-16
Evaluating the Matrix 9-17
Using the Matrix with Data Collection 9-18
Causes for Bad Matrices 9-19
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About the Matrices Tab

Purpose of the Matrices Tab

Matrices Tab 1,5 Matrices Tab contains the list of Matrices in the database.

Item Description

Name column Matrix name

Last Saved column Date/Time stamp showing when the matrix was last
saved

Owner column User name of the person who created the matrix

# of Dyes column The number of dyes selected for the matrix

Description A description of the matrix

New button Opens the Matrix Editor dialog box

Always enabled

Open button Opens the editor for a selected matrix

Enabled when a single matrix is selected

Save As button Displays the Save As dialog box

Enabled when a single matrix is selected

Import button Displays a dialog box for Importing matrices
Always enabled

Note The extension must be .mix.

Export button Displays a dialog box for Exporting the selected
matrix

Enabled when one or more matrices are selected

Note The extension must be .mix.

Delete button Deletes the selected matrix(s)

Done button Closes the GeneMapper Manager
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About Matrices

Introduction

Matrix Definition

Multicomponent
Definition

There are two dye-labeling chemistries currently available to prepare
nucleic acid samples to use the GeneMapper software on ABI PRISM®
instruments:

4 57 end labeling Dye Sets D, F, G5
4 3’ end labeling Dye Set E5

Each chemistry has a set of dye labels that fluoresce at different
wavelengths when excited by a laser.

During data collection on the... The wavelengths are separated...
ABI Prism® 310 Genetic Analyzer, by a spectrograph into a known
ABI Prism® 377 DNA Sequencer, spectral pattern across a detection
377XL, or 96-lane upgrade system with the sequencer.
instrument

A Matrix is a mathematical formula that corrects for spectral overlap of
fluorescent emission spectra data collected from ABI PRISM
instruments.

This process of eliminating the bleed-through caused by spectral
overlaps is called multicomponenting.

Applying a matrix to raw data allows you to generate multicomponented
data.
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Why Is a Matrix A matrix is necessary because the four or five dyes used to label the
Necessary fragments fluoresce at different wavelengths and may have spectral
overlaps:

5—F1\M JC;E TAhiiIRA ROX

EMISSION

E L | < L -
450 200 330 600 650

WAVELENGTH (am)
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Sample Files Using The following figures show examples of data analyzed with and without
A Matrix a matrix.
You can see that peak data from a sample file analyzed without a matrix

displays the expected peak, along with extra peaks in other dye colors,
or bleed-through from other dye colors.

E=————— 12+50 Lane Demo Sample.4 =———————"[1-
—y 1800 1700 1800 1900 2000 2100 2200 2300

400 A

. 1'\ r:ﬂ
BIG[ Y[+ v
Sample file analyzed without a matrix

Enj 1250 Lane Demo Sample.d =—————[315
II =10 x] l1 Foo I1 =1un) I1 a00 ?DDD I2 100 I2200 IESDD

1600

1200

00

- Ll

>
BIG[ Y[ v

Sample file analyzed with a matrix

Assigning a Matrix Normally the matrix is assigned to a sample file automatically upon
to a Sample generation during or after a run. Additionally, a matrix can be manually
assigned to a 377/310 sample file from within the GeneMapper
software.

When to Assign a Before you can successfully analyze 310/377 sample files using the
Matrix GeneMapper software, you must make a new matrix or assign an
existing one to a set of sample files.
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Limitations to The matrix is instrument-specific. You cannot apply a matrix you made
Matrices on the ABI PRisM 377 DNA Sequencer to data you collected on an
ABI PRisMm 310 Genetic Analyzer, nor can you apply a matrix made on
one ABI PRIsM 377 to a sample or gel file made on another
ABI Prism 377. In other words, you cannot apply matrix created on one
instrument to other instruments of the same model.

You can only assign a matrix to sample files generated on the same
instrument, under the same electrophoresis, gel matrix and buffer
conditions, and using the same dye set.

When to Create a Create a new matrix in the following conditions:
New Matrix ¢ For each dye set:
- D,F G5,E5

4 When you change the dye set you use to label sample fragments,
for example, if you are using the fifth dye.

4 When you use gel materials or buffers with pH values that differ
greatly from the pH value of the gel material or buffer on which the
existing matrices were generated.

¢ When you see multiple unexpected peaks of different colors under
an expected peak.

4 When you recalibrate your CCD camera (ABI PRism 310 Genetic
Analyzer and ABI Prism 377 DNA Sequencer) and the change is
greater than 3 pixels from the original pixel position.

4 When you replace the CCD camera (ABI PRISM 310 Genetic
Analyzer and ABI PRisM 377 DNA Sequencer).

4 When you see an increase in pull-up or pull-down.
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Considerations The following table lists some of the considerations before making a

Before Making a matrix:
Matrix

Consideration

Comment

load?

How much dye matrix standard to

With the ABI PRISM 377 DNA
Sequencer, loading more than 3 pL
will overload most wells and may
produce too much signal.

Any amount that results in a signal
over 4,000 RFUs is too strong.

Which lanes to load with the dye
matrix standards?

For gel electrophoresis, load the
matrix standards with an empty lane
between each sample to avoid
contamination of the individual dyes
by residual material leaking adjacent
samples.

matrix creation?

Which gel data will be used for

After generating a gel image, for
ABI PRisM 377 instrument, check
that the tracking of the gel file is
adequate.

Where to Store Store exported matrix files (.mtx) intended for use by Data Collection

Exported Matrix software in:
Files

D:\AppliedBio\Shared\Analysis\Sizecaller\Matrix\

If Data Collection and Analysis are installed on different computers, the
location is the same. Remember to copy the matrix from the analysis
computer to the Data Collection computer.

Note GeneMapper software matrices are stored in the Oracle database.

Creating and Evaluating a Matrix 9-7

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Process of Creating a New Matrix

Process Diagram The following diagram shows the procedure for making a new matrix:

Import samples into a new
GeneMapper project

i

View raw data to determine data
point range for the matrix

+
Select Tools > GeneMapper Manager
- +
Select the Matrices tab
+
Click New
- +
Enter a matrix description

"

Select the number of dyes

il

Select the sample file for each dye color

"

Insert the data point to start at for each
dye color

¥

Click Create

i

Review and edit the matrix result

¥

Click OK to save and close the window

Project window

GeneMapper
Manager window

Matrix Maker window

For sample preparation and loading information, refer to the appropriate
instrument user manual.
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Steps to Create a The following table lists the steps to create a new matrix:

New Matrix
Step | Process See Page
1 Choosing a Data Point Range for the Matrix 9-10
Calculation
2 Generating a New Matrix 9-12
3 Assigning the Matrix to Samples 9-16
4 Evaluating the Matrix 9-17
5 Using the Matrix with Data Collection 9-18
6 Causes for Bad Matrices 9-19
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Choosing a Data Point Range for the Matrix Calculation

Introduction Depending on how well your Matrix Standards run, it may be necessary
for you to choose a specific range of data points to be considered for
your matrix calculation.

In order to choose appropriate values for the data point range, you must
first view the sample file raw data from each of the matrix standard files,
S0 you can decide where to choose the start point for the data point
range.

Viewing the Raw To view raw data:

Data
Step | Action
1 Open a new GeneMapper Project.
2 Import Samples by selecting File > Add Samples to Project.
3 Select the files you want to view:

a. Navigate to the disk/directory containing the samples for
creating a matrix.

b. Select the files you wish to use.
c. Click Add to List.

4 Click Add to import the files into a new project and close the Add
Samples to Project window.

The Project window reopens with the imported files displayed in the
Samples tab.

5 In the navigation pane, expand the folder containing sample files.

Select a sample file.
7 Click the Raw Data tab.

What to Look For In the raw data display of the sample files verify the following:
in the Raw Data ¢ Data peaks are present in all four or five of the matrix standards.

Displa
piay There are no anomalies.
4 The baseline is stable (flat between peaks).
¢ Peaks are on-scale—no more than 8191 relative fluorescent

units—and the peaks of the dye of interest have a value of at least
200.
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Choosing a Data
Point Range

Eliminating
Primer Peaks

If peak data does not show these characteristics, refer to “Causes for
Bad Matrices” on page 9-19, for possible interpretations of your peak
data.

To choose a data point range:

Step | Action

1 Move the cursor well away from the primer peak, in a region at the
beginning of the run and in a flat part of the baseline, and record
the data point values for both the start and stop points in the flat
part of the baseline of the data point range.

Note When choosing the start point, do not include primer peaks
in the data point range (refer to “Eliminating Primer Peaks”). You will
need to enter these values in the next step when generating the
new matrix (refer to page 9-12).

2 Return to the Project window by selecting the run folder in the
navigation pane.

Both the primer peaks and the data peaks are displayed when viewing
the raw data of your matrix standards. Any time you run dye-labeled
samples on a gel (377 instrument), or capillary (310 instrument), you
have excess dye-labeled primer in the reaction. The primer peak
displays as the first peak, usually off-scale because it is in molar
excess. Eliminate the primer peak when making a matrix, by choosing
the start point after the primer peak in a flat area with a stable baseline.

Note To create a good matrix, you need at least five fragments in each color.
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Generating a New Matrix

Creating a To create a GeneMapper software matrix:
GeneMapper

. Ste Action
Software Matrix P
1 Select GeneMapper Manager > Tools . Then click the Matrices tab.
The Matrices page opens.
F‘m]eclal Analysis Melhudsl Table Semngsl Plot Settings MEWDIES' Size Slandardsl
|Name |Last8aved |0wner |# of Dyes |Descmptiun

2
3
4
i
B
7
a
q
10

MNew... Open.. Save As.. Impart... Export.. Delete

Done
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To create a GeneMapper software matrix: (continued)

Step | Action

2 Click the New button on the Matrices tab. The Matrix Editor dialog
box opens.

4 Matrix E ditor

Matrix Description

hhatrix Mame: |

Description: ‘ ‘

Matrix Settings

Select the Matrix Standard Sample File: Mumber of Dyes: IE

B | NoFile Selected for"B* Data Startat [1000 |
G | MoFile Selected for"G" Data Startat [1000 |
v | MoFile Selected for " Data Startat [1000 |
R | MoFile Selected for"R" Data Startat [1000 |

Foints: I1DDDDD
Create |

Matrix Result

B G N R
B 0.00o 0.00o 0.00o 0.00o
G 0.00o 0.00o 0.00o 0.00o
N 0.00o 0.00o 0.00o 0.00o
R 0.00o 0.00o 0.00o 0.00o
QK Cancel
3 Enter in a Matrix name and description, if desired.
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To create a GeneMapper software matrix: (continued)

Step | Action
4 Choose the number of dyes from the Number of Dyes drop-down
list.

If 5 dyes are selected, a button for “O” Data is added to the bottom

of the list.

Matrix Settings

Select the Matrix Standard Sample File: Mumber of Dyes: EZ[

B | NoFile Selected for"B* Data Startat [1000 |
G | MoFile Selected for"G" Data Startat [1000 |
v | MoFile Selected for " Data Startat [1000 |
R | MoFile Selected for"R" Data Startat [1000 |
0 | MoFile Selected for"0" Data Startat [1000 |

Foints: I1DDDDD
Create |

5 The B, G, Y, R, and O buttons represent dye colors. Choose the file
associated with the appropriate dye color.

a. Click a button to display a pop-up menu.

b. Use the pop-up menu to access a sample file to link to each of
the dye-labeled primers.

c. Choose the sample file that represents the dye color for that
button.

6 Enter the start point that you determined when choosing a data
point range in the Start At field.

Refer to “Choosing a Data Point Range” on page 9-11.

7 Enter the total number of data points to include to calculate the
matrix in the Points field.

In most cases, leave the default value, unless you must exclude a
portion of your data because of artifacts or bleed-through.

Note You must have at least five peaks to make a matrix.

8 Click Create to generates a new matrix.

9 Click OK to save and close the Matrix Editor dialog box.
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Matrix Example The following is an example of the matrix results showing the values
used to calculate the overlap correction.

Matrix Result
R 0
B |1.0000 0.2009 01176 0.0319 0.0385
G |09422 1.0000 0.8531 0.4977 0.2718
¥ |0.5638 0.6374 1.0000 0.9224 0.6925
R |0.2847 0.3627 07838 1.0000 1176
0 [0.0404 0.0862 0.1982 0.304 1.0000

| Cancel |

For each dye, the value where the dye fluorescence is read by the
appropriate filter is 1.000. The adjacent colors show the amount of
overlap for which the system must compensate. The adjacent values, in
most cases, should be less than 1.000, but greater than or equal to

0.0000.
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Assigning the Matrix to Samples

Introduction After generating the new matrix, assign it to all the samples that you
want to analyze.

IMPORTANT After assigning your matrix to samples, refer to “Evaluating the
Matrix” on page 9-17.

Procedure To assign a matrix to samples:

Step | Action

1 Open or create a GeneMapper Project containing the samples you
wish to analyze.

Select the Matrix column in the project window.

Select the appropriate matrix from the drop-down list for each
sample, or use the Edit > Fill Down feature.

4 Apply additional project settings prior to analyzing the sample files.

9-16 Creating and Evaluating a Matrix

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Evaluating the Matrix

Introduction After creating a new matrix and assigning it to select sample files,

evaluate the quality of the matrix. The quality of the matrix has a direct
impact on the quality of the results data.

Procedure To evaluate the matrix:

Step | Action
1 Analyze the sample files used to make the matrix.
2 Display results data for all the Dye Matrix Standard sample files in
the plot window, showing only electropherogram data.

For each displayed sample file you should see the following:

You should see...

If not...

that the only visible peaks represent
the color of the Dye Matrix Standard
run in that lane, or for that injection
(ABI PRIsM 310).

all other lines should be relatively
flat, indicating that the matrix
properly compensated for the
spectral overlap.

For example, for the blue matrix
standard sample file, you should
only see blue.

sharp, well-defined, singularly
colored peak data.

you probably have a bad matrix.

For instructions on how to identify
and correct problems with bad
matrices, see “Causes for Bad
Matrices” on page 9-19.
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Using the Matrix with Data Collection

Using Different Be sure to copy matrices generated and exported on the analysis
Computers for computer (the computer running GeneMapper software) to the Data

Data Collection Collection computer, if different. Copying the matrices will ensure that

the correct matrix name is stored in the sample file. The proper matrix is

and Analysis 4 ; g
required for accurate analysis of 310 and 377 sample files.

To transfer the matrix from one computer to another:

Step | Action
1 Click the Matrices tab in the GeneMapper Manager window.
2 Select Matrix to Export.
3 Click Export.
4 Select a name and location for the matrix.
5 Transfer the .mix file to the data collection computer.

Where to Store Store exported matrix files (.mtx) intended for use by Data Collection
Exported Matrix software in:

Files D:\AppliedBio\Shared\Analysis\Sizecaller\Matrix\

If Data Collection and Analysis are installed on different computers, the
location is the same. Remember to copy the matrix from the analysis
computer to the Data Collection computer.

Note GeneMapper software matrices are stored in the Oracle database.
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Causes for Bad Matrices

If an Error There are two possible causes for the error messages shown in the
Message Diplays following table:

If...

Take this action...

you designated the wrong files,

reassign the matrices.

Refer to “Assigning the Matrix to
Samples” on page 9-16.

the signal is too weak to make a

matrix,

rerun the matrix standards.

Two Causes of Bad The following table lists two common causes of bad matrices:

Matrices

Problem

Cause

What to do

Artifact peaks of
different colors under
the true peaks.

Refer to the figure
below.

Loading too much dye
when running matrix
standards, resulting in
dye bleed-through.

Complete another run
and recreate the
matrix.

Wrong Matriz

2600

2800

Bl

3000 3200

300
500_

400

200 ‘R
0 ..

i

4B : A11--Test 24-2 7/

4G A11--Test 24-2 7/

Al

Noisy baseline.

If the matrix subtracts
too much of a
particular color from
the sample, then the
baseline may become
too elevated, resulting
in false peaks.

Refer to the figure
below.

Complete another
matrix run and make
sure you do not have
any off-scale data.

Or, choose a different
set of fragments.
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The following table lists two common causes of bad matrices: (continued)

Problem Cause What to do
Gel Filerg 6.W Display-24 = |-
120 140 180 120 200 220 240 260 280 300 320 340 360 380 [1h|
3840
3360
2880
2400
1920
1440
980
430 JﬂJALW_
o < Ao ,&_‘_
i EE :11%test 2 S test 2 EE e6:11%test2 Atest 2
LIl 5v:11stest 2 /test 2 ER :11%test 2 £ test 2
kil h |¢||
Dye/Sample Minutes Size Peak Height Peak Area Data Point
3l
. 41.55 40.37 160 1128 558
. 41.76 41.44 150 983 566
42.03 42,78 484 4494 ]
.4 42.51 45.19 170 1240 594
. 42.75 46.39 126 955 G603
6 dz.94 4754 397 3408 612
ot 51.52 90.37 63 G665 932
. 51.87 gz.11 67 550 945
. 5z.00 az.78 &1 i asn
10 52.21 93.85 62 3z9 955 i
<] [
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Using the Size
Standard Settings

Chapter Overview

Introduction This chapter describes the Size Standard and Size Match Editors in the
ABI Prism® GeneMapper™ Software Version 3.0.

In This Chapter This chapter contains the following topics:

Topic See Page
About Size Standards 10-2
Size Standards Tab 10-3
Creating/Editing a Size Standard 10-5
Size Match Editor 10-12
Size Calling Curve 10-18
Performing a Sizing-Only Application 10-19

Using the Size Standard Settings 10-1

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com




About Size Standards

What are Size Size standards are specific DNA fragments of known sizes. After
Standards defining the sizes of a size standard, the GeneMapper™ software
matches this definition to the internal size standard included with the
run. The software assigns the defined size values to the appropriate
peaks of the internal size standard and uses this information with the
selected size calling method to size all unknown fragments.

Applied Biosystems provides several fluorescently labeled size
standards, which are described in Appendix D. If necessary, you can
also define your own size standard.

Advantages of Running an internal size standard results in precise molecular length
Using a Size determination, because the internal size standard and the unknown
Standard fragments undergo exactly the same electrophoretic forces.
GeneMapper software can then compensate for band-shift artifacts
caused by variations in the gel and in the sample from lane to lane or
injection to injection.

10-2  Using the Size Standard Settings
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Size Standards Tab

Purpose of the Size The Size Standards tab in the GeneMapper Manager window contains
Standards Tab a table of size standards stored in the database.

\-:-,-,I GeneMapper Manager E
Projects' Analysis Methods' Table Settings' PIDtSeﬂings' Matrices Size Standardsl

|LastSaved |Owner |Type |Descripti0n

Mew... Qpen... Save As... Export... Delete |
Done |
Item Description
Name column Size Standard name
Last Saved column Date/Time stamp showing when the size standard
was last saved
Owner column User name of the person who created the size
standard
Type Classic or Basic/Advanced
Description A description of the size standard
New button Opens the Specify parameters and Size Standard

Editor dialog boxes to create a new size standard

Open button Opens the editor for a selected size standard

Enabled when a single size standard is selected

Save As button Displays the Save As dialog box

Enabled when a single size standard is selected

Import button Displays a dialog box for Importing size standards

Always enabled

Using the Size Standard Settings 10-3
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Item Description

Export button Displays a dialog box for Exporting selected size
standard(s)
Enabled when one or more size standards are
selected

Delete button Deletes the selected size standard(s)

Done button Closes the GeneMapper Manager
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Creating/Editing a Size Standard

Overview

Specifying Size
Standard
Parameters

To create a size standard, you must first specify the parameters under
which the size standard is created and then define the peaks using the
Size Standard Editor. When editing a pre-defined size standard, only
the Size Standard Editor dialog box will be shown.

To specify size standard parameters:

Step | Action

1 Select Tools > GeneMapper Manager. Then click the Size Standards
tab.

2 Click the New button to open the Select Dye and Analysis Method
dialog box.

Select Dye and Analysis Method E

" Classic

[ied Red *

Artalysis Method: |3?3n Ds-33install v |

SeleckEample |

Ok | Cancel |

3 Select the appropriate button, Basic or Advanced or Classic. The
mode you select must be the same as the peak detection algorithm
you use to analyze the samples in Analysis Method.

Using the Size Standard Settings 10-5
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To specify size standard parameters:

Step | Action

4 If using the Classic mode:
a. Select a dye color from the drop-down list.
b. Select an Analysis Method from the drop-down list.

Select Dye and Analysizs Method I
= Basic or Advanced
¢ Classic
Drye: Red >

Analysis Method:

Select Sample |

0K | Cancel |

c. Click the Select Sample button to open the Select Sample
window, and select the sample file that contains the dye
standard you want to use as the template.

& Select Sample

Look in: |_| Microsatellite ;l

CO06_ED18_Run_CO06_2002-05-10_205_07 fsa
CO06_ED28 Run_CO0R_2002-05-10_205_05 fa
C006_E038_Run_CO0B_2002-05-10_205_03 fsa
CO06_E108_Run_CO0B_2002-05-10_205_01 fsa

File name: |Micrusatellite Select Sample |
Files oftype: IAEIIfsa(.fsa) | cancel |
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To specify size standard parameters:

Step | Action

5 Click Select Sample button to select the sample, and click OK.

The Size Standard Editor opens.

\-;wl Size Standard Editor
~Gize Standard Description———  Template File Info

MName I File: CO06_E029_Run_CO06
Run Date & Time: 20032-05-10 22:23:44.0
Description: Dwve: Red
Analysis Method Microsatellite Default

[ Size Standard Tahle

~Gize Standard:

10109
E739
3269

0 778 1556 2334 aMe 3830 4863 5446 BR2d4 002 77RO 65
] ]
Feak Data Points Size
1 1526 0.0 ind
2 1533 0o
El 1543 0o
4 1548 oo
b} 1553 oo
R 15RQ nn =

QK | Cancel |
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Using the Size The Size Standard Editor window in Basic or Advanced mode allows
Standard Editor in Yyou to define the peaks for each size standard dye you use.

Basic or Advanced
Mode G Size Standard Editor

Edit

Size Standard Description

Marme:

Description;

Size Standard Dye: |Red LI
Size Standard Table

Size in Basepairs
0.0 |

n.a

-

D

n.a

n.a

n.a

n.a

n.a

n.a

0ol | o @ M| e | R

n.a

M

0K | Cancel |

To use the size standard editor in basic or advanced mode:

Step | Action
1 Choose a Size Standard Dye color from the drop-down list.
2 Enter a description for the size standard you are creating.
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To use the size standard editor in basic or advanced mode: (continued)

Step

Action

3

Enter the base pair values to be defined in your size standard in the
table provided.

Note Use the Edit menu to undo certain actions or Add and
Remove Rows as desired.

Edit

Add Mewe Rowe Ctrl+2,
Remove Row  Cirl+R

Click OK to save and close the Size Standard Editor, or click Cancel
to close without saving.
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Using the Size The Size Standard Editor in Classic mode shows an electropherogram
Standard Editor in and a table of peaks for the dye color and sample selected. The
Classic Mode Software assigns a number to each peak found in the electropherogram
in order, from left to right. You should be able to recognize the peak
pattern of the standard in the electropherogram.

4 Size Standard Editor

Size Standard Description Template File Info
Mame: I File: CO06_ED29_Run_C006...
Run Date & Time: 2002-05-10 22:23:44.0
Description: Drye: Red
Analysis Method: Microsatellite Default
Size Standard Table
~Size Standard:
10109
6739
3369
0 e o e 31z w0 | es | sam | eaza | om0 e
K 1
Peak Data Points Size
1 1526 0.0
2 1533 0.0
3 1543 0.0
4 1548 0.0
i 15483 0.0
[ 15A8 nn

ak | Cancel |

Note You can only change the peak size value in the right column of the table.
You cannot change or rearrange the peak numbers.

Note If too many peaks display in the electropherogram or the baseline is too
high, you might need to adjust the analysis parameters.
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To use the size standard editor in classic mode:

Step

Action

1

Enter in a name and description for the size standard.

2

Specify the peaks of the standards and their sizes.

Click the peak you want to define either in the electropherogram or
in the table, or click on a row and the corresponding peak is
highlighted.

Note For easier viewing, you can zoom in on the
electropherogram by click+drag on the X-Axis numbers.

Type the peak size in the corresponding column.

Note Leave a zero in the Size column when you want to ignore a
peak for the standard definition.

Press the tab key to automatically move to the next size standard
peak.

Click OK to save and close the Size Standard Editor, or click Cancel
to close without saving.
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Size Match Editor

Introduction The Size Match Editor window enables you to examine size standard
electropherograms, edit the identification of size standard peaks, and
view the size calling curve. To open the Size Match Editor window, click
Analysis on the toolbar in the GeneMapper Project window and select
Size Match Editor.

w Size Match Editor

Edit View Tools

B &
3_C0 53 Size Matches | size Calling Curve |
Sizing Quality=1.0 Oyerride 50 |
20 S
1947 1525 82 Tz
1730
25 50

1514

1298

1081

265

649

a3z

216

1] + + + + + + + ' i e e H=tbey +
0 550 100 1850 2200 2P50 B300 3850 4400
KN i |
oK | Cancel | ARply |

When the Size Match Quality indicator shows a marginal or fail state,
you can use the Size Match Editor to help adjust the in-lane size
standard to make it valid. Typical problems include the following
conditions:

4 Peak shift - The algorithm does not correctly identify a peak,
resulting in invalid positions for other size standard peaks.

¢ Missing peak - The algorithm does not identify a peak.

Extra peak - The algorithm identifies a peak that is not a size
standard peak,but a spike or pull-up peak.
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table below.

Window Elements The Size Match Editor window elements are described in the following

Element

Description

Sample navigation
pane

Enables you to select a sample to view by scrolling
through the Sampile list. The list of samples displayed
reflects the list of samples selected in the Project
Sample view.

Size Quality
indicator

Displays the quality of the currently displayed size
standard (name listed above the plot). Value 0.0-1.0.

Size Matches
electropherogram

Displays the size standard peaks. Clicking on a peak
selects it (single selection only).

Size Calling curve

Displays the size calling curve for best fit.

OK button

Closes the Size Match Editor window, accepting the
pending changes. For samples whose size standards
are modified, the Project window is ready for
reanalysis.

Cancel button

Closes the Size Match Editor window, disregarding
any pending changes.

Apply button Same as OK button, except the dialog box remains
open.

Override SQ Allows the user to override the Sizing Quality value

button and automatically set the value to 1. This will cause

the sizing quality to be invalidated and a check mark
will display in the SQI column in the Project window
Samples tab.

¢ Edit
¢ View
¢ Tools

Editor Commands The following Size Match Editor menus are described in this section:
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Edit Menu

The Edit menu is used to delete or change size labels.

=Ll View Tools

Urd ([
AaniEize Catell
Delete Size Label Delete

Change Size Label...
Delete All Size Labels Ctrl+Delete

Iltem Description Enabling

Undo Undoes the last user action. Enabled after a user

(Ctrl+2) action that adds,
modifies, or deletes.

Add Size Adds a size label to the selected Enabled when an

Label peak. unlabeled peak is
selected.

Delete Size Deletes the size label of the Enabled when a

Label selected peak. labeled peak is

(Delete) selected.

Change Size | Opens a dialog box for the Enabled when a

Label selected peak, allowing the labeled peak is

selection of a new size label. selected.

Delete All Removes/deletes all size labels for | Always enabled.

Size Labels the selected size standard sample.

(Ctrl+Delete)
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View Menu

The View menu is used to change the Size Match Editor window.

£oam

k

Y-Rxis Scale

k

¥ Show Mavigator Cirl+Shift+

4 Scale to... user defined

ltem Description Enabling
Zoom Submenu used to scale the plotto | Always enabled.
the following value:
Eull View (Ctrl+])
Y-Axis Scale 4 Scale to maximum Y (default) Always enabled.

Show Navigator

Switches the navigator pane

Always enabled.

(Ctrl+Shift+N) (Removes the pane with the first
use and restores it on the second
use.)

Tools Menu

Tools

Auto Adjust Sizes
Check Sizing Guality

Item Description Enabling
Auto Adjust Auto adjusts size standard Always enabled.
Sizes peaks.
Tooltip: Auto Adjust
Check Sizing Checks the quality of the Always enabled.
Quality current size matching.
Tooltip: Check Quality
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Toolbar The Size Match Editor toolbar contains the following icons:

lcon Description Enabling
Autoadjusts size standard peaks. Enabled after a
M Adjusts the size of other peaks peak is changed.

automatically to the right of the
selected peak.2

Tooltip: Auto Adjust Sizes

Checks the quality of the current size Enabled after a
I@ matching. Checks the quality of the peak label is
revised peak positions and updates changed.

the Size Match Quality indicator.b
Tooltip: Check Sizing Quality

x Deletes all size labels. Always enabled.

Tooltip: Delete All Size Labels

a. Only for Basic and Advanced modes.

b. Only for Basic and Advanced modes.

Using the Size The Size Match Editor window uses the mouse for editing.

Match Editor Note All user edited size standard samples automatically have a sizing quality

of 1.0, and display a check mark in the SQI column in the Samples window.

To edit a particular Size Standard peak:

Step | Action
1 Import and analyze samples in the Project window.
2 Sort failed samples to the top of the Samples tab view.
3 Select the samples whose size match you want to edit.
4 Select Analysis > Size Match Editor.

The selected samples display in the navigation pane at the left side
of the window. Selecting a sample name in this list displays its Size
Standard electropherogram in the plot panel.

5 Click the peak to be edited.

Right-click the peak to open the editing pop-up window, and Add,
Delete, or Change the selected peak.
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To edit a particular Size Standard peak: (continued)

Step

Action

7

If you choose Add or Change, move the cursor to the right to open
the Select Size sub-menu.

Choose the desired height value from this menu.

Check the sizing quality by selecting Check Sizing Quality under the
Tools menu.

If the peaks are sized correctly, but the quality score is still below
passing, click the Override SQ button to set the SQ to 1.0.

Click Apply if you are going to edit a second size standard peak, or
click OK if you are finished applying your changes to the edited
peak.
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Size Calling Curve

Overview The Size Calling Curve is used as a measure of how well the internal
size standard matches the standard definition, and whether or not it is
linear.

The Size Calling Curve displays two curves.

i Size Match Editor il
Edit View Tools
= |

Ii Size Matches Size Calling Curve

o

Best Fit Second Onder Curve

5ol £0=d6 7667269434671
A1=0 05T 44BTE0294501856
£3=0 5583610746348 29E-6
R'2=0.9999 168353

Size Calling Curve

Local Southem bethod

600 700 00 00 4000 100 4200 4300 400 1500 1600 1700 1800 1900

DK Cancel kY

Red Curve [f the size calling curve is a red curve, it is based on the sizecalling
method used to analyze the data.

Black Curve If the size calling curve is a black curve, it is a best-fit, least squares
curve, which the GeneMapper software calculates for all samples,
regardless of the size calling method used. This curve is provided to
help evaluate the linearity of the sizing curve. When the sizing curve
and best-fit curve match, they overlap so you see only the size curve.

Note Sizing problems due to anomalous mobilities may be displayed as
non-linear.
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Performing a Sizing-Only Application

Introduction Sizing-only applications quickly analyze data without generating
genotype calls.

General
Sizing-Only

To perform a general sizing-only application:

Application | Step

Action

1

Import samples into the Project window.

2

In the Analysis Method column, select an analysis method with the
following features:

4 The appropriate analysis type selected for your data
¢ A Binset of none

¢ The appropriate Peak Detection Algorithm set for your data

In the Size Standard column, select the size standard used with
your data.

Analyze your samples.

4 Samples are analyzed for sizing only; no genotype calls will be
made.

4 When viewing samples in the Plot window, the Sizing Table
displays information for all peaks detected.

Sizing To take advantage of the Auto Bin feature for generating marker bins for
Microsatellite microsatellite data, reference data needs to be sized.

Reference Data To size reference data:

Step

Action

1

Import microsatellite reference samples into the Project window.

2

In the Analysis Method column, select an Analysis Method with the
following features:

4+ Analysis Type set to Microsatellite
4 Binset set to none

4 Peak Detection Algorithm set for your data

In the Panel column, select the panel that references this data.

Panels must be created in advance of Auto Binning and should
contain all marker information known.
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To size reference data: (continued)

Step | Action
4 In the Size Standard column, select the size standard used with
your data.
5 Analyze your samples.

Samples are now ready to be used for Auto Binning in the Panel
Manager.

Sizing SNaPshot Whether creating SNaPshot® bins manually or by using the Auto Panel
Reference Data feature with SNaPshot Primer Focus samples, reference data needs to
be sized.

To size reference data:

Step | Action

1 Import SNaPshot or Primer Focus reference samples into the
Project window.

2 In the Analysis Method column, select an Analysis Method with the
following features:

¢ Analysis Type set to SNaPshot
4 Binset set to none

4 Peak Detection Algorithm set for your data

3 Set the Panel column to none.

4 In the Size Standard column, select the size standard GS120LIZ®
or the appropriate size standard for your data.

5 If using Primer Focus samples, set the Sample Type column to
Primer Focus.

6 Analyze your samples.

Samples are now ready to be used for creating bins in the Panel
Manager.
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Process Quality
Values

Appendix Overview

Introduction This appendix describes how users can optimize the quality assurance
level of their results by using the Process (component-based) Quality
Values (PQV) in the ABI Prism® GeneMapper™ Software Version 3.0 to

troubleshoot the data analysis process.

In This Appendix This appendix contains the following topics:

Topic See Page
Overview of Process (Component-Based) Quality Values A-2
(PQV)

Using Process (Component-Based) Quality Values A-3

Process Quality Values A-1
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Overview of Process (Component-Based) Quality Values (PQYV)

What are Process Process Quality Values (PQVs), values reported by data analysis, aid in
Quality Values finding and fixing problems in sample preparation and analysis. These
values are the end results reported by the PQV system.

The PQYV Process The PQV process includes the following :

4 At the end of the process, quality values (also known as PQV or
Process Component-Based Quality Values) are assigned to the
size calling process and the allele calling process.

4 On the Samples page and Genotypes page, the columns
presenting PQV result data, other than SQ and GQ results, display
the following samples after analysis:

—  “Pass [l“ (green square) symbol when no problem exists,

—  “Check /\” (yellow triangle) symbol when there are
problematic components such as missing size standards, or
missing matrices

- “Low Quality @ " (red octagon) symbol when the result falls
below an acceptable response

What are PQVs PQVs reported by data analysis are an aid to finding and fixing
problems in sample preparation and analysis. These values are the end
results reported by the PQV system.

Editing PQVs When you edit PQVs you must create an Analysis Setting and select
the application mode to control which PQVs are used and available to
the user for editing.

A-2  Process Quality Values
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Using Process (Component-Based) Quality Values

The PQV System Quality values reported by the GeneMapper software are an aid to
finding and fixing problems in sample preparation and analysis. These
values are the end results reported by the PQV system. For more
information on the PQV system, see “Unique Features of GeneMapper
Software v3.0” on page 1-3.

The color-coded, sortable PQV values on the Samples and Genotypes
pages allow the user to isolate problem samples quickly and examine
the electropherograms.

Two types of PQV values are presented on the Samples and Genotypes
pages. On the Samples page:

4 The SFNF, MNF, SNF, and OS parameters report results as Pass
[l or Check /\.

¢ The second type, the Sizing Quality (SQ) parameter, reports results
as Pass [Jll, Check /\, or Low Quality @.

On the Genotypes page:

4 The SHP, AN, AE, OBA, SPA, Bin, PHR, LPH, SPU, BD, SP, OS,
CC, OVL, NB, and DP parameters report results as Pass [l or
Check /\.

¢ The second type, the Genotype Quality (GQ) parameter, reports
results as Pass i}, Check /\, or Low Quality @@.

Note On the Genotypes page, the ADO and AE parameters are also PQV
parameters but they report results as checks } instead of colored flags.

A Low Quality (red octagon) quality value for the Sample SQ indicates
that the sizing standard has failed. A Low Quality value for the GQ
parameter means the analysis has failed for that marker. You can set
the thresholds for the SQ and GQ values in the Analysis Method Editor
on the Quality Flags page.

Process Quality Values A-3
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Rules for PQV In gaining familiarity with the PQV columns on the Samples page and
Columns Genotypes page, keep the following rules in mind:

4 Quality metrics with Pass/Check values and no Low Quality value
are warning flags. Analysis does not stop if problems are detected
with these properties, but the user should examine results flagged
with Check values.

¢ Holding the cursor over a column header displays a ToolTip
identifying the full name of the column (the default names are often
acronyms).

4 PQV results are reported in the column labeled SQ on the Samples
page and GQ on the Genotypes page.

The SQ and GQ quality indicators (displayed in either symbols or in
numerical values depending upon the Quality Metrics Display
setting in the Tools-Options Analysis tab) have the meanings listed
below:

— Green = good data (default: numerical range of 0.75 to 1.0)

— Yellow = questionable data (default: numerical range of 0.25 to
0.75)

— Red = low quality data (default: numerical range of 0.0 to 0.25)
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PQYV Flags on the The PQV flags on the Samples page.
Samples Page

PQV Column | Description

SFNF Sample File Not Found

¢ Aflag (Pass [l or Check ) is automatically
displayed when no sample file is found.

4 Not editable.

MNF Matrix Not Found

¢ Aflag (Pass [ or Check ) is automatically
displayed when no matrix file is found attached to the
sample file.

4 Not editable.

SNF Size Standard Not Found

¢ Aflag (Pass [ or Check ) is automatically
displayed when no size standard is found.

4 Not editable.

OoSs Offscale

¢ Aflag (Pass [ or Check ) is automatically
displayed when there is offscale data in the signal.

4 Not editable.

4 |Indicates an offscale result in the size standard region of
the signal.

SQ Sizing Quality

¢ Avalue (Pass [, Check , or Low Quality @) is
automatically displayed to indicate the sizing process
quality.

4 The sizing quality is calculated based on the similarity
between the size standard fragment pattern and the
actual size standard peak distribution pattern in the
sample.

4 Not editable.
4 This feature performs the following functions:

— ldentifies and eliminates the primer peaks based on
peak shape

— Performs size matching (ratio matching)

— Makes a size calling curve using the Local Southern
Method

A-6 Process Quality Values

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



PQYV Flags on the The PQV flags on the Genotypes page:

Genotypes Page
P g Column Description

AE Allele Edit (check box)

4 The check box displays unchecked immediately after
analysis.

¢ The check box is checked when the marker allele calls
have been edited by the user.

Note The marker allele calls are edited in the Plot View
page. The user can enter comments in the Allele History
Comments column on the same page.

ADO Allele Display Overflow (check box)

4 The check box is checked when the number of alleles the
marker calls exceeds the number to display previously set
by the user.

4 The user specifies how many alleles to display in the Table
Settings Editor parameters. The default is two.

¢ There are six columns for each allele to indicate name,
size, height, area, mutation and comments.

SHP Sharp Peak

¢ Aflag (Pass ¥ or Check ) is automatically displayed
when there is a sharp peak present in the marker signal.

4 Analysis does not stop if problems are detected with these
properties, but the user should examine results flagged
with Check values.

4 The PQV system gives a label of SHP to indicate a cluster
of peaks with a large, narrow peak in the middle whose
width is 50% less than the neighboring peak.

4 This flag is used for Linkage Mapping (Microsatellite,
dinucleotide only) analysis.

4 Not editable.
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The PQV flags on the Genotypes page: (continued)

Column Description

AN Allele Number

¢ Aflag (Pass ll or Check ) is automatically displayed
when the number of alleles exceeds the maximum legal
number for the organism, or no alleles are found. That
number is specified in the analysis method.

4 Triggering this flag reduces the final PQV Genotype value
(GQ parameter) to zero (“0” multiplier).

4 Not editable.

OBA One Basepair Allele

¢ Aflag (Pass ll or Check ) is automatically displayed
when there is a one-base pair allele (a microvariant peak)
present in the marker signal.

4 Two allele peaks that are one base pair apart are flagged.
This may indicate the presence of a microvariant and/or an
invalid allele call.

4 This flag is used only for LMS (Microsatellite, dinucleotide
markers only).

4 Not editable.

SPA Single Peak Artifact

¢ Aflag (Pass l or Check ) is automatically displayed
when the marker signal contains single peaks due to some
problem in electrophoresis.

4 The flag is triggered, when there are no peaks present
within a two-base pair range prior to an allele peak.

4 This feature detects the absence of stutter peaks, which
indicates nonmicrosatellite peaks.

4 This flag is used only for LMS (Microsatellite, dinucleotide
markers only).

4 Not editable.
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The PQV flags on the Genotypes page: (continued)

Column

Description

Bin

Out of bin allele

¢ Aflag (Pass ll or Check ) is automatically displayed
when the called alleles’ peak apex is out of the bin
boundary.

4 Triggering this flag reduces the final PQV Genotype value.
The default is 20% (0.2 multiplier) of what it would be
otherwise.

4 This flag is used for LMS analysis.
4 For HID, this is labeled OL (off ladder alleles).
4 Not editable.

PHR

Peak Height Ratio

¢ Aflag (Pass ll or Check ) is automatically displayed
when there are two alleles present and the ratio between
the lower allele height and the higher allele height is below
a certain level.

4 If there are more than two alleles present, the calculation
iterates through all the peak pairs.

¢ PHR can be set in the Peak Quality tab of the analysis
method (Analysis Manager). The default is 50%.

4 For LMS markers, the ratio is calculated based on peak
heights of the called allele peaks.

4 For SNP, the ratios are calculated the same as for
microsatellite markers except it goes across two different
colors and only two peaks are used in the calculation.

4 Not editable.

LPH

Low Peak Height

¢ Aflag (Pass ¥ or Check ) is automatically displayed
when the alleles are lower that the specified values and do
not result in the proper intensity.

4 The homozygous (default is 200) and heterozygous
(default is 100) values can be set in the Peak Quality tab of
the Analysis method (Analysis Manager).

4 Setting this flag reduces the final PQV Genotype value (GQ
parameter). The default is 50% (0.5 multiplier) of what it
would be otherwise.

4 Not editable.
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The PQV flags on the Genotypes page: (continued)

Column Description

SPU Spectral Pull-Up

¢ Aflag (Pass ll or Check ) is automatically displayed
when the marker signal contains bleed-through peaks
(pull-up peaks).

4 Pull-up is when the peak height of the called allele peak is
less than X% of the larger peak within +1 data point.

4 The default is a conservative 10% to check all colors. The
user can set this value.

4 This flag is used for LMS (Microsatellite), SNP, and HID.
4 Not editable.

BD Broad Peak

¢ Aflag (Pass l or Check ) is automatically displayed
when the called alleles’ peak width is wider than a certain
value. The default of this value is 1.5 basepair.

4 This flag is used for SNP, HID, and LMS (Microsatellite, all
markers).

4 Not editable.

SP Split Peak

¢ Aflag (Pass [l or Check ) is automatically displayed
when a split peak is found by GeneMapper software.

4+ A split peak is defined as overlapping peaks that are < .25
basepairs apart (the horizontal distance from two peak
apexes).

4 Not editable.

(O Offscale

¢ Aflag (Pass [l or Check ) is automatically displayed
when there are offscale peaks present within the marker
size range.

4 This flag is used for all applications.
¢ Not editable.
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The PQV flags on the Genotypes page: (continued)

Column Description

CC Control Concordance

¢ Aflag (Pass [ or Check ) is automatically displayed
when the designated control sample does not exactly
match the defined alleles for this marker in the panel being
scored.

¢ This feature serves as an internal control for quality
assurance, and allows you to see deviations in your
controls.

¢ This flag is used for all applications.

4 We recommend that you run the control sample at least
once for every panel.

4 Not editable.

OvL Overlap

¢ Aflag (Pass [l or Check ) is automatically displayed
when a peak in the overlapped region is called twice. (It is
possible to have two allele size ranges that overlap.)

¢ This feature serves as a warning for an allele calling error.
¢ This is used for HID only.

NB Narrow Bin

¢ Aflag (Pass [l or Check ) is automatically displayed
when a peak is present at a position within 0.5 basepairs
from a bin and no peak is present inside that bin.

4 The benefit is to capture peaks that fall outside of bin
boundaries due to experimental variations.

¢ This flag is used for SNP only.

DP Double Peak

¢ Aflag (Pass [l or Check ) is automatically displayed
when two peaks of the same color in the same bin have a
ratio >0.5. (minor peak height/major peak height)

4 This flag is used for SNP only.
4 Not editable.
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The PQV flags on the Genotypes page: (continued)

Column Description

GQ Genotype Quality

4 A Low Quality or red octagon . is shown when the
analysis has failed for that sample.

¢ Pass [l Check /\ , or Low Quality @@ flags are set by
the Analysis Method. Not editable.

Below is a representation of sample peaks with the allele
quality (AQ) assigned.

AG

AG

See the following page for information about the mathematical
formula used to calculate the Genotype Quality from a sample
represented by the image above.
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The PQV flags on the Genotypes page: (continued)

Column

Description

GQ
(continued)

Genotype Quality - Mathematical Formula

¢ The mathematical formula used is:

M

i i

a

fiﬁ

GQ = MQP x (PQV, x PQV, x..xPQVy)

GR2119

a AQ (Allele Quality) is a function of quality value assignments for the
following: sizing quality, allele calling quality, bin assignment quality,
and bin quality.

b MQ (Marker Quality) is modified by user defined PQVs to generate
the final GQ value.

4 PQVs are weighted from 0 to 1.
¢ The actual value of a PQV in the equation is:
1 minus the weight

¢ 0 (weight) = no effect on the final GQ calculation
(1 minus 0 = 1, therefore no change to GQ value)

4 1 (weight) = full effect (1 minus 1 = 0) (If you multiply GQ by
0 and you get a GQ value of 0, then the sample analysis
failed.)

¢ Between 0 and 1, the higher the value, the greater the
impact on GQ.

4 PQV filtering is controlled by the threshold set by
GeneMapper software users, and remains fully functional
irrespective of what weight is chosen.
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Software Genotyping
Algorithms

Appendix Overview

Introduction This appendix provides a description of the new genotyping algorithms
used in the ABI PRISM® GeneMapper™ Software version 3.0 and a
detailed description of the Peak Detection Basic, Classic, and
Advanced algorithm settings.

In this Appendix This appendix contains the following topics:

Topic See Page
GeneMapper Software Genotyping Algorithms B-2
Basic Mode - Peak Detection Algorithm Settings B-8
Classic Mode - Peak Detection Algorithm Settings B-9
Advanced Mode - Peak Detection Algorithm Settings B-14
Peak Detection: Polynomial Degree and Peak Window Size B-19
Parameters

Optimizing Peak Detection Sensitivity: Example 1 B-23
Optimizing Peak Detection Sensitivity: Example 2 B-25
Optimizing Peak Detection Sensitivity: Example 3 B-27
Peak Detection: Slope Threshold for Peak Start and Slope B-28
Threshold for Peak End Parameters

Slope Threshold Examples B-30
Size Calling Methods for Classic and Advanced Modes B-32
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GeneMapper Software Genotyping Algorithms

Overview Five algorithms used in the GeneMapper software are discussed in this
appendix:

4 Peak Detection - uses Basic, Advanced, or Classic mode to detect
peaks and process data

4 Size-matching/calling—matches found peaks to size standards
¢ Binning—determines bin centers for genotyping

Allele calling—produces a consensus call based on several
allele-calling algorithms

4 Quality value determination—assigns a quality value to size- and

allele-calling algorithms (See Appendix A, “Process Quality Values,
for more information.)
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A flowchart of the data flow in GeneMapper software is shown below.
Standard signal processing is applied to the data prior to being

delivered to the GeneMapper algorithms.The algorithms discussed
here are shown in the raised portion.

Input sample ABI Prism 310/377 systems ————————— 3| Multicomponenting

ABI PrISM 3730/3700/3100 systems

Peak detection

Y
Size-matching/calling
Caller 1 o o o o O
Arbitrator

l Final quality value determination ‘

Report results to user

Peak Detection This algorithm uses Basic, Advanced, or Classic mode to detect peaks
Algorithm and process data. (See “Basic Mode - Peak Detection Algorithm
Settings” on page B-8,“Classic Mode - Peak Detection Algorithm
Settings” on page B-9, and “Advanced Mode - Peak Detection
Algorithm Settings” on page B-14.)
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Size-Matching This algorithm uses a dynamic programming approach that is efficient
Size-Calling (runs in low polynomial time and space) and guarantees an optimal
Algorithm Solution. It first matches a list of peaks from the electropherogram to a
list of fragment sizes from the size standard. It then statistically derives
quality values determined by examining the similarity between the
theoretical and actual distance between the fragments.

SizeSize-Matching Algorithm Example

An example of how the size-matching/calling algorithm works is shown
below using a contaminated GeneScan™ 120 size standard data.

Peaks found (standard and contamination) are indicated by blue lower
bars along the x-axis. The size standard fragments as determined by
the algorithm (and their corresponding lengths in base pairs) are
designated by the upper green bars. Note that there are more peaks
than size standard locations because the standard was purposely
contaminated to test the algorithm. The algorithm correctly identifies all
of the size standard peaks and removes the contamination peaks
(denoted by the black triangles) from consideration. The large peak is
excluded from the candidate list by a filter that has identified it as being
atypical with respect to the others.

Bars indicate size standard

determined by algorithm Bars indicate

peaks found

200~ E -

-
o
=]

flourescence

| L1 I <711 | |

|
0 400 800 1200 1600
scan line
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Binning Algorithm

Allele-Calling
Algorithm

This algorithm estimates the bin centers using all found alleles. To
determine true bin positions, the algorithm uses an iterative clustering
technique and then reports a quality value proportional to the binning
noise. To enhance the flexibility, bins may also be edited manually.

Note When the user creates bins manually, all alleles, regardless of their
quality values, are treated as reference alleles as long as the alleles reside
within the created bins’ boundaries.

Final allele calls are based on a consensus between several different
allele-calling algorithms. Each caller has a different design philosophy
such that it excels in a particular data regime. A variety of allele-calling
algorithms are used. Allele-calling algorithms involve envelope
detection, optimization of parametric models, and rule-based systems.

Example Output of Different Allele-Calling Algorithms

The following is an example of three different allele-calling algorithms
for 16 samples. User annotations are denoted by the (red) circles, allele
caller outputs are denoted by the (green, black, and blue) asterisks.
Note that consensus between multiple callers virtually assures that the
calls are correct. In certain cases some algorithms have not made a call
since they have determined that the data is too complex to act on.
Examples of this occur in (i) and (p). Here the blue asterisks show the
calls transmitted to the user. Low quality values are reported because in
both cases the first algorithm did not call and in (i) the black caller is not
in agreement with the blue. However, despite these conditions, the calls
are correct. The low quality values alert the user to potential problems
such as the spurious peak in (i) and the high background in (p).
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Quality Value The Quality Value Determination algorithm is used to create Process
Determination Quality Values (PQVs). PQVs are reported by data analysis and are an
Algorithm aid to finding and fixing problems in sample preparation and analysis.
These values are the end results reported by the PQV system

The quality value determination algorithm equation is the following:

MQ' = x (AQ2
GQ = MQ x (PQV, x PQV, x...xPQVY)

PQVs are weighted from 0 to 1.
4 The actual value of a PQV in the equation is: 1 minus the weight

4 0 (weight) = no effect on the final GQ calculation
(1 minus 0 = 1, therefore no change to GQ value)

¢ 1 (weight) = full effect (1 minus 1 = 0) (If you multiply GQ by 0 and
you get a GQ value of 0, then the sample analysis failed.)

¢ Between 0 and 1, the higher the value, the greater the impact on
GQ.

PQV filtering is controlled by the threshold set by GeneMapper software users,
and remains fully functional irrespective of what weight is chosen.

1. MQ (Marker Quality) is modified by user defined PQVs to generate the final GQ value.

2. AQ (Allele Quality) is a function of quality value assignments for the following: sizing
quality, allele calling quality, bin assignment quality, and bin quality.
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Basic Mode - Peak Detection Algorithm Settings

Overview The Basic peak detection algorithm is used as the default algorithm by
GeneMapper software v3.0. Basic Mode uses the Local Southern size
calling method which determines the sizes of fragments by using the
reciprocal relationship between fragment length and mobility.

In Basic mode there are two analysis parameter options.

4 Minimum Peak Height - Automatic

4 Minimum Peak Height - User specified (rfu)

Minimum Peak The Minimum Peak Height group box provides two parameter options:

Height

Item

Description

Automatic
option button

This option button sets the level
automatically for the five dye colors (blue,
green, yellow, red, and orange).

This level represents the minimum signal
strength that will be identified as a peak for
each dye (equivalent to 10 times the noise).

User specified (rfu)
option button

This option button enables the number entry
fields for the five dye colors (blue, green,
yellow, red, and orange).

These numbers are the minimum signal
strength that will be identified as a peak in
relative fluorescent units (rfu). For all dyes,
the default is 50, the minimum is 1, and the
maximum is any number of 10 digits.
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Classic Mode - Peak Detection Algorithm Settings

Overview In Classic mode there are five analysis parameter options. They are as

follows:

¢ Ranges

¢ Data Processing

4 Size Calling Method
¢ Peak Detection

4 Split Peak Correction

Ranges Parameter The following are the Ranges parameter options:

Options
Item Description
Analysis Used to analyze all the data collected on the genetic
drop-down menu: analysis instrument for each sample.
Full Range Enter Start and Stop data point numbers in the entry

fields in order to specify only a limited range analyzed
for each sample. The data point numbers affect what
is displayed in the results display. Normally, set the
analysis range to start after the primer peak.

Partial Range

Note Sample files generated from the ABI PRISM®
377 DNA Sequencer may have already removed the
primer peak by setting the data point range for gel
image generation to exclude the primer peak.

Sizing Enter Start and Stop size numbers in the entry fields
drop-down menu: in order to specify only a limited range analyzed for
All Sizes each sample.

Partial Sizes
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Data Processing The Data Processing parameter options specify how the raw data is
Parameter Options processed before peak detection and size calling.

Description of the data processing parameter options:

Item

Description

Baseline checkbox

Used to automatically adjust the baselines of all
detected dye colors to the same level for a better
comparison of relative signal intensity.

Multicomponent
checkbox

Note Do not
check this box for
multicapillary
instruments. This
user function was
performed in Data
Collection.

Used to specify that the GeneMapper software
applies a predefined matrix to adjust for spectral
overlap when it performs analysis.

Although the dyes used to label DNA fluoresce at
different wavelengths, the spectra overlap to some
extent. Create a matrix file containing a mathematical
matrix to correct for this overlap.

For a description of matrix files and how to create
them, see Chapter 9, Creating a Matrix File.

Smoothing
option buttons

Used to help reduce the number of false peaks
detected by the GeneMapper software.

You have the following options:

Select... | To...
apply no smoothing.

None

Select this option if the data has very
sharp, narrow peaks of interest.

Light provide the best results for typical
data.
Heavy apply to data from slower runs that

has very broad peaks, or to avoid
the detection of sharp edges.

Choosing this option might reduce
peak size or eliminate narrow peaks.
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Size Calling
Method Parameter
Options

Click a radio button to select the desired size calling method. The
GeneMapper software uses these methods to determine the molecular
length of an unknown fragment.

Description of the size calling method parameter options:

Interpolation

Item Description

2nd Order Least Both Least Squares methods use regression analysis
Squares and 3rd to build a best-fit size calling curve.

Order Least

Squares

Cubic Spline Forces the sizing curve through all the known points

of the selected GeneScan size standard.

Local Southern
method

Determines the sizes of fragments by using the
reciprocal relationship between fragment length and
mobility. (Default method)

Global Southern
method

Similar to the Least Squares method in that it
compensates for standard fragments that may run
anomalously.

Peak Detection Use the Peak Detection parameter options to specify the minimum peak
Parameter Options height to be detected for analysis. This, in turn, controls the number of
peaks analyzed. Peaks falling below the parameters specified display in
the electropherogram, but are not analyzed, and no values display for
them in the tabular data.

Description of the detection parameter options:

Item

Description For example

Peak Amplitude
Thresholds

Set the dye amplitude
threshold at a level that
allows the software to
detect peaks, but
eliminate noise.

For each dye, the
GeneMapper software
detects peaks above
the threshold entered
in the entry field.

If you leave the default
value of 50, peaks with
amplitude above 50 are
analyzed and display in
the tabular data.

Lower amplitude peaks
still display in the
electropherogram, but
are not analyzed and
do not display in the
tabular data.
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Description of the detection parameter options: (continued)

Item Description For example
Minimum Peak Half Defines what If this number is large,
Width constitutes a peak. the software ignores
: Use to specify the noise spikes.
smallest half peak If the peaks in the data
width for peak are narrow, set the
detection. value to a low number.
The range is from Experiment with this
2-99. value to determine the
A typical number might best number for the
. . data.
be 3 for microsatellites,
or 10 for SSCPs.

Split Peak Under denaturing conditions, certain fragments in the GeneScan 2500
Correction Standard display as doublets, or split peaks. This standard has labels
Parameter Options ©n both stands of the DNA. Under poor denaturing conditions you see
split peaks. One of the two fragments typically has normal mobility,
while the other does not. The Split Peak Correction feature allows the
software to correctly call each of the splits.

If you select split peak correction, you will also need to verify or change
the correction limits. After you decide on a split peak correction method,
use the same method for all projects to keep size calling consistent.

Description of the split peak correction parameter options:

Item Description
No Peak Correction | No correction for doublets.
GS2500 Peak Makes the following peak size assignments for
Correction GeneScan 2500:

¢ The right peak for all fragments 222, 233, 238,

286, and 490.

¢ The left peak for all other splits.
Left Most Peak Chooses the left peak for every doublet.
Correction

B-12 Software Genotyping Algorithms

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Description of the split peak correction parameter options: (continued)

Item Description

Right Most Peak Chooses the right peak for every doublet.
Correction

Correction Limit Set a correction limit if correcting for doublets.

Set this value slightly larger than the largest split
observed.

This value (set in data points) specifies the maximum
width of split that should be corrected (the difference
in data points of the positions of the two peaks).
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Advanced Mode - Peak Detection Algorithm Settings

Overview In Advanced mode, there are four main analysis parameter options.
They are as follows:

¢ Ranges

4 Smoothing and Baselining
4 Size Calling Method

¢ Peak Detection

Ranges Options The following are the Analysis Range options:

Item Description

Full Range button Use to analyze all the data collected on the genetic
analysis instrument for each sample.

Partial Range Enter Start and Stop data point numbers in the entry
(Data Points) fields in order to specify only a limited range to be
button analyzed for each sample.

Data points affect what is displayed in the results.
Normally, you set the analysis range to start after the

primer peak.
Sizing Enter Start and Stop size numbers in the entry fields
drop-down menu: in order to specify only a limited range analyzed for
All Sizes each sample.
Partial Sizes
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Smoothing and The Smoothing and Baselining parameter options help to optimize peak
Baselining Options size and eliminate noise from the baseline.

Item Description
Smoothing Used to help reduce the number of false peaks
option buttons detected by the GeneMapper software.

You have the following options:

Select... | To...

None apply no smoothing.

Select this option if the data has very
sharp, narrow peaks of interest.

Light provide the best results for typical
data.
Heavy apply to data from slower runs that

has very broad peaks, or to avoid
the detection of sharp edges.

Choosing this option might reduce
peak size or eliminate narrow peaks.

Baseline Window Used to automatically adjust the baselines of all
text field detected dye colors to the same level for a better
comparison of relative signal intensity.

Baselining Option

The Baselining option controls the scope of the baseliner. Use this
option to set the size Beta of the Baseline Window. GeneMapper
software computes a baseline for the electropherogram of each dye
independently.

How the Baselining Option Works

A baseline comprises a value at each data point i. Basically, the
baseline value at each data point j, is the lowest electropherogram
value in a window whose width Beta is set using the Baselining option,
and centered at each data point .
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More accurately, the baseline computed in this manner is intermediate.
The real baseline value at each data point j, is the highest intermediate
value, again in a window whose width Beta is set using the Baselining
options and centered at each data point i. GeneMapper software
baselines an electropherogram by subtracting the baseline from the raw

electropherogram

Troubleshooting the Baseline Window

The following table describes what happens if the baseline window is

either too small or too large..

Using...

Causes...

a small baseline window size

the baseline to creep into the peaks,
resulting in shorter peaks in the
analyzed data.

a large baseline window size

the baseline to ride too low, resulting
in elevated and possibly not
baseline-resolved peaks.

Size Calling GeneMapper software uses these methods to determine the molecular

Method Options length of an unknown fragment.

Description of the size calling method parameter options:

Item

Description

2nd Order Least Squares and 3rd
Order Least Squares

Both Least Squares Methods use
regression analysis to build a best-fit
sizecalling curve.

Cubic Spline Interpolation

Forces the sizing curve through all
the known points of the selected size
standard.

Local Southern Method

Determines the sizes of fragments
by using the reciprocal relationship
between fragment length and
mobility.

Global Southern Method

Similar to the Least Squares Method
in that it compensates for standard
fragments that may run
anomalously.
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Peak Detection
Options

The Peak Detection options locate peaks at the positive-to-negative
zero crossings of the first derivative of the baselined electropherogram.
The peak detector computes the first derivative at a data point /by fitting

a polynomial to a window centered on i.

Item

Description

For example

Peak Amplitude

GeneMapper software

If you leave the default

Thresholds reports to the user only | value of 50, peaks with
those peaks whose amplitude above 50 are
heights are at least the | analyzed and display in
Peak Amplitude the tabular data.
Threshold for that dye. Lower amplitude peaks
Set the dye amplitude still display in the
threshold at a level that | electropherogram, but
allows the software to are not analyzed and
detect peaks, but do not display in the
eliminate noise. tabular data.

Full Width Half Defines what If this number is large,

Maximum constitutes a peak. the software ignores

Use to specify the
smallest full width at
half maximum for peak
detection.

The range is 2-99.

A typical number might
be 3 for microsatellites,
or 10 for SSCPs.

noise spikes.

If the peaks in the data
are narrow, set the
value to a low number.

Experiment with this
value to determine the
best number for the
data.
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Item Description For example
Polynomial Degree Sets the degree of the These parameters
polynomial. control the sensitivity of
this process. Sensitivity
Min. Max. increases with the
setting setting polynomial degree and
2 5 decreases with the

Peak Window Size

Sets the width of the
window

Min. setting

Max. setting

1 above the Degree of
Polynomial
differentiation setting.

Number of data points
between peaks

window size.

Use polynomials of
degree 2 or 3 for
well-isolated peaks,
such as those from a
size standard, and a
degree 4 for finer
control.

For degree 4, the Peak
Window Size should be
1 to 2 times the full
width at half maximum
of the peaks that you
wish to detect.

These parameters
cannot be set for each
color independently.

Slope Threshold for
Peak Start

Slope Threshold for
Peak End

Determines where a
peak starts and stops

For example, a peak
ends when the first
derivative again
exceeds the Slope
Threshold for Peak
End.

Slope Threshold for
peak start must be
non-negative and
Slope Threshold for
peak end must be
nonpositive.

Values other than 0 will
move the extent of the
peak toward its center.
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Peak Detection: Polynomial Degree and Peak Window Size

Parameters

About These
Parameters

How These
Parameters Work

How to Use These
Parameters

Use the Polynomial Degree and the Peak Window Size settings to
adjust the sensitivity of the peak detection. You can adjust these
parameters to detect a single base pair difference while minimizing the
detection of shoulder effects or noise.

Sensitivity increases with larger polynomial degree values and smaller
window size values. Conversely, sensitivity decreases with smaller
polynomial degree values and larger window size values.

The peak window size functions with the polynomial degree to set the
sensitivity of peak detection.

The peak detector computes the first derivative of a polynomial curve
fitted to the data within a window that is centered on each data point in
the analysis range.

Using curves with larger polynomial degree values allows the curve to
more closely approximate the signal and, therefore, the peak detector
captures more peak structure in the electropherogram.

The peak window size sets the width (in data points) of the window to
which the polynomial curve is fitted to data. Higher peak window size
values smooth out the polynomial curve, which limits the structure being
detected. Smaller window size values allow a curve to better fit the
underlying data.

Use the table below to adjust the sensitivity of detection.

To Polynomial Window Size
Degree Value Value

Increase sensitivity use... Higher Lower

Decrease sensitivity use... Lower Higher
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Guidelines for To detect well-isolated, base-line-resolved peaks, use polynomial
Using These degree values of 2 or 3. For finer control, use a degree value of 4 or

Parameters dreater.
As a guideline, set the peak window size (in data points) to be about 1

to 2 times the full width at half maximum height of the peaks that you
want to detect.

Examining Peak To examine how GeneMapper software has defined a peak, select
Definitions View > Show Peak Positions. The peak positions, including the
beginning, apex, and end of each peak, are tick-marked in the
electropherogram.
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Effects of Varying The figure below depicts peaks detected with a window size of 15 data
the Polynomial points and a polynomial curve of degree 2 (green); 3 (red); and 4
Degree (black). The diamonds represent a detected peak using the respective
polynomial curves.

Note that the smaller trailing peak is not detected using a degree of 2
(green). As the peak detection window is applied to each data point
across the displayed region, a polynomial curve of degree 2 could not
be fitted to the underlying data to detect its structure.

2000 —

Polynomial curve of degree 4
1500 |- (black)

Polynomial curve of degree 3

(red)
1000
Polynomial curve of degree 2
. (green)

500

Electropherogram showing peaks detected with three different polynomial
degrees
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Effects of
Increasing the
Window Size Value

In the figure below, both polynomial curves have a degree of 3 and the
window size value was increased from 15 (red) to 31(black) data points.

As the cubic polynomial is stretched to fit the data in the larger window
size, the polynomial curve becomes smoother. Note that the structure of
the smaller trailing peak is no longer detected as a distinct peak from
the adjacent larger peak to the right.

2000 —

1500 —

Window size value of 31 (black)

™ Window size value of 15 (red)

500

Electropherogram showing the same peaks as in the figure above (see page
B-21) after increasing the window size value while keeping the polynomial
degree the same
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Optimizing Peak Detection Sensitivity: Example 1

Initial The figure below shows two resolved alleles of known fragment lengths
Electropherogram (that differ by one nucleotide) detected as a single peak. The analysis
was performed using a polynomial degree of 3 and a peak window size
of 19 data points.

BT oo o o sm am o om s on g o sm an e oo s g m gn g s s em s ge s o s

o |

o0 |

a0 |

zoan |

1750 |

1800 |

1290 |

1000 |

5 |

500

250 |

o f s

X v
TyerSameie iees £ ek Fghn | Fesk Aes | Daa Pt
Peak

20G,29 | 1592 186.78 [FE] 24789 22|

Electropherogram showing two resolved alleles detected as a single peak

Note For information on the tick marks displayed in the electropherogram see
Examining Peak Definitions on page B-19.
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Effects of The figure below shows that both alleles are detected after re-analyzing
Decreasing the With the polynomial degree set to 3 while decreasing the window size
Window Size Value Value to 15 (from 19) data points.

BT s oo s s s gm0 s wo gm gw o g mo s en mw s ao m gw o s om g e o o s e

a0 |

500 |

50 |

o0 |

150 |

1500 |

1250 |

1000 |

50 |

E

a0 |

0|

TyelGamvie R Pekiege | Fel | omaren
ek
206,30 500 N e e )
206,31 1562 16078 1953 o4 woa

Electropherogram showing the alleles detected as two peaks after decreasing
the window size value
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Optimizing Peak Detection Sensitivity: Example 2

Initial The figure below shows an analysis performed using a polynomial
Electropherogram degree of 3 and a peak window size of 19 data points.

[ e N I R N R = I

1200 |

1600 |

x -1

Dyelample ‘ Tntes Size Peal Height Peal Area ‘ Data Pairt
Paalc
ELRE| BRG] EEEET] T STE) EE
ErT | XE) 341 a1 5an &58a raas

Electropherogram showing four resolved peaks detected as two peaks
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Effects of The figure below shows the data presented in the figure above (see
Reducing the page B-25) re-analyzed with a window size value of 10 and polynomial
Window Size Value degree value of 5.
and Increasing the
Polynomial Degree
Value ..

[ e A I R L T O I R

1600 |

x .

Dyefsample Mntes Size Peak Height Peak prea Data Foint

E)
337
E<t)
341
342

e [REG) (5
[t a3 1928
1222 oage 1335
age a07. 198
63 203 1953

w
a
28233

B2

Electropherogram showing all four peaks detected after reducing the window
size value and increasing the polynomial degree value
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Optimizing Peak Detection Sensitivity: Example 3

Effects of Extreme The figure below shows the result of an analysis using a peak window
Settings size value set to 10 and a polynomial degree set to 9. This extreme
setting for peak detection led to several peaks being split and detected
as two separate peaks.

[FBY w0 son o9 o0 op o0 on a0 ow g0 40 4w o s e 40 am  ne s 4w on  mn mw

1000 |

1o | byt

B 0
T = Tk v | Femaw | om rom

o

T 5 Rz T T {FE

I AR, a7 17 123, 53 100 1769

= 'AB, 47 25 123, B2 258 1772
1518 s 7 £ o = a7

= 4B, 17 108,85 328, a7 487, 4082
1518 T = i aion e

5] 4B, 19 110 45 333 B2 214 442

Electropherogram showing the result of an analysis using extreme settings for
peak detection
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Peak Detection: Slope Threshold for Peak Start and Slope
Threshold for Peak End Parameters

About These
Parameters

How These
Parameters Work

Guidelines for
Using These
Parameters

Use the Slope Threshold for Peak Start and Slope Threshold for Peak
End parameters to adjust the start and end points of a peak.

This parameter can be used to better position the start and end points
of an asymmetrical peak, or a poorly resolved shouldering peak, to
more accurately reflect the peak position and area.

In general, from left to right, the slope of a peak increases from the
baseline up to the apex. From the apex down to the baseline, the slope
becomes decreasingly negative until it returns to zero at the baseline.

Apex —————(—(———————  — ————— — — — — — —
Increasingly Increasingly
positive negative
slope slope
+)
Baselne - -———"—--—-————————= -

If either of the slope values you have entered exceeds the slope of the
peak being detected, the software overrides your value and reverts to
zero.

As a guideline, use a value of zero for typical or symmetrical peaks.
Select values other than zero to better reflect the beginning and end
points of asymmetrical peaks.

A value of zero will not affect the sizing accuracy or precision for an
asymmetrical peak.
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Using These Use the table below to move the start or end point of a peak.
Parameters

IF you want to move the... THEN change the...

start point of a peak
closer to its apex

Slope Threshold for Peak Start value from
zero to a positive number

end point of a peak
closer to its apex

Slope Threshold for Peak End value
to an increasingly negative number

Note The size of a detected peak is the calculated apex between the start
and end points of a peak and will not change based on your settings.
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Slope Threshold Examples

Initial The initial analysis with a value of 0 for both the Slope Threshold for
Electropherogram Peak Start and the Slope Threshold for Peak End value produced an
asymmetrical peak with a noticeable tail on the right side.

[FBY om om 2 s zw 2o 2w a0 mw me gm0 g e me aw @ mw_ @w aw @0 o

1a00 |

100 |

1400 |

1200 |

1000 |

00 |

eon |

00 |

0 |

0 1

X v I

B | e | e Pk | Team | oo
Peslc
| oo i wser T5m o7z =50

Electropherogram showing an asymmetrical peak
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Electropherogram After re-analyzing with a value of —35.0 for the Slope Threshold for Peak

After Adjustments End, the end point that defines the peak moves closer to its apex,
thereby removing the tailing feature. Note that the only change to
tabular data was the area (peak size and height are unchanged).

B o s xe ze wa s nw e mo om0 o ma we s ma mo oz a0 m m

1200 |

1600 |

x v

Dyz/Sample ‘ Mnutes ‘ Size | Peak Height Peak fr=a Data Point
Peaic
O =vs 1 X2 TTEET ] o0 7250

Electropherogram showing the effect of changing the slope threshold for peak
end
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Size Calling Methods for Classic and Advanced Modes

Overview

Least Square
Method

There are four size calling methods that you can use with the
GeneMapper software v3.0. They are as follows:

¢ Least Square

4 Cubic Spline Interpolation
4 Local Southern

4 Global Southern

Both Least Squares methods (2nd Order and 3rd Order) use regression
analysis to build a best-fit size calling curve. This curve compensates
for any fragments that may run anomalously. As a result, this method
normally results in the least amount of deviation for all the fragments,
including the size standards and the samples.

Depending on whether you choose the 2nd or 3rd Order Least Squares
Method in the Analysis Parameters dialog box, the resulting size curve
is either a quadratic or a cubic function. The software uses the known
standard fragments and the associated data points to produce a sizing
curve based on Multiple Linear Regression.

Advantages

In the figures on page B-33, you can see that in nearly all instances the
mobility of an individual DNA fragment is coincident with the best curve
fit of the entire data set. Stated differently, the mobility of most DNA
fragments is strictly length-dependent. This method automatically
compensates for fragments that run anomalously.

GeneMapper software v3.0 calculates a best-fit least squares curve for
all samples, regardless of the size calling method you choose. The
curve is black in the Standard Sizing Curve window.
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Eest Fit Znd Order Curve
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&

2nd Order Least Squares size calling curve

Note This graph was generated using GeneScan 3.7.1 software. These
results are similar to results obtained when you use GeneMapper software v3.0.

= 11wP2)- 1l = |

Best Fit 3rd Order Curve
250 | AD = - 1.2Z6EE06E+02
141 =+1.608974E-01
hE =-Z.041442E-05
son | 43 =+ 1.887158E-09
R*2=1.000
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50|

Size Calling Curve
3rd Order Lesst Squares

T T T
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T T
2500 2000
Data Point

T T T
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Bl AT

3rd Order Least Squares size calling curve

Note This graph was generated using GeneScan 3.7.1 software. These
results are similar to results obtained when you use GeneMapper software v3.0.
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Cubic Spline By definition, the Cubic Spline method forces the sizing curve through
Interpolation all the known points of the selected size standard. Although this
Method enforement produces exact results for the values of the standards
themselves, it does not compensate for standard fragments that may
run anomalously.

EI=——————————— 1I1*P2}- 11 =[5

Best Fit Znd Order Curve
a0 | A0 =-9.771623E+01

1 41 =+1.220835E-01
42 = -4556885E-06
200 | R°2 = 1.000

250 |

200 |

150

100 |

50

Size Calling Curwve
Cubic Spline Interpolation

T T T T T T T T
1000 1800 2000 2500 2000 2500 4000 4500
Data Point

[EEIEAR [

Note This graph was generated using GeneScan 3.7.1 software. These
results are similar to results obtained when you use GeneMapper software v3.0.

Possible Local Sizing Inaccuracy

Mobility of any DNA fragment can be affected by its sequence, and by
secondary and tertiary structure formation. If any internal size standard
fragment has anomalous mobility, the Cubic Spline method may exhibit
local sizing inaccuracy.

For example: Assume that a standard fragment is close in molecular
length to an unknown sample fragment. Assume further that the
standard fragment runs anomalously. The Cubic Spline method assigns
the official value to this standard fragment, even though it may be
slightly incorrect. The size of the unknown fragment is then likely to be
calculated incorrectly as well.

Note  This method does not determine the amount of sizing accuracy error.
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Local Southern The Local Southern method determines the sizes of fragments by using
Method the reciprocal relationship between fragment length and mobility, as
described by E. M. Southern (1979).

FieE=—————————————— lIsl =———————]I-
270 Best Fit 2nd Order Curve
&40 =-1.990206E+02
&1 =+2.075795E-01
2401 42 = -1.545595E-05
R*z=1.000
210
180 |
150 |
120 |
30
60
Size Calling Curwve
Local Southern Method
30
T T T T T T T T T
1200 1400 1600 12800 2000 2200 2400 2600 2800
Data Point
EIREENE] [

Note This graph was generated using GeneScan 3.7.1 software. These
results are similar to results obtained when you use GeneMapper software v3.0.

The Equation
L = [c¢/(m-mO0)] + LO

The equation attempts to describe the reciprocal relationship between
the mobility, m, and the length, LO, of the standard fragments.
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How This Method Works

This method, which is similar to the Cubic Spline method, uses the four
fragments closest in size to the unknown fragment to determine a best
fit line value. Only the region of the size ladder near the fragment of
unknown length is analyzed.

Note  Size estimates may be off if any of the standard fragments run
anomalously.

The following table lists how the Local Southern method works:

Step | Action

1 The fitting constants of the curve are calculated for each group of
three neighboring points on the standard.

A separate curve is created for each set of three points.

2 A curve is then created by using three standard points (two points
below and one point above the fragment) and a fragment size is
determined.

3 Another curve is created by looking at an additional set of three

points (one point below and two points above the fragment) and
another value is assigned.

4 The two size values are averaged to determine the unknown
fragment length.
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Global Southern
Method

This method is similar to the Least Squares method in that it
compensates for standard fragments that may run anomalously. The
method creates a best-fit line through all the available points, and then
uses values found on that line to calculate the fragment values.

=[O 11=P27-11 BE
Best Fit Znd Order Curve
a0 | A0 =-9.771623E+01
1 41 =+1.220835E-01
42 = -4556885E-06
200 | R°2 = 1.000
280
200 |
150
100
50 |
Size Calling Curwve
o Global Southern Method
I1 ooo I1 00 |2000 I2500 ISDDD ISSDD |4000 I4500
Data Point
|EE i LR [&@

Note This graph was generated using GeneScan 3.7.1 software. These
results are similar to results obtained when you use GeneMapper software v3.0.
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The Equations

The following table describes how the equations work:

Equation Description

L = [¢/(m-mO0)] + LO Attempts to describe the reciprocal
relationship between the mobility, m,
and the length, LO, of the standard
fragments.

2i(Li - (c/(mi-m0) + L0))2 The fitting constants LO, m0, and ¢
are calculated by a least squares fit
to minimize the left side quantity.

How This Method Works

All points in the standard are weighted equally and the curve is not
constrained to go through any specific point. The software can analyze
a large range of fragment sizes with this method.

DNA fragments that are... Are sized using...

not bracketed within the size a second order least squares curve
standard curve extrapolation.

bracketed within the size standard the method that was chosen.

curve

For best results, use a standard that brackets all the fragments of
interest.
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Project Window
Software Interface

Appendix Overview

Introduction This appendix gives detailed descriptions of the features of the ABI
Prism® GeneMapper™ Software Version 3.0 application, including
details of each major application window.

In This Appendix This appendix contains the following topics:

Section See Page
Overview of the Project Window C-2
Project Window Menus C-9
Project Window File Menu Dialog Boxes c-27
Printing Tables and Electropherograms C-34
Add Samples to Project Dialog C-36
Project Window Edit Menu Dialog Boxes C-46
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Overview of the Project Window

Menus and Dialog The Project window has a number of menus and dialog boxes
Boxes associated with it. The drop-down menus available on each window (for
example, File, Edit, View) provide a set of commands specific to the
window. This section will describe the menu commands and dialog
boxes associated with a given window.

Samples View The following information is provided in this section for the Samples

view.
Topic See Page
Appearance of Samples View C-2
Samples View Columns C-3
Samples View Features C-5

Appearance of Samples View

The Samples view of the Project window displays the samples you want
to analyze or have already analyzed. This view looks much like the
following example when sample data has been imported.

@ GeneMapper Project: Miciosatellite Praject

File Edit Analysis W“iew Tools Help

eF e O BB i [l HII b &  Tableseting:  ENEend <3 B & |
= EProject Samples |Genuwpes|
[Linkage " 4
[5NaPsho ‘Status‘sample File ‘Sample MNarne ‘Comments ‘Sample Type ‘Analysws Method ‘Panel ‘S\ze |
‘E ‘h fea ‘2 ‘NDHE ‘Sample ‘SNEPEhDIDEfELI\I ‘NDHE ‘Class
] 3_C Mone Sample SMaPshot Default
10 5_E03 08fsa |5 MNone Sample SMaPshat Default MNone G535
ihl 6_F03_111fsa 6 MNane Sample SMaPshot Default MNane G3al
12 liz_C04_06fsa liz MNone Sample SMaPshat Default MNone G540
< T 3
4 >
Analysis Completed =i

Note You can hide and show columns in the table using Table Setting.
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Samples View Columns
The columns of the Samples view are explained in the table below.

Note The following image is shown with the navigation pane closed.

(@ GeneMapper Praject: Microsatellite Project

File Edit Analysis Wiew Tools Help

cfee @ B HI| B & | TableSefting:  [SMP Defaull @ BS |

Samples |Genmypes|

‘Status‘sample File ‘Sample MNarne ‘Comments ‘Sample Type ‘Analysws Method ‘Panel ‘S\ze Standard ‘M;
1 e 2 2 None Sample 5 hotDefault  Mone
2 3_C03_05fsa 3 MNane Sample SMaPshot Default MNane GE1200Z
3 5_E03 08fsa |5 MNone Sample SMaPshat Default MNone 5350
4 6_F03_111fsa 6 MNane Sample SMaPshot Default MNane G3400
5 liz_C04_06fsa liz MNone Sample SMaPshat Default MNone GS500LIZ
3] [ 01_100301.fsa 100301 MNane Sample Microsatellite Default None GE1200Z P
7 h 02_100405 fga | 100405 MNone Sample Microsatellite Default None GS120L1Z Pi
8 [ 03_100501.fsa 100501 MNane Sample Microsatellite Default None GE1200Z P
g h 04_100302.fga 100302 MNone Sample Microsatellite Default None GS120L1Z Pi
10 05_100406.fsa 100406 MNane Sample Microsatellite Default None 35350 P
" 06_100502 fga | 100502 MNone Sample Microsatellite Default None G5500 Pd~
< | »l
‘Ama\yala Completed e
Samples View Column Descriptions
Column Description
Sample or row From application; used to select a single entire row.
number
Status A |h symbol indicates that the sample needs to

be analyzed or reanalyzed.

Note These symbols indicate status of each
sample, and they control which samples will be
analyzed during the next analysis if the Analyze icon
is selected. There are other analysis options which
ignore the status field.

4 The Status field next to each sample contains the
|!’k symbol prior to analysis. This field is empty
after analysis, if analysis was successful.

4 Resetting parameters such as the Panel, Size
Standard, Sample Type, and the Analysis
Method resets the symbol for a given sample,
enabling reanalysis.

Sample File From sample sheet; not editable.
Sample Name From sample sheet; editable, free text.
Comments Editable, free text.
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Samples View Column Descriptions (continued)

Column

Description

Sample Type

Editable via Sample Type drop-down list box; valid
types are Sample, Control, Allelic Ladder, and
Primer Focus, Negative Control.

Analysis Method

Editable via a drop-down list box. The list is editable
via the Analysis Method Editor in the Analysis
Methods tab in the GeneMapper Manager window.

Panel

Editable via Panel window; Panel window contents
come from Panel Manager.

Size Standard

Editable via a drop-down list box. The list is editable
via the Size Standard Editor in the Size Standards
tab in the GeneMapper Manager window.

Matrix

Editable via a drop-down list box. The list is editable
via the Matrix Editor in the Matrices tab in the
GeneMapper Manager.

For the ABI PRISM® 377 DNA Sequencer and the
ABI PRIsM® 310 Genetic Analyzer instruments, the
matrix file is created in the Matrices Tab in the
GeneMapper Manager window.

Run Name

From sample sheet; not editable.

Instrument Type

From sample sheet; not editable.

Instrument ID

From sample sheet; not editable.

Run Date and Time

From sample sheet; not editable.

REF

Reference data; | % indicates that the selected
sample is defined as reference data in the Panel
Manager.

Sal

Sizing quality invalidated; checkmark indicates that
sizing quality value is 1.0.

User Defined 1-3

Editable free text. Also from the vertical bar enabled
in the sample sheet fields. See Chapter 2, “Using
GeneMapper Software.”

Note Refer to Appendix A for PQV information.
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Samples View Features

Feature Description

Select Row(s) Click the Row Header box; drag to select a
continuous range.

Select Column(s) Click the Column Header box; drag to select a
continuous range.

Resize columns Click and drag between columns to change column
width.

Quick sort column Shift—click the column header to sort ascending;

shift—click again to sort descending.

Deselect Row Ctrl-click the Row Header box
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Genotypes View The Genotypes view, shown below, displays the results of allele calling
analysis. Each row or “record” in the table is a single marker for a
sample. For example, if a panel specified for a sample contains four

markers, the Genotypes table contains four records for that sample

(each in a separate row).

+a GeneMapper Project: Casework Project

File Edit Analysis Miew Tools Help

el BB

il LUl

milE = é

Table Setting

IApphed Binsystemsapplied B = [ | B &

Samples Genowpes|

Sing|e [sample File | Sample Name [Panel [itarker  [Dye [Atlele 1 [alele 2 [size 1 [Size 2 [Height 1]Height [ Peak An Peak n Mutatior | Mutatior [AEH Go [AEH Go (05 [aDo]aEH [BIN
Marker 2 |co_Controlfsa|CO_Control  |COflervd  [D16sa39 (B (11 12 (25338 |267.34 [1487.0 [1577.0 |11898.0[12672.0 []

3 [CO_Conlrolfsa | CO_Control | GOfler w3 |AMEL [0 [% 10341 23830 15110.0 GeneM: ]

4 [CO_Conlrolfsa |CO_Control | GOflervd  [THX (6 [a oL [179.16 |186.15 [1077.0 [1030.0 66950 [6779.0 ]

5 |CO_Conralfsa|CO_Control  COflerva  [TPOX_ [G |8 2230 18230 14283.0 Gene: ]

6 |cO_Conralfsa|CO_Contol (COflervd  |cSFIPO [6 |10 |12 29588 (30451 [12490 [11180 |10362.0[9350.0 ]

7 [co_conmalfsa|co_conmol (coflerva  [p7se2o [v |10 |11 37234 (27628 6780 [7250 [s612.0 [63310 ]

8 [CO_Ladderfsa |CO_Ladder |COflervd  [Dastasg[s |12 |13 [111.35 (11549 [1611.0 [1589.0 [10777.0[10110.0 HES

9 [CO_Ladderfsa CO_Ladder | COflervd  [D165539[8 |5 8 22045 [241.44 [1575.0 [1658.0 11731.0[12512.0 HES

an—opraas L oia " = a0oes 1o s s Ir-

analysis Completed

l

57
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Genotype View Columns

The table in the Genotypes view can display some of the columns in the
Samples view (see table on page C-3), plus these unique columns.

Genotypes View Columns

Column

Description

Marker

Not editable; name of the marker associated
with the record; created in the Panel
Manager.

Dye

From Panel Manager; not editable; indicates
which dye is associated with the marker
(B=blue, G=green, Y=yellow, R=red, or
O=orange).

Note Not used for SNP Genotyping
(SNaPshot® analysis).

Allele 1, 2, etc.

Not directly editable in the table cell; allele
calls are editable only in the plot windows.

The call for Allele 1. Allele calls and names
are defined in the Panel Manager as bin
names. The Allele call text box displays a list
of valid calls plus one of the following:

4 ? (for unknown) for linkage and SNP
(SNaPshot) applications

4 OL (Off-ladder) for Human Identification
(HID) applications

4 blank for no allele calls.

Note When alleles shown in the
Genotypes table are edited in the Plot
window, the allele call in the table also
changes and confidence value indicators in
the table turn to grey triangles.

Size 1, 2, etc.

Peak size for Allele. Not editable.

Height 1, 2, etc.

Peak height for Allele. Not editable.

Peak Area 1 & 2

Peak area for Allele. Not editable.

Mutation

Indicates allele falling within a mutant bin.

AE Comment

Displays last user-edited comment.
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Genotypes View Columns (continued)

Column Description
ADO (Allele Display 4 The box is labeled with an |}( when the
Overflow) number of alleles the marker calls

exceeds the number to display previously
set by the user.

4 The user specifies how many alleles to
display in the Table Settings parameters.
(The default is two.)

¢ There are six columns for each allele to
indicate name, size, height, area,
mutation, and comment.

AE (Allele Edit) 4 The box displays unlabeled immediately
after analysis.

4 The box is labeled with an P when the
marker allele calls have been edited by
the user.

4 The marker allele calls can be edited in
the Plot window. The user can enter
comments in the Allele Edit column while
editing allele calls.

User Defined 1-3 Editable; free text. Also from vertical bar
enabled in sample sheet fields. See
Chapter 2, “Using GeneMapper Software.”

Note Refer to Appendix A for PQV column information.
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Project Window Menus

Introduction The tables in this section describe the following Project Window menus.

Topic See Page
File Menu C-9
Edit Menu C-11
Analysis Menu C-12
View Menu C-14
Tools Menu C-16
Help Menu C-26

Command The commands in the Project Window menu can be activated in two
Activation and Wways:

Special Terms ¢  Clicking the command in the menu, or

4 Using the special key combinations shown to the right of the name
in the menu.

File Menu The commands are described in the table below.

A=W Edit Analysis Wiew Tools

Mew Project... CArl+n
Open Praject... Ctrl+0
Eave Projent Al

Save Project As...

Add Samples to Project... Cirl+l

Export Table... Cirl+E
Print... Cirl+P
Log Cut

Exit Alt+F 4
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Project Window File Menu Commands

ltem Description Enabling
New Project Clears sample files, results, and Always enabled
(Ctrl+N) project name from the Project except when a blank

window, displaying a blank Project.

If previous project has pending
changes, the following alert
message is displayed: Do you
want to save changes? [Yes] [No]
[Cancel]

Project is displayed.

Open Project
(Ctrl+0O)

Displays the Open Project dialog
box.

If previous Project has pending
changes, the following alert
message is displayed: you want to
save changes? [Yes] [No] [Cancel]

Always enabled.

Save Project
(Ctrl+S)

Saves Project to the file named at
the start of analysis.

Named projects are saved to the
GeneMapper database without a
dialog box.

Enabled when the
Project table has
pending changes.

Save Project
As...

Displays the Save dialog box.

Always enabled.

Add Samples | Opens the Add Samples To Always enabled.

To Project Project dialog box.

(Ctrl+1)

Export Table Displays the Export table dialog Enabled when the

(Ctrl+E) box. Project table
Exports table as tab or comma contains data.
delimited text file.

Print Displays the Print dialog box. Enabled when the

(Ctri+P) The standard Print Setup dialog is g;?aed table contains
opened from the Print dialog. '

Log Out Closes the Project window and Always enabled.

displays the Login window.

Displays a Save alert message if
the Project has pending changes.
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Project Window File Menu Commands (continued)

ltem Description Enabling

Exit (Alt+F4) Exits the GeneMapper application; | Always enabled.
displays Save alert message if
Project has pending changes.

Edit Menu The commands in the Edit menu are used to manage the contents of
the Project window by performing standard actions like undo, delete,
select, and by enabling access to settings for Preferences.

=Ll Analysis  Wiews Tools

Delete from Project

Select All Crl+A
Fill Dot Ctrl+0
Find... CArl+F
Sart... Crl+ G

Project Window Edit Menu Commands

ltem Description Enabling

Delete From | Deletes the selected sample(s) Enabled when a

Project from the Project and the database | Project sample is
and displays the following alert selected.
message:

Deleting the selected sample(s)
will delete both samples and
results from project. This action
cannot be undone.

[OK] [Cancel]

Note Each use of the command removes a single run or
sample. If you want to remove all samples and the associated
folder, use the Select All command before using the Delete
from Project command. This action does not delete the actual
sample file or Sequence Collector sample data.

Select All Selects all samples in the active Always enabled.
(Ctrl+A) view.
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Project Window Edit Menu Commands (continued)

ltem Description Enabling
Fill Down Fills the selected column with the Enabled when a
Ctrl+D contents of the first cell. This column is selected or
(Ctri+D) command is applicable only to multiple cells are
Analysis Method, Panel, Size selected.
Standard, and Matrix columns.
Find Displays the Find dialog box. Enabled when the table
(Ctrl+F) contains data.
Sort Displays the Sort dialog box. Enabled when the table
(Ctrl+G) contains data.

Analysis Menu The commands in this menu control analysis and display of the data in
a Project and access to a number of other windows that support the
Project window, such as the Analysis Manager and Panel Manager. The
following table is provided as a reference for the Analysis menu.

Yiew Tools Help

Display Plats Ctri+L
Size Match Editor...
Analyze Ctrl+R

Analyze Selected Samples

Analyze All Ctrl+Shit+R
Analyze Markers...

Analysis Method Editar...

Size Standard Editor...

Bring Errors to Top Cirl+B

Bring Mon-concordant Samples ta Top

Project Window Analysis menu commands:

Item Description Enabling

Display Plot Opens the Plot window. Enabled when one or

(Ctrl+L) more samples or
records are selected.

Size Match Opens the Size Match Editor Enabled only when

Editor window. sized samples are
present in the Project.
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Project Window Analysis menu commands: (continued)

Item Description Enabling
Analyze Analyses all samples eligible for | Enabled when
(Ctrl+R) analysis. The symbol is shown Samples tab is visible
in the Status column. and at least one
sample in the table
requires analysis.
Analyze Analyzes selected samples Enabled when
Selected only. Samples tab is visible.
Samples
Analyze All Analyzes all samples whether Enabled when
(Ctrl+Shift+R) or not the Status column Samples tab is visible.
reports that the sample is
eligible for analysis, including
those previously analyzed. The
following alert message is
displayed: Analyze all samples?
This may change your existing
results. This action cannot be
undone. [OK] [Cancel]
Analyze Analyzes only the marker(s) Enabled when
Markers you select within each sample. Samples tab is visible.
(“Analyze Markers Dialog Box”
on page C-14.)
Analysis Allows the user to change the Enabled when a

Method Editor

settings for analysis.

sample with an
analysis method is
selected.

Size Standard
Editor

Allows the user to edit base pair
and dye settings.

Enabled when one or
more samples or
records are selected.

Low Quality To
Top
(Ctrl+B)

Sorts all Low Quality (SQ or GQ
column) samples or results
records to the top of the table.

Enabled when
analyzed samples are
present in the table.

Non-concordant
Samples to Top

Brings non-concordant samples
to the top of the analysis page.
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Analyze Markers Dialog Box

The Analyze Markers dialog box enables you to select which marker, or
set of markers separated by commas, will be analyzed within each
sample.

tz* Analyze Markers

@ This analysis option is designed for Microsatellite and SMaPshat analyses.
Enter marker names separated by commas:

Ok I Cancell

This option is only enabled when you are in the Project window
Samples tab and samples are present.Does not work with HID
samples.

View Menu The View menu is used to hide/show the Project window navigation
pane and switch between the two Project window tabs. The following
table is provided as a reference for the View menu.

Toaols Help
Samples Ctrl+Shift+1
EEfHES iR FEE T
Sample |nfo Ctrl+F1
Raw Data Ctrl+F2
EFT Data Crl+F 3
| | R =i (1]
R Sl J

Show Mavigatar Ctrl+Shift+M

Project Window View Commands:

ltem Description Enabling

Samples Switches to the Samples tab. Always enabled.
(Ctrl+Shift+1)

Genotypes Switches to the Genotypes tab. Enabled when results
(Ctrl+Shift+2) are present.

Sample Info Switches to the Info tab for the Always enabled.
(Ctrl+F1) selected sample in the project.
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Project Window View Commands: (continued)

ltem Description Enabling
Raw Data Switches to the Raw Data tab Always enabled.
(Ctrl+F2) for the selected sample in the
project.
EPT Data Switches to the EPT tab for the Always enabled.
(Ctrl+F3) selected sample in the project.
Eull View Shows the full view of the Raw Enabled only when
(Ctrl+]) Data or EPT graph. viewing the Raw Data
or EPT Data of a
sample.
Y-Axis Scale Changes Y-axis scale. (See “Y Enabled only when
Axis Scale” on page C-15.) viewing the Raw Data
or EPT Data of a
sample.
Show Switches the navigator pane Always enabled.
Navigator (shows/hides the pane).

(Ctrl+ Shift+N)

Y Axis Scale

The Y Axis Scale option is only enabled when viewing the raw data or
EPT data of a sample file.

Show Mavigator Cirl+Shift+N

# Scale to maximum Y
Scale to...

There are two options:

4 Scale to maximum Y - scales to the maximum Y value for the
selected sample.

4 Scale to - opens a dialog box in which a user can define the value

of the Y axis.

{g# Enter Y-Axis Scale Yalues x|

Minirmurm:

I

Maxirmurm:

js000

Ok I Cancell

Project Window Software Interface C-15

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com




Tools Menu The Tools menu provides access to the GeneMapper Manager, Panel
Manager, and Table Setting Editor applications.

Tools MalEl

Genelapper Manader Ctrl+i

Panel Manager Ctrl+.J

Tahle Sefting Editar...  Ctrl+T

Showe Offsets..

Opfions...
ltem Description Enabling
GeneMapper Opens the GeneMapper Always enabled.

Manager (Ctrl+M) | dialog box. (See
“GeneMapper Manager” on

page 2-11.)
Panel Manager Opens the Panel Manager Always enabled.
(Ctrl+J) dialog box. (See Chapter 4,
“Using Panel Manager.”)
Table Setting Opens the Table Setting Only enabled when
Editor Editor dialog box. (See samples are present.
(Ctrl+T) “Table Settings Editor” on Only allows editing of a
page 6-4.) currently selected
Table Profile.
Show Offsets Displays bin offsets for Always enabled.

selected samples.

Options Opens the Options dialog Always enabled.
box. (See “Options Dialog
Box” on page C-17.)
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Options Dialog Box

The Options dialog box contains several tabs for setting preferences
associated with various software features. The following tabs are
described below:

Topic See Page
Startup Tab: C-17
Add Samples Tab: C-18
Sequence Collector Tab: C-21
Analysis Tab: C-22
Users Tab: C-24

Note Each registered user has his or her own set of preferences. When you
set these options, it only affects the currently logged in user.

Startup Tab:

The Startup tab contains preferences associated with the startup of the

software.

Startup | Add Samples' Seguence Collector' Analysis' Users'

Froject
& Open Blank Praject

" Open Previous Praject

QK Cancel
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Startup Tab Elements

Element Description
Open Blank Project Sets the software so that upon launch, a blank
option button Project window opens.

Open Previous Project | Sets the software so that upon launch, the last
option button Project viewed will open.

Add Samples Tab:

The Add Samples tab contains preferences associated with the adding
of samples.

x|
Startup  Add Samples | Sequence Collectur' Anal\'sis' Users'

When adding new samples, auamatically...
—Set Analysis Method to

(o |Defau|t VIforaII samples.

' Read frcm the Sample.

—Ret Bire Standard tn-

(o IGS4DDHD VI far all szmples.

% Read wom the Sample.
Set 3100377 Matrix to:

L Isdyes Vl far all szmples.

' Read fram the Sample.

~Set Panel to:
ClSelect a Panel far all samples.

& Read from Data collection 'CommentParel fisld' .

Set Sample Type ta:
 |Sample VIforaII samples.

& Read from Data collection Info' fizld.

LCancel
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Add Samples Tab Elements

Element

Description

Set Analysis Method to
drop-down menu and

Read from the Sample
option button

When you add samples, the Analysis Method
property is set to the value in the text box, which
contains the list of analysis methods from the
GeneMapper database.

Set Size Standard to
drop-down menu and

Read from the Sample
option button

When you add samples, set the size standard
property to the value in the text box, which
contains the list of size standards from the
GeneMapper database.

Set 310/377 Matrix to
drop down menu

Read from the Sample
option button

Set the matrix file to the dye you are using or
read from the sample file.

Set Panel to

4 Select a Panel for all
samples option button
and window

4 Read from the Data
collection
‘Comment/Panel field’
option button

When you add samples, the panel for all
samples is set to the value in the text box. When
the option button is selected, the following
choices may be made:

¢ Leave the text alone, which selects the
existing name, or

4 Click the field to present the Select a Panel
window (to select an existing panel)

The Select a Panel window contains the list of
panels from the GeneMapper database.

Set Panel to:

& |Select a Panel for all samples.

" Read from the Sample Sheet 'Sample Comment' field

When you add samples, the panel for all
samples is set to the value in the Sample Sheet
“comment” column.
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Add Samples Tab Elements (continued)

Element

Description

Set Sample Type to
4 Sample type for all

4 Read from Data
collection ‘Info’ field
option button

samples option button
and drop-down menu

When you add samples, the Sample Type for all
samples is set to the value chosen from the
Sample Type drop-down menu, contains
choices for Sample, Control, Allelic Ladder, and
Primer Focus.

When you add samples, the GeneMapper
software does a “best guess” match, comparing
the contents of the field specified in the Sample
type box with the list of sample types (Sample,
Control, Allelic Ladder, Negative Control, and
Primer Focus).

4 If a match is found, then the Sample Type
property for the sample is set to that sample

type.
4 If a match is not found, then the Sample

Type property for the sample is set to
“Sample”

Note The Panel and Sample Type properties accounts for close spellings and
abbreviations as shown in the following table.

Spellings and Abbreviations

Case

Result

or a similar variation.

A sample file field contains
either Control, Ctrl, Crl, Cntrl,

The sample type for the sample is set to
Control.
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Sequence Collector Tab:

The Sequence Collector tab enables access to a single Sequence

Collector.

Dptions

Startup | Add Samples Sequanca Collecter | analysis | Usars |

TestResult:  Not Tested

"Dalabase Connection Test

User Mame:

[ Save

Database:

|
Passward I
[
I

Schema Cwner:

Test Connectian

.| Cancel

Sequence Collector Tab Elements

Element

Description

Test Result

The results returned are Pass or Fail. These results are
displayed by clicking the Test Connection button. If the
Test Connection button has not been pressed, the Test
Result will display Not Tested.

User Name

Registered user name to access Sequence Collector.

Password

Password for the user name to access Sequence
Collector; data entry into this field displays as bullets or
asterisks.

Save
(check box)

Save the Password; when set, the user does not have to
enter a password to get access to Sequence Collector.

Database

Name of the Sequence Collector (Sequence Collector
string); refer to Sequence Collector documentation for
more information.

Schema Owner

The name of the owner who has access to desired
sample collections.

Test Connection
(button)

Tests the connection to the database specified; includes
appropriate error checking per Sequence Collector.
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Analysis Tab:

The Analysis tab contains preferences associated with the analysis of

data.

Stanupl Add Samp\esl Sequence Collector Analysis | Usersl

FAutomatic Analysi

[ Automatically bring errors to the top of the table

- Quiality Metrics Display

" Symhols

© humbers

~Itonly one labelled allele in a genatype, then duplicate the abel

[ Duplicate homozygous alleles

A cancer

Analysis Tab Elements

Element Description
Automatic Analysis When samples are analyzed, the software sorts
group box: the table automatically to bring samples with

errors to the top of the table. Same functionality as

Automatically brings the Bring Errors To Top icon in the Project window.

errors to the top of the
table check box

Quality Metrics Display | Display quality values in project tables as symbols
group box: (green square, yellow triangle, red octagon), or

Symbols button numerical values (0.0, ..., 1.0).

Note If Symbols (default) is chosen, then all
quality values are shown as symbols. If Numbers
is chosen, then only SQ and GQ columns are
shown as numbers; the other result columns are
symbols.

Numbers button
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Analysis Tab Elements (continued)

Element Description

If only one allele is If this option is checked, single alleles will be
labeled in a genotype, displayed in the Genotypes table and in the Plot
then duplicate the label | window as two labels to indicate presumed
group box: homozygotes.

Duplicate homozygous
alleles checkbox
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Users Tab:

The Users tab contains preferences associated with managing
registered users.

Options | x|

startup | Add Samples | Sequence Collector | Anaysis  Users |

| Genemapper User

UserMame |Created On Show
gm 2002-03-281 |

New User. | CHERGE RABeyard
i Cancel

Note Once created, user names cannot be deleted.

Users Tab Elements

Element Description

User Name field Displays the list of registered users.
4 User Name column = Name of the user
4 Created On column = Date user was created

4 Show column = Shows the user in User Name
drop-down menu of the login window, if checked.
Clearing a Show column check box for a user blocks
login for that user (can be done by anyone running
GeneMapper software).

Shift—click the column label headers to sort the list by
that column.
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Users Tab Elements (continued)

Element Description

New User button | Opens the New User dialog box.

G MNew User E

Mew user name: I
Fassword: I
Confirm Password: I

W Cancel

To add a user name for GeneMapper software, click New
User to open a dialog box and then:

1. Type a user name into the dialog box.

2. Enter a password using only alphabetic
characters.

3. Confirm the password.

4. Click OK to assign the user name and close the
dialog.

When you select this user name on launching

GeneMapper software, the name is used to identify

the preferences set by the user.

Note User names must be unique. If the new user
name is not unique, an alert message will be displayed.

Note Users added here are for this GeneMapper
software installation and is visible to all other users. The
names are converted to lower case and passwords are
not case sensitive.
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Users Tab Elements (continued)

Element Description
Change Opens the Change Password dialog box, and allows you
Password to change the password for the selected user.

Change password for user gm

Password: I
Confirm Password: I

Help Menu The Help menu provides access to online help and to the About
GeneMapper software window.

GeneMapper Help  F1
About GeneMapper

Project Window Help Menu Commands

ltem Description Enabling
GeneMapper Help | Opens the GeneMapper User Always enabled.
(F1) Manual PDF file using Acrobat

Reader.

Does not open the tutorial guides.

About Opens the About GeneMapper Always enabled.
GeneMapper window and displays the software
version.
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Project Window File Menu Dialog Boxes

Introduction The following dialog boxes are accessed from the Project window File
menu. This section describes each of the dialog boxes.

Note This section contains information on all application dialog boxes except
for the “Add Samples to Project” dialog box, which is covered under its own
section (See “Add Samples to Project Dialog” on page C-36).

Save Dialog Box The Save dialog box, accessed from the New Project window, is
presented when a project already exists in the Project window, and
provides you with the option of saving the project.

t Save Project

@ Froject narme:

(0] 4 Cancel
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Open Project The Open Project dialog box displays the list of projects in the
Dialog Box database. You use the first field to find a project quickly, then click the
Open button to open the selected project (or double-click the project

name).

1. Type the first few letters of the project you are looking far.

2. Belectthe project you want, then click Open.

Last Saved

Microsatellite Project 200

Froject #of Samples

2 Caszework Project 2002-06-0514:58:55

3 Caszework Project 06| 2002-06-0515:22:29 8
4 HID Casework 06260 2002-08-01 15:33:47|GM 3
5 Matahase Proisrt FNN7-N7-N1 NE1 740 5k 4

Open | Cancel |

Note Once you have opened a Project window, you may resize it horizontally
and vertically to increase the width and depth of the Project table.
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The following table describes the Open Project dialog box window

elements.

Open Project Window Elements

Element

Description

Search field

Typing in this field selects the first item in the project
list whose nhame matches the characters.

Project table

Lists all the projects in the database.
4+ Project = Name of the project.

4 Last Saved = Date and time stamp of when the
project was last modified.

4 Owner = Name of the user who created the project.

4 # of Samples = the number of samples in the
project.

Note Columns may not be moved or hidden. You
may resize the width of the columns by dragging
between the column headers. Only one row in the table
may be selected at a time. You may navigate up and
down in the table using arrow keys.

Shift-clicking a column header sorts the data by that
column.

Open

Opens the selected project. If previous project has
pending changes, the following alert message is
displayed before the Open Project dialog box opens:
Do you want to save changes? [Yes] [No] [Cancel]

Cancel

Closes the Project Manager dialog box.
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Save Project and The Save Project and Save boxes enable you to save projects to the
Save Dialog Boxes database. The first dialog box is presented for the Save command if you
want to save a project before it is analyzed. Using Save after analysis
does not require a dialog box because you are required to name a
Project before analysis.

& Save Project

@ Froject narme:

Ok I Cancell

The Save dialog box opens when you select the Save As command.

Save

Project name:

ErAE | Don't Save Cancel

The elements of these dialog boxes are described in the table below.

Save Project Elements

Element Description

Project name Text field for the name of the project; accepts
alphanumeric characters.

The database requires standard Windows interface
restrictions on length and symbol characters.

OK Saves the project to the database.

Saved projects are tagged with the Project Name,
User Name, and Time/Date Stamp. If the name you
entered already exists, an alert message is displayed.

Cancel closes the alert dialog and displays the Save
Project dialog box again.

Cancel Closes the dialog box and does not save the project.
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Save Project Elements (continued)

Element Description

Save Saves the project under the name entered in the dialog
box.

Don’'t Save Aborts the Save action.

Export Table The Export Table dialog box allows you to choose where to save the
Dialog Box exported file.

The file types supported include:
¢ Tab-delimited text (.txt)
4 Comma-separated values (.csv)

Note Export operates on the currently-displayed tab. For example, if the
Samples tab is displayed, Export would export the tab-delimited data shown in
the Samples table. Exported data includes column headers.

& Export Table
Laoaokin _4 DAGhdistributionExamples
|| PanelCats
|| SampleFiles
5 File name | Exportiatie
6 Ehowfiles oftype |AII Files (** LI Cancel
Export file as: [Tab-delimited text () | =l
8 J
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Export Table Callouts

Item | Name Description
1 Toolbar These icons are used as follows:
- Clicking moves display up one level in
main pane.
| - Clicking moves display to “Home” level in
main pane. This is usually
“Profiles\<user>".
Eﬁl - Clicking creates a new folder at the
present directory level.
Bl - Clicking presents a list of the contents of
the selected folder.
- Clicking presents details of the selected
folder.
2 Drop-down Select drive letter and/or folder.
directory menu
3 Folder/file The contents of the drive/directory are selected
display pane in the toolbar and the directory menu is displayed
here.
4 Export Table This button exports the selected table.
button
5 File name field | Enter a file name to use for exported table.
6 Show files of This is a display filter for files (folders are always
type field shown). Allows specification of file extension.
Filters files for display in all files, .txt files, .csv
files, .txt&.csv.
7 Cancel button | Closes the Export Table window without
exporting a table.
8 Export file as Select the format of the file you want to export.
field

Note Exported text tables show PQV’s as numbers even if they are displayed
as symbols.
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Print Dialog Box The Print dialog box, shown below, is a print file dialog box that controls
printing. The Samples table, the Genotypes table, Panel Manager
views, and plot windows may be printed.

Print K

— Printer
Froperties |

Marne: WA O SEMNEYCYMinpaFCl

Status: Feady

Type: HF Lazerlet 8100 Seriez PCL B

Where:  minya

Comment. Black & White Printer -- Cubicle across from the Ki [ Print ta file

— Print range Copies

“a MHumber of copies: I'I 3:
€ Fages from) |
€] Selection @ [ Callate

Ok I Cancel |

The dialog box above contains the following items used for printing:

Item Description

Properties Presents the dialog box used to set up the printer.
button

Name field Shows the currently selected printer.

Note The drop-down menu to the right allows selection
of other available printers.

Status Indicates status of selected printer.

Type Shows type of printer.

Where Shows the path name of the selected printer.

Comment Check box enables printing the project to a file.

Page range Allis the only option available when working with tables.
Number of Select the number of copies to print.

Copies

Collate options Check box enables collating of copies.
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Printing Tables and Electropherograms

Introduction All tables and electropherograms can be printed as what-you-see-is-
what-you-get (WYSIWYG), except for these conditions:

4 Only the number of columns shown in the table printout below are
printed out on a single sheet of paper in the Portrait mode.
Additional columns to the right are printed out on additional sheets
of paper. Change to the Landscape mode to minimize the number
of sheets of paper used.

Note To reduce the number of sheets of paper printed for a table, hide
columns you do not want to print using the Table Settings Editor.

4 Printed plots are sized vertically to fill a single sheet of paper:

—  With four plots, the plots are sized close to the same size as the
default size on your monitor.

— Six plot panes are a practical limit for a single sheet.

Examples Table Printout

ABI PRISM® GeneMapper 3.0(TM) SNP - Samples Aug 20,2002 11:43:25 AM
StatusSampIe Eil-e“ e ;.S.arﬁ“pule Name ;wacW).mments Sample Typkg’

T SNP5DyeC132  SNP5Dye None Sample

2 SNP5DyeC132 | SNP5Dye None |Sample

3 SNP5DyeC132 |SNP5Dye  |None Sample

4 SNP5DyeC132 SNP5Dye  |None  |Sample

5 SNP5DyeC132 | SNP5Dye None Sample

EE 'SNP5DyeC132_ |SNP5Dye  |None  Sample

7 | SNP5DyeC132 [SNPS5Dye  |None  |Sample

8 'SNP5DyeC132 | SNP5Dye None 'Sample

9 \SNP5DyeC132 |[SNP5Dye  |None  |Sample

Note Additional pages are created to accommodate the number of rows in the
table. Each additional page that continues the table to the right would have the
same row numbers as shown in the left column.
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Plot Printout

ABI PRISM® GeneMapper 3.0(TM: Mixed

Tue Aug 20 13:53:57 PDT 2002

Sample File | Sample Name | Panel [0S |sQ . .
| ssrment pisss O (H @ EE R B @ B JEE e e e os
T = mE ]
%, 8. N o Wl e e i e 06 0t 0n 2 e e
o (\A il
3 i |
| |
288 ‘ .
115 A\ / [\A
i faa) L i
T
lal§ {al 101

120 131 133 136 137 139 141

e | e T =
0 C06.fsa z% . iSe!-l]S_PsnelUl pisvss | | f' ;E E 07
DIS2I8S . : .
160 162 164 166 168 170 172 174 176 178 180 182 184 186 188 190 192 134 196 198
20 t—t : +
178
127
51
ik -
e lem Jmm [p o me e e o Lo b |
o] W B (W E (RN (E (A [ e
21 m . a m 281 283 25 287 29 <] 23 2%
- . /\ .
350 | |
250 \ ¢
\ -
0 = r\«___/\_J : \u i
ol 264
gm Page 1of 1

Note The number of plots per page is set by the Panes dialog box in the Plots
window. The example above was scaled down vertically and would be printed
on the whole height of the page on a printer.

Project Window Software Interface C-35

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Add Samples to Project Dialog

Introduction This section provides general information about:
4 the Add Samples to Project dialog
¢ the Edit and View menus available in the window
4 using the three tabs in the window.

This following topics are covered in this section.

Topic See Page
General Information and Procedure C-36
Edit Menu C-37
View Menu C-39
Files Tab C-40
GM Database Tab C-41
Sequence Collector Tab C-44

General The Add Samples to Project window provides a navigation pane to
Information and €nable you to add Samples to the project. You can also access the
Procedure dialog box by clicking the Add Sample icon on the Project window
toolbar.

w Add Samples to Project =]

Edit View

Files | Gl Database' SEOUERCE Collector' ~Samples Tao Add:
E|_| Linkage ;I
01_100301 f=a
02_100405 fsa
03_100501 f=a
04_100302 fza J
05_100406 fsa
06_100502 f=a
07_100305 f=5a
(=) _4 ShaPshat =

Add To List == |

Cleall addl did: §Ana|yze| Eancell
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To add samples to the Project:

Step

Action

1

Click @| (Add Samples To Project) on the Project window toolbar.

Add Samples to Project window opens to the last tab viewed by the
user (default is Files tab).

Sample files can reside on the local hard drive(s), mapped network
drive(s), and removable media drives.

If Sequence Collector is configured and you are logged into
Sequence Collector, the Sequence Collector tab is enabled.

In Files tab, navigate to folder containing sample files. Select the
folder, then click the Add to List button.

Folder is added to the Samples To Add field. Individual samples
within a folder can be selected and added. Selecting the folder adds
all samples.

Click the Add button.

Add Samples to Project window closes and the project window
becomes visible. Samples are added to the bottom of the Project
window table.

Edit Menu The commands in the Edit menu of the Add Samples window are used
to manage the contents of the window. The commands are described in
the table below.

Edit B
el EniAll 0 i e
Add Samples o List Ctrl+D
0] == [e(ete
Clear All J
Opfions...

Add Sample Files Edit Menu Commands

ltem Description Enabling

Select All Selects all the items of a given Enabled when a single

(Ctrl+A) type. valid selection has
been made (e.g.,
sample file).
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Add Sample Files Edit Menu Commands (continued)

Item

Description

Enabling

Add
Samples to
List
(Ctrl+D)

Adds the selected item(s) from the
Files, GeneMapper database, or
Sequence Collector to the
Samples to Add list.

Enabled when a
sample file or folder
with files in the Files,
GeneMapper
database, or Sequence
Collector is selected.

Clear
(Delete)

Clears (deletes) the selected
item(s) in the Samples to Add list.

Enabled when a valid
selection is made.

Clear All

Hierarchical menu. Clears all
sample files and folders from the
specified field:

4 Samples to add
¢ Criteria

Note The Criteria subcommand
functions in the GeneMapper
Database tab but not in the Files
tab and is used to clear all search
criteria from the Criteria Selector
List (see the figure on page C-41).

If undo is not possible, the
following alert message is
displayed: Clear all items? You
cannot undo this action. [Yes] [No]
[Cancel]

Enabled when the field
is present and an item
exists in that field.

Options

Opens the Options dialog box in
the Add Samples tab.

Always enabled.

C-38 Project Window Software Interface

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com




View Menu The View menu of the Add Samples window is used to switch between
the three sources for samples and refresh the file directory. The
commands are described in the table below.

Files

GM Database

Ctrl+1
Ctrl+2

SEHUERER ol Bor

Add Samples View Menu Commands

Item

Description

Enabling

Files
(Ctrl+1)

Opens the Files tab.

Always enabled.

GM
Database
(Ctrl+2)

Opens the GeneMapper
Database tab.

Always enabled.

Sequence
Collector
(Ctrl+3)

Opens the Sequence
Collector tab.

Enabled and visible if
Sequence Collector is
configured and you are logged
into Sequence Collector.

Configured through the
Options menu.
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Files Tab The Files tab enables you to choose sample files from local or mapped
networked storage devices.

Files pane — Samples To Add pane —
T ——— . D

Edit View

F\Iesl Gl Database| EEfEnte CollE: tnr| ~Samples To Add:

b ) _uninst3 d

app

) Database

e ] dacs

-] Examples
4] PanelData
{ ie[0) AmpFLSTR Panels_v3

Ly |

__| SampleFiles

1 JRE

(-] GMdistribution

B[] 1386

B[] OracleGh

- | RECYCLER

=131

FH-EFA -

Add To List ==

el e N Eancall

Add Samples to Project Window Elements

Element Description

Files pane Contains the directory structure configured for the
computer running GeneMapper software.
The navigation pane provides a tree viewer that works
like the MS Windows Explorer interface. You can use
Shift—click for continuous multiple selection and
Ctrl—click for discontinuous multiple selections within a
folder.

Samples To Add Contains the folders and files that the system will add.

pane This field also uses the tree viewer interface. You can
use Shift—click and Ctrl—click as described above.

Add To List Adds the selected items from the files pane to the

button Sample to Add field.

Options button Opens the Options window.

Clear button Clears the selected files from the Samples To Add
pane.

Add button Adds the Samples To Add list into the Project window.

Cancel button Closes the Add Samples to Project dialog box.
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GM Database Tab The GM (GeneMapper) Database tab enables you to choose sample
files that have previously been added into a GeneMapper project. This
database uses a search interface to extract samples that match your

criteria.
_Criteria Selector list Samples To Add pane __

Search Criteria Table

(52 Add Samples to Project [x]
Edit ¥iew
|| Files &M Database | iexerie Colerir | Garmples To Add
Search Criteria
: )
~||Field Condition | Criteria
Project Project Name |slans with =
Sample Froject Create Date is
Analysis =
Genotypes = Project Modification Date |jg =
I Searoh Results Cancel || Search .‘

Add To List >
| Ciesn| B EAEEERE =] Eancel

Freferences.

This feature allows mixing and matching sample files. For example, you
can merge sample files from a number of small projects into a single

large project.
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GM Database Search Rules

Criteria and

Rules Description

Search criteria This list and table contains the search criteria from
which to extract samples from the GeneMapper
database.

Note Locations of the list and table are pointed out in
the figure on the previous page.

4 Criteria selector list = list of properties (columns in
the project window) grouped by topic.

¢ Field column = Text field that contains the
properties (columns) in the selected group criterion.

4 Condition column = Combo box that contains
conditions that the system will use to search for
samples. Search rules include:

—Is
— Contains
— Starts With

— Date criteria - Presents a calendar widget to
specify the date

4 Criteria column = Field for specifying the text string
associated with the search rules which are case
sensitive.

Rules for Search Criteria accumulate as they are entered in different
criteria rows and to different groups of criteria.

Multiple items in the search criteria list use the natural
language “and” for searching. For example, the natural
language of the Criteria field is: “Display samples
whose Panel property contains “XXX” and display
samples whose Collection Instrument property
contains “YYY””
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GM Database Tab Elements

Element

Description

Search Criteria
Cancel button

Enabled when a search is in progress; search stops
when clicked.

Note You may not stop the search during data
transfer from the GeneMapper database.

Search button

Searches the database using the criteria list and
displays the search results in the Search Results field.

Search Results
field

Displays the results of the database search (sample
files).

Add To List button

Adds the selected items from the Results field to the
Samples to Add field.

Samples To Add
field

Contains the folders and files that the system will add.
This field uses the tree viewer interface.

Options button

Opens the Options window.

Clear button

Clears the selected files from the Samples To Add field.

Add button

Adds the Samples to Add list into the Project window.

Cancel button

Closes the Add Samples to Project dialog box.
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Sequence Collector The Sequence Collector tab enables you to choose sample files that
Tab are stored in a Sequence Collector. The tab uses a search interface to
extract samples that match your criteria. The Sequence Collector tab
opens only when a connection to Sequence Collector exists.

@Add Samples to Project ll
Edit  View

Files | GM Database Seguence Collectorl ~Samples To Add:

Search Criteria
Field Condition | Criteria

Collection Creatar Starts With i’
Collection Name Starts With

PRI El

Search Results Capcel I Search I |

Add To List == |

Cleall addl did: §Ana|yze| Eancell

The following table describes elements of the Sequence Collector tab.

Sequence Collector Tab Elements

Element Description

Search Criteria This table contains the search criteria from which to
extract samples from the Sequence Collector.

¢ Field column = Text field that contains the
properties (columns) in the selected group criterion.

4 Condition column = Field that contains conditions
that the system will use to search for samples.
Search rules include:

— Starts With
— Contains
— Equals

— Date criteria - Presents a calendar widget to
specify the date

¢ Criteria column = Field for specifying the text string
associated with the search rules which are case
sensitive.
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Sequence Collector Tab Elements (continued)

Element

Description

Rules for Search
Criteria

Criteria accumulate as they are entered by the user.

Multiple items in the search criteria list use the natural
language “and” for searching. For example, the natural
language of the Criteria field is: “Display samples
whose Panel property contains “XXX” and display
samples whose Collection Instrument property
contains “YYY””

Search Criteria
Cancel button

Enabled when a search is in progress; the search stops
when clicked.

Note May not stop the search during data transfer
from the GeneMapper database.

Search button

Searches the database using the criteria list and
displays the search results in the Search Results field.

Search Results

Displays the results of the database search (sample
files). Columns in the table include Sample File plus
others to match the fields specified in the search
criteria.

Add To List button

Adds the selected items from the Results field to the
Samples To Add field.

Samples To Add
field

Contains the folders and files that the system will add.
This field uses the tree viewer interface.

Options button

Opens the Options window.

Clear button

Clears the selected files from the Samples To Add field.

Add button

Adds the Samples To Add list into the Project window.

Cancel button

Closes the Add Samples to Project window.
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Project Window Edit Menu Dialog Boxes

Find Dialog Box The elements of the Find dialog box is described below.

Find [ x|

Find what; | |

In column | Sample File Hame it |

Find Hext | | Find Al | | Close |

Project Window Find Elements

Element Description

Find what Field containing the search string.

In column List box containing the names of columns in the table.

Find Next Finds the next instance of the search string in the
specified column and selects it.

Find All Finds and selects all rows in the table that contain the
search string in the specified column.

Close Closes the Find dialog box. Table selections remain
intact.
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Sort Dialog Box The Sort dialog box, shown below, allows sorting of sample files,
results, etc., by ascending or descending order in up to three steps.

g Sort
Sort by

. ® Ascending
[ Sample File - |

_} Descending

Then by
. ® Ascending
[ Sample File hill )
_} Descending
Then by
. ® Ascending
[ Sample File - |

_} Descending

| K H Cancel |

The Sort dialog box has three entry fields for entering sort criteria (the
“Then by” fields allow successive sorting by two other criteria).

Project Window Sort Elements

Element Description

Sort by Sort box containing the column which will be sorted.
(Then by)

Ascending Option buttons for choosing if the sort is ascending or
and descending in alphabetical/numerical order.
Descending

buttons

OK button Closes the Sort dialog box and performs the sort.
Cancel Closes the Sort dialog box. Does not perform the sort.
button
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GeneScan Size
Standards

Appendix Overview

Introduction The ABI Prism® GeneMapper™ Software Version 3.0 comes with
several ready-to-use GeneScan® size standard definition files that you
can choose from to analyze fragments run on ABI PRISM® genetic
analyzers.

The following table lists the ready-to-use size standards stored in the
GeneMapper database.

If using size standard... Select this...
GeneScan™ 120 LIZ® GS120LIz
GeneScan™ 400HD GS400HD
GeneScan™ 500 GS500
GeneScan™ 500(-250) GS500(-250)
GeneScan™ 500 LIZ® GS500LIZ
GeneScan™ 500(-250) LIZ® GS500(-250)LIZ

Note The GeneScan™ 350 size standard is not automatically stored in the
database; however, it is provided in the GeneMapper > Size Standards folder for
import.

In This Appendix This appendix contains the following topics:

Topic See Page
GeneScan 120 Size Standard D-2
GeneScan 350 Size Standard D-3
GeneScan 400HD Size Standard D-4
GeneScan 500 and GeneScan 500(-250) Size Standards D-6

GeneScan Size Standards D-1
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GeneScan 120 Size Standard

About This Size The GeneScan™ 120 Size Standard is useful for sizing fragments
Standard between 15 and 120 base pairs. It is used when analyzing SNaPshot®
samples.

How It Is Prepared All aspects of the preparation of the GeneScan-120 LIZ size standard
are proprietary. Each fragment contains a single LIZ fluorophore.

GeneScan 120 The following table lists the GeneScan-120 LIZ denatured molecular
Molecular Lengths fragment lengths (nucleotides) for the nine fragments.

Fragment Fragment
Length Length
15 62
20 80
25 110
35 120

50

Electropherogram The following screen shows an electropherogram of GeneScan-120 LIZ
of GeneScan 120 run under denaturing conditions.

iz Size Match Editor %]
Edit Wiew
x B ® |
~Size Standard:
Size Match Quality=1.0
1399 25 a0 110
20 a0 &2 120

1049 15 35

699

349

0

243 2592 2748 2304 306D 26 3372 3528 3684 3340 393
Ok Cancel | Lpply, |
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GeneScan 350 Size Standard

About This Size The GeneScan™ 350 Size Standard is useful for sizing fragments
Standard between 35 and 350 base pairs. The native fragments are uniformly
spaced to provide accurate size calling.

How It Is Prepared The GeneScan 350 Size Standard is prepared by Pstl digestion of
plasmid DNA, followed by ligation of a TAMRA™ or ROX™-labeled
22-mer oligodeoxynucleotide to the cut ends. A subsequent enzymatic
digestion with BstUl yields DNA fragments containing a single TAMRA
or ROX dye (See “GeneScan 350 Molecular Lengths” below).

GeneScan 350 The following table lists the GeneScan 350 Denatured Fragment
Molecular Lengths Molecular Lengths (Nucleotides) for the 12 fragments.

Fragment Fragment Fragment
Length Length Length
35 139 250
50 150 300
75 160 340
100 200 350

Electropherogram The following screen shows an electropherogram of GeneScan 350 run
of GeneScan 350 under denaturing conditions.

g Size Match Editor

Edit View
&

/[ Size Standard:

Size Match Quality = 0.99

3000

200 340 350
150 180 200 =0
139

2000- 75 00
Ly
£
1000 i
o

9235 o485 o695 295 B155 9985 W15 3845 DPS 4305 4535 A7RS 4935 SRS 4S5 %885 5915 G145 B35 6605

oK Cancel
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GeneScan 400HD Size Standard

About This Size The GeneScan™ 400HD (High Density) Size Standard is used to
Standard determine fragment lengths between 50 and 400 base pairs.

Special Uses The high density of marker bands in this standard makes it particularly
useful for microsatellite analysis. All fragments have been checked for
migration that is true to size under a wide variety of run conditions on all
ABI PRISM® instruments.

How It Is Prepared All aspects of the preparation of the GeneScan 400HD Size Standard
are proprietary. Each fragment contains a single ROX fluorophore.

Fragment Lengths The following table lists the lengths of the 21 fragments that make up
the GeneScan 400HD Size Standard.

Fragment Fragment Fragment
Length Length Length
50 180 290
60 190 300
90 200 320
100 220 340
120 240 360
150 260 380
160 280 400

Denaturing Although the GeneScan 400HD Size Standard is made of
Electropherogram double-stranded DNA fragments, only one of the strands is labeled.
Consequently, even if the two strands migrate at different rates under
denaturing conditions you will not need to worry about peak splitting.
The following figure shows the peak patterns of GeneScan 400HD
fragments run under denaturing conditions. Fragments were run using
the 3700 POP-6™ polymer at 60 °C.
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Electropherogram The following screen shows an electropherogram of GeneScan 400HD.
Of Genescan v Size Match Editor

400HD e view

L[]

rSize Standard;

Size Match Quality= 1.0
2300

5 0 190 0 P 280 200 300 /0 380
50 19 2 240 0 30

0 160 200 2 60

0

400
4100-

2836 3094 33 10 3860

426 434 dee2 400 S8 5416 S6F4 Sz B190 G4d8  BT0E

B34 7202 B0

oK Cancel Apply
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GeneScan 500 and GeneScan 500(-250) Size Standards

About These Size
Standards

How It Is Prepared

GeneScan 500
Molecular Lengths

The GeneScan™ 500, the GeneScan™ 500 LIZ®, the GeneScan™
500(-250), and the GeneScan™ 500(-250) LIZ® Size Standards are
useful for sizing fragments between 35 and 500 base pairs. The native
fragments are uniformly spaced to provide accurate base calling.

The GeneScan 500(-250) contains all of the fragments in the GS 500
Size Standard except for the 250 bp fragment. Since it is identical in
other respects, it is not discussed separately in this section.

The GeneScan 500 all Size Standard is prepared by Pstl digestion of
plasmid DNA, followed by ligation of a LIZ or ROX-labeled 22-mer
oligodeoxynucleotide to the cut ends. A subsequent enzymatic
digestion with BstUl yields DNA fragments containing a single ROX or
LIZ dye (see “GeneScan 500 Molecular Lengths” below).

The following table lists the GeneScan 500 denatured fragment
molecular lengths (nucleotides) for the 16 fragments.

Fragment Fragment Fragment
Length Length Length
35 160 400
50 200 450
75 250 490
100 300 500
139 340
150 350
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Electropherogram The screen below shows an electropherogram of GeneScan 500 run

of GeneScan 500 under denaturing conditions.

i@ Size Match Editor

Edit View

]

Size Standard:

Size Match Quality = 0.98

000-

2000-
5

1000 A

2

S

200
200 200

L]

a1z sz28 5544 %D BAVE

6432 G0 7Iz4 A FTSE  BOT2  gams G704
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Sample File
Conversion

Appendix Overview

Introduction This appendix describes how to use sample file conversion programs to
prepare Macintosh® computer-generated fragment analysis sample
files for transfer to a Microsoft® Windows®-based format and vice versa.

In This Appendix This appendix contains the following topic:

Topic See Page

Converting Macintosh Sample Files E-2

Sample File Conversion E-1
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Converting Macintosh Sample Files

About Converting Applied Biosystems created two conversion programs that prepare
Sample Files sample files for transfer from a Macintosh computer to computers
running Microsoft Windows NT operating systems, and vice versa.
These sample file conversion programs run only on a Macintosh
computer.

The sample file conversion programs do not perform the file transfer
from computer to computer. They set attributes of the files so that they
can be used on the destination computer. For example, when
transferring a fragment analysis sample file from a Macintosh computer
to a computer running the Windows operating system, a file extension is
required and the conversion program adds .fsa to the sample file name.
For more detailed information on how these conversion programs
function, refer to the SimpleText file entitled “About Conversion
Programs” located in the same folder as the sample file conversion
programs.

Installing To install the sample file conversion programs on a Macintosh
Conversion computer:
Programs

Step | Action

1 Insert the GeneMapper software CD-ROM into your Macintosh
computer's CD-ROM drive.

An icon displays for the CD-ROM on the right-hand side of the
screen.

2 Double-click the CD-ROM icon.

A CD-ROM window displays containing files and folders.
3 Locate and double-click the CONVFOLD folder.

Inside this folder are two files, CONVPROG.HQX and
README.TXT, which contain the installation instructions.

4 Copy the CONVPROG.HQX file to your local hard drive by clicking
on the file, dragging the file over to the local hard drive icon, and
dropping it in.

5 Decompress the CONVPROG.HQX file by dragging and dropping it
onto a program called “Stuffit Expander.”

Note You can download a free version of Stuffit Expander from
http://www.stuffit.com/expander.

E-2 Sample File Conversion
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Note Decompressing the CONVPROG.HQX file creates a folder on the local
hard drive. This folder contains the conversion programs and the SimpleText file
“About Conversion Programs.” This file is a seven-page document that
describes in detail how to use the conversion programs, why they are
necessary, solutions to common problems, and possible alternative programs.

Converting To convert Macintosh computer sample files for use on a computer
Macintosh Sample running Microsoft Windows operating system:

Files to Micosoft

Windows Files

Step | Action

1 Double-click the (Sample File Mac to Win) to start
the program.

Sample File Win to Mac

The following dialog box opens.

[QApnleTest i]

Date Modified

I» a Hard Disk ToolKit™ 12/17/98
- m parent Today
3 - W contains wi iles Today =
[ u rest of System stuff 12/11499
3 SequencmgAna\ysis 341 5/17/00 .y
I @i System Folder 12/11/99 [+
Where are the files to convert to Windows format?
[ New [ ] ” Open ]| [ Cancel ] [ Choose ]

Note On Macintosh computers running operating system 8.0 or
less, this dialog box has a different appearance. For more
information, refer to the SimpleText file “About Conversion
Programs” mentioned above in “Installing Conversion Programs.”

2 Using the triangle-shaped icons to the left of the folder names,
navigate to the folder that contains the fragment analysis sample
files you want to convert .

Sample File Conversion E-3
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To convert Macintosh computer sample files for use on a computer
running Microsoft Windows operating system: (continued)

Step | Action

3 Select the folder by single-clicking its name.

4 Click the Choose button at the bottom of the dialog box.

If there are no problems, the program performs the task and quits
automatically. When you open the folder, the sample files have the
file extension .fsa.

Note To convert sample files created on a computer running the
Microsoft Windows operating system for use on a Macintosh
computer, follow steps 1-3 above; in Step 1, double-click the
Sample File Win to Mac icon.

E-4 Sample File Conversion
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Software Warranty
Information

Appendix Overview

Introduction This appendix describes the software warranty provided by Applied
Biosystems for the ABI PRISM® GeneMapper™ Software Version 3.0.

In This Appendix This appendix contains the following topics:

Topic See Page
Computer Configuration F-2
Limited Product Warranty F-3

Software Warranty Information F-1
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Computer Configuration

Configuration Applied Biosystems supplies or recommends certain configurations of
computer hardware, software, and peripherals for use with its
instrumentation. Applied Biosystems reserves the right to decline
support for or impose extra charges for supporting nonstandard
computer configurations or components that have not been supplied or
recommended by Applied Biosystems. Applied Biosystems also
reserves the right to require that computer hardware and software be
restored to the standard configuration prior to providing service or
technical support. For systems that have built-in computers or
processing units, installing unauthorized hardware or software may void
the Warranty or Service Plan.

F-2 Software Warranty Information
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Limited Product Warranty

Limited Warranty

Warranty Period
Effective Date

Warranty Claims

Applied Biosystems warrants that for a period of ninety (90) days from
the date the warranty period begins, its ABI PrisM® GeneMapper™
Software Version 3.0 will perform substantially in accordance with the
functions and features described in its accompanying documentation
when properly installed on the instrument system for which it is
designated, and that for a period of ninety (90) days from the date the
warranty period begins, the tapes, diskettes, or other media bearing the
software product will be free of defects in materials and workmanship
under normal use. If buyer believes that it has discovered a failure of the
software to satisfy the foregoing warranty, and if buyer notifies Applied
Biosystems of such failure in writing during the ninety (90) day warranty
period, and if Applied Biosystems is able to reliably reproduce such
failure, then Applied Biosystems, at its sole option, will either (i) provide
any software corrections or “bug-fixes” of the identified failure, if and
when they become commercially available, to buyer free of charge, or
(i) notify buyer that Applied Biosystems will accept a return of the
software from the buyer and, upon such return and removal of the
software from buyer’s systems, terminate the license to use the
software and refund the buyer’s purchase price for the software. If there
is a defect in the media covered by the above warranty and the media is
returned to Applied Biosystems within the ninety (90) day warranty
period, Applied Biosystems will replace the defective media. Applied
Biosystems does not warrant that the software will meet buyer’s
requirements or conform exactly to its documentation, or that operation
of the software will be uninterrupted or error free.

Any applicable warranty period under these sections begins on the
earlier of the date of installation or ninety (90) days from the date of
shipment for software installed by Applied Biosystems personnel. For
all software installed by the buyer or anyone other than

Applied Biosystems, the applicable warranty period begins the date the
software is delivered to the buyer.

Warranty claims must be made within the applicable warranty period.

Software Warranty Information F-3
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Warranty The above warranties do not apply to defects resulting from misuse,

Exceptions neglect, or accident, including without limitation: operation outside of
the environmental or use specifications, or not in conformance with the
instructions for the instrument system, software, or accessories;
improper or inadequate maintenance by the user; installation of
software or interfacing, or use in combination with software or products,
not supplied or authorized by Applied Biosystems; and modification or
repair of the product not authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems’ sole and
exclusive representations, warranties, and obligations with respect to its
products, and Applied Biosystems makes no other warranty of any kind
whatsoever, expressed or implied, including without limitation,
warranties of merchantability and fitness for a particular purpose,
whether arising from a statute or otherwise in law or from a course of
dealing or usage of trade, all of which are expressly disclaimed.

Warranty The remedies provided herein are the buyer's sole and exclusive

Limitations remedies. Without limiting the generality of the foregoing, in no event
shall Applied Biosystems be liable, whether in contract, tort, warranty,
or under any statute (including without limitation any trade practice,
unfair competition, or other statute of similar import) or on any other
basis, for direct, indirect, punitive, incidental, multiple, consequential, or
special damages sustained by the buyer or any other person or entity,
whether or not foreseeable and whether or not Applied Biosystems is
advised of the possibility of such damages, including without limitation,
damages arising from or related to loss of use, loss of data, failure or
interruption in the operation of any equipment or software, delay in
repair or replacement, or for loss of revenue or profits, loss of good will,
loss of business, or other financial loss or personal injury or property
damage.

No agent, employee, or representative of Applied Biosystems has any
authority to modify the terms of this Limited Warranty Statement or to
bind Applied Biosystems to any affirmation, representation, or warranty
concerning the product that is not contained in this Limited Warranty
Statement, and any such modification, affirmation, representation, or
warranty made by any agent, employee, or representative of

Applied Biosystems will not be binding on Applied Biosystems unless in
a writing signed by an executive officer of Applied Biosystems.

This warranty is limited to the buyer of the product from
Applied Biosystems and is not transferable.

F-4 Software Warranty Information
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Some countries or jurisdictions limit the scope of or preclude limitations
or exclusion of warranties, of liability, such as liability for gross
negligence or wilful misconduct, or of remedies or damages, as or to
the extent set forth above. In such countries and jurisdictions, the
limitation or exclusion of warranties, liability, remedies or damages set
forth above shall apply to the fullest extent permitted by law, and shall
not apply to the extent prohibited by law.

Software Warranty Information F-5
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Glossary

Allele

Allele calling

Bin

Bin set

Diploid, polyploid
Genotype

GM

HID

Kit

LMS

Marker
Microsatellite

Panel

Project

SNaPshot Multiplex
Analysis

SNP

a variant of a marker

identification of alleles based on bin definitions; genotyping; GeneMapper
software analysis

a fragment size or basepair range and dye color that define an allele

a set of bin definitions for one source or set of experimental conditions, usually
an instrument; bin sets are available inside a kit

having 2 or more alleles, respectively, per gene or locus

the set of allele calls for a marker or genetic locus; usually 2 alleles
GeneMapper software

human identification and forensic applications

a set of panels; the grouping of panels in a kit is determined by the kit provider

Linkage Mapping Set; ABI chemistry using dinucleotide repeat microsatellite
markers

a known microsatellite or SNP location
short tandem repeat marker (di-, tri-, tetra-nucleotide repeat)

a set of bin definitions for one or more markers; the grouping of markers in
panels is determined by the kit provider

GeneMapper software project; a collection of samples

Primer extension-based chemistry for SNP validation

single-nucleotide polymorphism (used in this document to refer to SNaPshot®
System markers)

Glossary-1
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Index

A

Add Reference Data command 4-17
Add Sample to Project dialog box
general information C-36
Add Samples dialog box
Edit Menu C-37
Filestab C-40
View Menu C-39
Add Samples Tab view
elements C-19
Add samples to the Project
procedure C-37
advanced mode
peak detection options B-17
ranges options B-14
size calling method options B-16
smoothing and baselining options B-15
algorithms
allele calling B-2, B-5
binning B-2, B-5
described 1-3
peak detection B-2, B-3
quality value determination B-2, B-7
size-matching B-2
size-matching/size-calling B-4
Alleles tab
range filter 5-10
SNP cutoff value (for SNaPshot) 5-10
Analysis Method Editor
Alleles tab 5-7
Generaltab 5-7
Peak Detectortab 5-11
Peak Quality tab 5-14
Quality Flags tab  5-16
analysis methods 5-2
analysis parameters
setting
analysis range options B-14
data processing options B-15
Analysis Tab view
elements C-22
Apply button 4-2, 4-3, 4-7, 10-13, 10-17
Apply To checkbox 7-11

Automatic bin
assignment 4-40
builder 4-40
Automatic Bin Assignment (ABAA) 1-3
Automatic Bin Assignment Algorithms
(ABAA) 1-4
Automatic Bin Builder (ABB) 1-3, 1-4

B
Bin Set
alleles tab 5-8
choosinga 5-8
Bin view
cursor location information 4-38
description 4-37
genotype quality symbols 4-38
Marker Allele Size Range (ASR) 4-39
purpose of 4-37
X-and Y-axes 4-38
Bins definition
format of text file 4-26
Bins definitions for SNaPshot 4-30

C

CD-ROM contents  2-3

Collecting and preparing sample data
techniques for 2-1

Command activation
three ways of C-9

Computer
configuration requirement F-2
technical support for altered

configuration F-2
Cubic Spline Interpolation method B-34

customer support. See technical support 1-12

Cut-off Value 5-9

D
Dye/lanes window
example of 3-14
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E
Ease of use 1-4
EPTtab 3-10

Example Plot printout C-35
Example Table printout C-34
Export Project window 3-25
Export Table dialog box C-31

F
failed in-lane size standards
ability to correct 1-7
Filtering controls 6-10
Find command
planning for use of 2-9
Find dialog box C-46
Fully automated operation 1-4

G

GeneMapper
access rules 2-7
accessing subordinate application
windows 3-15
logging in and out 2-5
major steps in using 2-2
overview 1-2
registering 2-4
GeneMapper Manager
Analysis Method Editor 5-5
Analysis Methods tab  5-2
Matrices tab 9-2
New Analysis Method dialog box 5-6
GeneMapper results
exporting as text files 1-6
GeneMapper Software
installing and registering 2-3
GeneMapper software
hardware and software requirements
how it works, figure 1-8
important features 1-6
read-only access to the BioLIMS
database 1-6
GeneMapper system
dataflow 1-8
GeneScan Analysis Sample Sheet
importing data from 2-8
Genotypes view
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descriptions of columns C-7
Genotypes View filter setting 6-12
genotyping algorithms B-2

H
High-throughput 1-3

1
Import Project window 3-27
Infotab 3-8

L

Least Square method B-32
Local Southern method B-35
logging out of GeneMapper 2-7

M
Marker 4-36
marker allele size range (ASR) 4-39
marker and bin definitions
exporting 1-6
importing 1-6
Marker table columns 4-36
Marker Table view 4-35
matrices
about 9-3
causes for bad 9-19
error messages 9-19
limitations 9-6
where to store 9-7, 9-18
Matrices tab 9-2
matrix
assigning to a sample 9-5
assigning to sample 9-16
choosing a data point range 9-10, 9-11
considerations 9-7
creating a GeneMapper 9-12
definition 9-3
eliminating primer peaks 9-11
evaluating 9-17
evaluation procedure 9-17
example 9-15
generating anew 9-12
process diagram 9-8
process of creating a new 9-8



raw data display 9-10

sample files 9-5

steps to create 9-9

using different computers for data collection
and analysis 9-18

using with data collection 9-18

viewing the raw data 9-10

when to assign to a sample 9-5

when to create 9-6

matrix files

about 9-31t09-7

bad matrix files, causes 9-19 to 9-20
choosing a data point range 9-10 to 9-11
evaluating the matrix file 9-17

Full View command 4-20

Import Bins Options dialog box 4-9
Import/Export Bin Set command 4-8
Import/Export Panels command 4-8
Navigation pane 4-5

New Bin Set command 4-16

new marker 4-7

new panel 4-7

overview 4-2

Panel SNP Reference Data command 4-18
purpose of 2-12, 4-2

rules for imported and exported files 4-32
Show Project Alleles command 4-17
toolbar 4-4

new matrix file, generating 9-12to 9-15
process of creating new file 9-8 to 9-9
Multiple Allele Peak Determination (MAPDA)
Multiple Allele Peak Determination Algorithms
(MAPDA) 1-4

o

Open Project dialog box C-28
Options dialog box C-17

P
Panel and Bin text files 4-23
Panel data hierarchy 4-3
Panel definition format of text file 4-24
Panel definitions for SNaPshot 4-28
Panel Manager
Add Bin command 4-13
Add Reference Data command 4-17
Auto Bin command 4-19
Auto Panel command 4-19

1-3

automatic bin assignment algorithm 4-40

automatic bin builder process 4-40
Bin view 4-37, 4-38, 4-39

Bins menu 4-12

Delete Bin command 4-14

Delete Bin Set command 4-16
Delete SNP Marker command 4-13
Duplicate Panel command 4-7
dyes 4-22

Edit Bin command 4-14

Edit Bin dialog box 4-15

Edit SNP Marker command 4-12

View menu 4-20
window commands 4-6
X Axis Scale menu command 4-20, 4-21
scaleto 4-20
Y Axis Scale 4-21
Panel Manager window 4-2
displaying 4-3
Panel names 4-34
Panel table columns 4-34
Panel Table view 4-33
parameter values 5-7, 5-9
Pass or Fail
quality metrics 5-17
PCR Single-stranded Conformation
Polymorphism (SSCP)
Minimum Peak Half width setting B-12,
B-17
peak detection
optimizing sensitivity B-23, B-25, B-27
parameters B-19
peak window size B-19
polynomial degree B-19
slope threshold B-28
peak detection algorithm
advanced 5-12
basic 5-11
classic 5-13
Peak Detector tab
advanced peak detection algorithm 5-12
basic peak detection algorithm 5-11
classic peak detection algorithm 5-13
Peak Quality tab
allele number 5-15
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heterozygote balance 5-14
peak morphology 5-15
pull-up peak 5-15
signal level 5-14
SNP 5-15
plot settings default profiles 8-2
Plot Settings Editor
Display Settings tab 8-9
Generaltab 8-4
Genotype Header tab 8-5
Labels tab 8-7
Sample Header tab 8-5
Sizing Table tab 8-6
plot settings editor 8-4
Plot Settings tab  8-2
Plot window
Add Allele option 7-27
Add Bin option  7-29
Allele Changes option 7-16
Allele Edit Comment option 7-28
Alleles menu 7-25
bins 7-14
Controls To Top option 7-16
customizing 7-3
Delete Allele option 7-27
Delete Bin option 7-30
displaying 7-2
Dyes option 7-17
Edit Bin option 7-29
Edit menu 7-7
Editing Mode option 7-25
example of 3-14
Export Table dialog box 7-6
File menu 7-5
Full View option 7-9
Header option 7-21
Help menu 7-30
History option 7-27
labels 7-12
Marker Indicator option 7-21
Marker Margin option  7-22
Marker Range option 7-21
menus 7-5
Off-scale Peak Indicator option 7-17
overview 7-2
Peak Positions indicators  7-14
Plot Settings option 7-24
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Plots option 7-18
PQV feature 7-31
Rename Allele option 7-28
Table Filter option 7-20
Tables option 7-18, 7-20
toolbars 7-4
Tools menu  7-23
View menu 7-8
X-Axis Scale option 7-10
Y-Axis Scale option 7-11
PlusA Distance 5-9
PlusA Ratio 5-9
polynomial degree
peak detection B-19
varying B-21
window size value B-22
PQV results A-5
Prefences Add Samples
spellings and abbreviations C-20
Preferences
Analysis tab C-22
Importtab C-18
Sequence Collector tab C-21
Userstab C-24
Print dialog box C-33
Process Component Quality Values (PQV) 1-4
Process Component-Based Quality Values
(PQV) 1-4
process quality values (PQV) A-1
editing A-2
overview A-2
PQV flags on the Genotypes page A-7
PQV flags on the Samples page A-6
PQYV values for specific applications A-4
process A-2
rules for PQV columns A-5
using the PQV system A-3
Project
discussion of supporting utilities 3-3
Project Analysis menu
commands C-12
Project Edit menu
commands C-11
Project Edit menu dialog boxes
Find dialog C-46
Sort dialog C-47
Project File menu
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commands C-9
Project File menu dialog boxes
Export Table dialog C-31
New Project C-27
Open Project dialog C-28
Print dialog C-33
Save Project/Save Project As dialogs C-30
Project Help menu
commands C-26
Project View menu
commands C-14
Project window
importance of 3-2
interface conventions 3-5
navigating in  3-7
parts of the main window 3-6
reformatting 3-5
tasks performed in  3-3
toolbar 3-12
viewing contents  3-14
Projects page
using the 3-23

0
Quality Flags tab
options  5-17
PQV thresholds 5-16

R
Raw Data tab 3-9
registration card, completing 1-11

S
sample files
converting from Mac to NT E-2
Sample Information
source of 2-8
Sample Sheet
how GeneMapper uses 2-8
sample sheet 2-8
Samples and Genotypes views
applying a menu selection  3-19
purposes of tables  3-11
Samples view
appearance C-2
columns C-3

rules for columns 3-18
Samples View column filtering settings 6-10
Save Project/Save Project As dialog boxes C-30
Sequence Collector
database tab window elements C-44
tab view elements C-21
Sequence Collector tab C-44
size calling curve 10-18
black curve 10-18
red curve 10-18
size calling method
Cubic Spline Interpolation B-34
Global Southern B-37
Local Southern B-35
size calling methods
classic and advanced B-32
Cubic Spline B-34
Least Square B-32
Size Match Editor
Edit Menu 10-14
procedure for editing a peak 10-16
View Menu 10-15
when touse 10-12
Size Match Editor window 10-12
editor commands 10-13
elements 10-13
toolbar 10-16
using 10-16
size standard
350 All size standard D-3
400HD D-4
500 All D-6
creating and editing 10-5
specifying size standard parameters 10-5
Size Standard Editor window
using in basic or advanced mode 10-8
using in classic mode 10-10
Size Standard tab 10-3
Size Standards
advantages of using 10-2
what are 10-2
sizing only application
sizing microsatellite reference data 10-19
sizing SNaPshot reference data 10-20
sizing-only application 10-19
slope threshold B-30
peak end parameters B-28
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peak start B-28
Sort Dialog box C-47
SQ and GQ quality indications  A-5
SSCP, Minimum Peak Half width setting B-12,
B-17
Stutter Distance 5-9
Stutter Ratio 5-9

T
Table Manager
content column dialog box 6-8
filtering controls 6-10
Table Setting Editor
deleting a table profile 6-9
editing a table profile 6-9
filtering controls 6-10
filtering settings, genotypes view 6-12
filtering settings, samples view 6-10
new table profiles 6-9
Table Settings Editor 6-4
Generaltab 6-4
Genotypes tab 6-6
Sample and Genotypes tab elements 6-7
allele settings 6-8
Samples tab 6-5
Table Settings tab
overview 6-2
profiles 6-2
Technical support
for computers with altered configuration F-2
technical support 1-12
Thresholds 5-16
troubleshooting
bad matrix files, causes 9-19 to 9-20

U
User manual
organization 2-12
Users tab
elements C-24

w

Warranty
exceptions F-4
for computers with altered configuration F-2
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